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Introduction

Introduction

The Upgrade Guide for Sage 100 contains details on all of the new features in Sage 100
2023 and a comprehensive checklist to guide you through migrating your data from
earlier versions of Sage 100.

Use this guide after you've installed Sage 100 2023 following the instructions in the Sage
100 Installation and System Administrator's Guide. You can find the installation guide and
other documentation on the Sage 100 Documents page.

Depending on your purchase agreement, some features described here may not be available in
your product.
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What's New in Version 2023

What's New in Version 2023

This chapter describes the enhancements added in Sage 100 version 2023. Changes to
the Sage 100 Desktop are listed first, followed by global changes, module-specific
changes, and then a list of features that are now available for the non-subscription
version of Sage 100.

Depending on your purchase agreement, some features described here may not be
available in your product.

Sage 100 Desktop Changes

The following changes were made to the Sage 100 Desktop.

Information Center Page

A new Sage 100 Information Center page has been added, providing dynamic content
and announcements for you.

Recent Tab Added to the Ribbon

The Recent tab has been added to the ribbon, showing tasks that have been accessed
from the File menu, Home tab, Web Content tab, and Modules tab. On the View tab, you
can set how many recent items to show. You can also hide the Recent tab by right-
clicking the ribbon and clearing Show Recent in the Ribbon.

Expanded Tooltips

Expanded tooltips now show where tasks are located. For example, hovering over
Company Maintenance displays the tooltip Located in the Library Master Main menu.

Active Tab on the Ribbon Persists

The last tab accessed on the ribbon persists after exiting Sage 100. For example, if the
Favorites tab was the last tab used when you exited Sage 100, it will be the active tab the

Sage 100 Customer Upgrade Guide 2



Global Changes

next time you log in.

Global Changes

The following changes are carried throughout multiple modules.

Installation Simplification

In version 2023, Sage 100 has been consolidated into a single product with three
installation approaches. The option to install Sage 100 Standard, Sage 100 Advanced,
and Sage 100 Premium has been removed. Instead, during installation you will have the
option to select the architecture to use (Stand-Alone or LAN or Client/Server). If you
select the Client/Server architecture, you will be prompted to select the database to use
(ProvideX or Microsoft SQL Server).

Also, the following installation changes have been made:

* On the Sage 100 Integration Engine Service screen, a Skip button has been added. If
you're not integrating Sage 100 with Sage CRM, you can click Skip to bypass
configuring the Integration Engine.

» On the Productivity Applications screen, the Configure Sage 100 Integration Engine
option has been added.

Select Serial Numbers by Range

The Select Serial Numbers by Range button has been added in Lot/Serial Number
Distribution. You can select serial numbers using a range instead of scrolling through a
list to find the starting and ending serial numbers. This enhancement is carried
throughout the following modules:

Bill of Materials

Inventory Management

Purchase Order

Production Management
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Global Changes

* Return Merchandise Authorization

e Sales Order

-‘é’- We're listening! This idea was a suggestion from 90 Minds, Inc., and it received
multiple votes on the Sage 100 ideas site.

Default Years to Retain History

In module options tasks in which you can specify how many years to save history, the
default setting is now nine years. The minimum required number of years to retain history
has not changed, and this update will not affect your existing settings.

Activity Log Updates

When the Accounts Payable Remove Inactive Vendors utility and the Accounts
Receivable Remove Inactive Customers utility are run, the Activity Log is updated with a
list of inactive vendors and customers removed.

Image Viewer

The Image Viewer in Item Maintenance and Miscellaneous Item Maintenance has been
updated so that you can delete an image when you have the appropriate security set up.
The delete feature is available based on the new security option in Role Maintenance,
Allow User to Delete Image Files with the Image Viewer.

iShip Replacement

The iShip tracking tool has been replaced. In data entry tasks, when you click the
Tracking button, the tracking ID will now be used to determine which carrier the package
belongs to and you will be redirected to the appropriate site. The carriers handled
automatically are USPS, UPS, FedEx, DHL, and OnTrac. If the package ID does not
belong to one of these carriers, you will be redirected to a Google search with the
package ID.
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Accounts Payable

SAP Crystal Reports 2020

SAP Crystal Reports has been updated to version 2020. Crystal runtime components
(SP30) are the same version as in Sage 300, Sage Fixed Assets, and Sage HRMS.

Accounts Payable

The following changes were made in the Accounts Payable module.

Masked 1099 Vendor Taxpayer ID/Social Security
Number

The 1099 Vendor Taxpayer ID/Social Security Number is now masked in data entry tasks
and will also print masked on the Vendor Listing, Vendor Listing with Balances, and
Vendor Mailing Labels. Only users with the appropriate security setup can view this
sensitive information and access the option Print Unmasked Taxpayer ID/SSN check
box.

The check box is available based on the new security option in Role Maintenance, Allow
Viewing, Printing, and Editing of Highly Sensitive 1099 Information.

-‘@'— We're listening! This idea was a suggestion from 90 Minds, Inc., and it received
multiple votes on the Sage 100 ideas site.

Masked ACH Bank Account and Routing Numbers

The vendor electronic payment bank account and routing numbers are now masked in
data entry tasks and will also print masked on the Vendor Listing. The routing transit
numbers are also masked in ACH Maintenance. Only users with the appropriate security
setup can view this sensitive information and access the option Print Unmasked

ACH Information check box in Vendor Listing.

The check box is available based on the new security option in Role Maintenance, Allow
Viewing, Printing, and Editing of Highly Sensitive ACH Information.

We’'re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the

ideas site to share your ideas and vote for your favorites.
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Development Studio

Improvements in Invoice Payment Selection

The Include check box has been added in the Select Invoices for Payment window,
enabling you to quickly select each invoice for payment.

We’'re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the

ideas site to share your ideas and vote for your favorites.

Vendor Maintenance

On the Additional tab in Vendor Maintenance, the DBA Name field has been renamed the
1099 Name field.

Development Studio

The following change was made in Development Studio.

Grid Definition Maintenance

When defining grid columns in Grid Definition Maintenance, you can now exclude
columns from being exported to Excel by entering EXCEL=No at the Tag field.

Inventory Management

The following changes were made in the Inventory Management module.

Option to Hide Inactive Warehouses

The Display Quantities for Inactive Warehouses check box has been added on the
Additional tab in Inventory Management Options to allow you to hide inactive
warehouses.

A Show/Hide Inactive Warehouses button has been added in the following locations:
* Main tab on Item Maintenance and Item Inquiry

e Quantity tab on Item Maintenance and Item Inquiry
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Inventory Requirements Planning

¢ Reorder Maintenance
* Item Quantity Inquiry

-‘@'— We're listening! This idea was a suggestion from 90 Minds, Inc., and it received
multiple votes on the Sage 100 ideas site.

Option to Show/Hide Zero Quantities for Lot/Serial Items

The Display Zero Quantities for Lot/Serial Items in Cost Detail check box has been added
on the Additional tab in Inventory Management Options. You can select this check box to
initially display lot/serial items with zero quantities on the Cost Detail tab in ltem
Maintenance and Item Inquiry.

A Show/Hide Zero Quantity Lot/Serial Rows button has also been added on the Cost
Detail tab in Item Maintenance and Item Inquiry.

-‘@'— Your Sage 100 business partners at work! This idea was a suggestion from 90
Minds, Inc. where “More Minds Are Better Than One.”

Remove Inactive Iltems Utility

The Remove Inactive Items task has been added to the Inventory Management Utilities
menu. After running the utility, the Activity log is updated with a list of inactive items
removed.

—‘@'— Your Sage 100 business partners at work! This idea was a suggestion from 90
Minds, Inc. where “More Minds Are Better Than One.”

Inventory Requirements Planning

The following changes were made in the Inventory Requirements Planning module.

Inventory Requirements Planning Options
The following options have been added:
e Pull In Work Ticket check box

¢ Push Out Work Ticket check box
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Inventory Requirements Planning

« Round Integer Unit of Measure check box
« Base Effective Date on Release Date of Demand check box

« Calculate Build Time for Make ltems Using field

Inventory Requirements Planning

The following fields have been added, providing more options for the IRP generation
process:

+ Effective Date field

Include Sales Quotes check box

Explode Make Action field

Create Work Ticket with Materials From field

Default Lead Time (Days) field

Default Build Time (Days) field

Advanced Arrival Allowance (Days) field

If the Inventory Requirements Planning module is not integrated with Production
Management or Purchase Order, you can now click Production or Purchase to view a
report of inventory demand.

Expanded Summary and Detail Information

In Items to Produce and Items to Purchase, you now have the option to view summary
information for items with pending actions.

Item Detail now displays the recommended action, action date, and required date to meet
demand for each detail record.

Schedule IRP Generation with Task Scheduler

You can now schedule the IRP generation process with Library Master Task Scheduler.
This provides you with the flexibility to run the generation after business hours or
overnight.
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Library Master

Inventory Requirements Planning Inquiry

Inventory Requirements Planning Inquiry has been added to the Inquiries menu. Use this
task to view purchase or production information for an item based on the last completed
IRP generation process.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the

ideas site to share your ideas and vote for your favorites.

Reports Menu

A Reports menu has been added, along with the following reports: Action By Vendor
Report, Inventory Requirements Planning Report, Projected Demands Report, and Work
Ticket and Sales Order Demand.

Action By Vendor Report

The Action By Vendor Report includes the ability to select by warehouse code and then
print the warehouse code on the report. The standard unit of measure also prints on the
report.

Projected Demands Report
The following changes have been made:

« Afiscal/calendar year option has been added, enabling you to print the report for a
selected year.

« When the Consolidate Customers check box is selected if item projected demands
are included in the consolidation, the Qty Sold column on the report displays the
item's total quantity sold. If item projected demands are not included in the
consolidation, the Qty Sold column displays the sum of the consolidated customer's
quantity sold.

Library Master

The following changes were made in the Library Master module.
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Paperless Office

Option to Suppress Expired Messages

The Suppress Expired Messages check box has been added in User Maintenance,
enabling you to suppress displaying expired license messages by user.

Retain Last Path in Data File Display and Maintenance

When you click the Folder button in Data File Display and Maintenance, the Select File
window now shows the folder location of the last file viewed.

We’'re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the

ideas site to share your ideas and vote for your favorites.

Paperless Office

The following change was made in the Paperless Office module.

Updated Printer Driver

The Amyuni PDF Converter, the virtual printer driver used to create PDF documents, has
been updated to version 6.5.1.7.

Production Management

The following changes were made in the Production Management module.

Enhanced Scheduling

Enhanced scheduling features have been added throughout the Production Management
module to provide you with more flexibility and functionality.

-‘é’- Your Sage 100 business partners at work! This idea was a suggestion from 90
Minds, Inc. where “More Minds Are Better Than One.”

Production Management Options Schedule tab

In Production Management Options, a Schedule tab has been added with the following
new options:
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Production Management

» Select the Enable Enhanced Scheduling check box to use the forward or backward
scheduling method to schedule work tickets. Enhanced scheduling is the functionality
that was in the Work Order module.

If you prefer to use basic scheduling, clear the Enable Enhanced Scheduling check
box. Basic scheduling is the functionality that was in previous releases of Production
Management.

* The Maximum Number of Months to Schedule field has been added.

* You can define default work center closures that will be used for all work centers.

Activity Code Maintenance

The following enhanced scheduling fields have been added in Activity Code
Maintenance:

e Calculation Method

* Ignore Queue Time

Work Ticket Template Maintenance

The following enhanced scheduling fields have been added in Work Ticket Template
Maintenance:

e Calculation Method
» Hours Per Activity / Activities per Hour / Number of Hours
e Overlap Percent

* Ignore Queue Time

Work Center Maintenance
The following changes have been made in Work Center Maintenance:

* Enhanced scheduling fields have been added: Queue Time (Hours), Efficiency
Percent, Number of Workers or Machines, and Minimum Scheduling Time Period
(Minutes)
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Production Management

* You can set up the number of hours a work center is available for operation each day
of the week at the Available Hours fields.

» Closures for specific work centers can be set up.

* Click Copy From to copy information from an existing work center when creating a
new one.

» Click Apply to copy available hours and closures from an existing work center to one
or more other work centers.

 The Memo button is available to view, create, and maintain memos.

Work Ticket Entry
In Work Ticket Entry, the following changes have been made for enhanced scheduling:

¢ On the Schedule tab, the Schedule button has been added to access the new
Schedule Work Ticket window.

 In the Schedule Work Ticket window, you can select the forward or backward
scheduling method to determine when each step of a work ticket is started and how
long each step takes to complete.

» Use forward scheduling to enter the start date of a work ticket, and the
scheduling process will calculate the due date for the work ticket.

» Use backward scheduling to enter the due date for a work ticket, and the
scheduling process will calculate when the work ticket will be released to
the work center, in order for the work ticket to be completed on time

* On the Schedule tab, the Manually Schedule check box has been added to give you
the option to manually enter the production start date and production due date on the
Schedule tab and the Steps tab.

* On the Steps tab, the following fields have been added to the secondary grid: Ignore
Q Time, Overlap Percent, Prod Queue Date, Sched Method, Scheduling Hrs, Scaling
Method, Scaling Factor, and Extended Time.
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Production Management

Work Ticket History Inquiry

You can now view detailed step information on the Work Ticket History Inquiry Schedule
tab by selecting a step in the list box and clicking the Additional Information button.

Work Center Capacity Inquiry

Work Center Capacity Inquiry has been added to the Inquiries menu. Use this task to
review commitments against work centers in three formats: daily, weekly, and detail.

Scheduled Capacity Report

Scheduled Capacity Report has been added to the Reports menu. Use this report to print
commitments against work centers in three formats: daily, weekly, and detail.

Material Issue Workflow Improvements in Work Ticket
Transaction Entry

In Work Ticket Transaction Entry when creating a materials transaction, you can now
import available material lines with remaining quantity to issue in bulk to the Lines tab.
This enhancement speeds data entry.

You have the option to select all available material lines, or you can use the new Material
Selection window to select specific material lines to issue. The Material Selection button
has been added on the Work Ticket Transaction Entry Lines tab to open the Material
Selection window.

Lot/Serial History

A Lot/Serial History button has been added in the following locations:

» Materials tab on Work Ticket History Inquiry

* Inquiry tab on Work Ticket History Inquiry for the Materials and Completions views

* Inquiry tab on Work Ticket Entry for the Materials and Completions views

Selections for Purging Work Ticket History

In Purge Work Ticket History, selections have been added to enable you to purge by work
ticket number, release date, and close date.
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Production Management

Work Ticket Template Maintenance

You can now add a scrap percentage for each item on the Materials tab in Work Ticket
Template Maintenance.

We’'re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the

ideas site to share your ideas and vote for your favorites.

Labor Entry

In Labor Entry if you're capturing punch in/out time for an employee and the Payroll
module is integrated with Production Management, you can now select a department
worked in at the Dept No. field that is different than the employee's assigned department
in Payroll Employee Maintenance.

When you update the Payroll Check Register, the department worked in and its general
ledger accounts will be used instead of the employee's assigned department.

Add Activity Codes and Work Centers On the Fly

You can add on-the-fly activity codes and work centers in Work Ticket Class
Maintenance, Work Ticket Template Maintenance, and Work Ticket Entry with the
appropriate security setup in Library Master Role Maintenance.

Option to Relieve WIP Based on Percent Complete

The Relieve WIP Based on Percent Complete check box has been added on the Work
Ticket Entry Header tab and the Work Ticket Class Maintenance Main tab. Select this

check box to use the prorated cost for WIP when entering a partial completion in Work
Ticket Transaction Entry.

Explode Bill Subassemblies

In Work Ticket Entry, the Explode Subassemblies check box has been replaced by the
Explode Bill Subassemblies field. When the Bill of Materials module is integrated with
Production Management and enhanced scheduling is used, selecting Yes at the Explode
Bill Subassemblies field now creates work tickets steps for each subassembly on a
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Production Management

multilevel bill. This functionality was in the Work Order module and has now been added
to Production Management.

Explode Template Subassemblies

In Work Ticket Entry, the Explode Template Subassemblies field has been added,
providing the ability to explode subassemblies defined on a work ticket template when
enhanced scheduling is used.

Recalculate Material Budgets

On the Materials tab in Work Ticket Entry, the Recalculate Material Budgets button has
been added, enabling you to recalculate budgets for the step assigned to the selected
material line. All the material detail lines assigned to the same step will be recalculated.
Click the arrow next to the button, and then select Recalculate Material Budgets All Steps
to recalculate budgets for all material lines and steps in the grid.

Work Ticket Entry Copy Feature

In the Work Ticket Entry Copy From window, the Production Start Date field has been
added to simplify the process of copying a manually scheduled work ticket.

During the copy process, the system will calculate the number of days between the start
date entered here and the source work ticket start date. The difference between the dates
will be used to automatically adjust all of the scheduling dates in the source work ticket
steps as they are copied.

Create Work Ticket with Materials From Option

A new option has been added in Production Management Options, enabling you to create
a work ticket using the materials from the bill, work ticket template, both the bill and
template, or you can select to be prompted with a message in Work Ticket Entry asking
which materials to use.
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Features No Longer Subscription Only

Data Conversion for Earlier Version of Production
Management
The Production Management module code has changed from JT to PM. When you

convert Production Management data from an earlier version of Sage 100, the
converted company data files are changed to use the PM prefix.

Important! If you're upgrading from the standalone version of Production
Management that was previously available, you must be on version 2021.x of the
standalone version before upgrading to the Production Management module that
is part of Sage 100 2023.

Features No Longer Subscription Only

The following features were initially available only if you purchased Sage 100 through
a subscription plan. They are now available to all users, regardless of whether Sage
100 was purchased as a subscription or perpetual license.

- Journal and Register Viewer: Access to the Paperless Office Journal and Register
Viewer is available from various locations.

» Task Scheduler: You can email reports printed from a Task Scheduler job.

« Data File Display and Maintenance Enhancements: You can now select a subset of
fields from the table to be displayed. When selected, you can define filters and
apply them to one or more of the fields to limit the rows displayed in the Key Scan
screen. The status text on the Key Scan screen will indicate when a filter is active.

« Map Service: An option has been added on the Preferences tab in User
Maintenance allowing you to select which map service to use when clicking the Map
button in Sage 100 tasks. Use Google Maps, Bing Maps, or MapQuest.
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Changes in Version 2022

Changes in Version 2022

This chapter describes the enhancements added in Sage 100 version 2022 and
subsequent updates. Changes to the Sage 100 Desktop are listed first, followed by global
changes, module-specific changes, any updates to Microsoft 365 integration, retired
features, and then a list of features that are now available for the non-subscription version
of Sage 100.

Depending on your purchase agreement, some features described here may not be
available in your product.

Changes in Version 2022.3

The following enhancements were added in update 3 for Sage 100 2022.

Accounts Payable

The following changes were made in the Accounts Payable module.

Form 1099 Tax Reporting Version

Form 1099 Tax Reporting has been updated to version 2.98.

DBA Name for 1099 Forms

There has been a functionality change of where the 1099 DBA Name field prints on the
1099 Form.

If there is a name entered in the DBA Name field on the Additional tab in Vendor
Maintenance, it will now print on Line 1 of the Recipient Name box of the 1099 Form and
the Vendor Name will print on Line 2 of the Recipient Name box of the 1099 Form.

Updates for 1099 Form Tax Reporting

The following options have been added to support Form 1099 printing for tax year 2022:
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Changes in Version 2022.3

* Forthe 1099-DIV Form:
* Box 11 is now FATCA filing requirement check box.

» Subsequently, old box numbers 11 through 15 have been renumbered to
new box numbers 12 through 16, respectively. The new boxes are as
follows:

* Box 12 - Exempt-interest dividends
* Box 13 - Specified private activity bond interest dividends
* Box 14 - State
* Box 15 - State Identification No.
* Box 16 - State Tax Withheld
* Forthe 1099-MISC Form:
* Box 13 is now FATCA filing requirement check box

e Subsequently, old box numbers 13 through 17 have been renumbered to
new box numbers 14 through 18, respectively. The new boxes are as
follows:

* Box 14 - Excess golden parachute payments

Box 15 - Nonqualified deferred compensation

Box 16 - State tax withheld

Box 17 - State/Payer's state no.

Box 18 - State Income

Production Management

Work Ticket Entry Copy From

In the Work Ticket Entry Copy From window, the Production Start Date field has been
added to simplify the process of copying a work ticket.

During the copy process, the system will calculate the number of days between the start
date entered here and the source work ticket start date. The difference between the dates
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Changes in Version 2022.2

will be used to automatically adjust all of the scheduling dates in the source work ticket
steps as they are copied.

Changes in Version 2022.2

The following enhancement was added in update 2 for Sage 100 2022.

Accounts Receivable

Option to Print Zero Balance Customers with No Invoices

The Customers with No Invoices check box has been added to Statement Printing. You
can select this check box to print statements for zero balance customers that do not have
any invoice detail printing on the statement.

Changes in Version 2022.1

The following enhancements were added in update 1 for Sage 100 2022.

Inventory Requirements Planning

The Inventory Requirements Planning (IRP) module is now compatible with the version of
Production Management that was released in Sage 100 2022. The updated version of
Inventory Requirements Planning is automatically installed with update 1 if you have the
Production Management module installed. Inventory Requirements Planning is
automatically registered if Production Management is registered, so you do not need a
new license key.

Data Conversion and Material Requirements Planning

If you already have the Material Requirements Planning (MRP) module installed,
Inventory Requirements Planning is still installed, but you cannot have both modules
activated for the same company at the same time. Activating IRP for a company
deactivates MRP for that company.

When you open Inventory Requirements Planning Options, you will be asked if you want
to convert your MRP data to IRP data. If you convert your MRP data, your MRP data files
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Changes in Version 2022

are deleted after the conversion process is compete. You can choose not to convert your
MRP data and proceed with the IRP setup, and this will remove your MRP data.

Maintain Projected Demands

Maintain Projected Demands has been added to the Main menu. You can use Maintain
Projected Demands to manually enter demand information before generating the IRP
data file that's used to show demand and create work tickets and purchase orders.

Library Master

The following enhancements were added in the Library Master module.

Data File Display and Maintenance Updates

The following changes have been made in Data File Display and Maintenance:

» Two new options have been added to the Operator list in the Filter window:

» Contains CRLF: Use this operator to find records that contain carriage
return/line feed characters.

» Non Printable: Use this operator to find records that contain non-printable
characters.

 Inthe Select Fields window, you can select up to 25 fields to display in columns in the
Key Scan window.

OAuth Authentication Method for SMTP Mail Server

In Company Maintenance on the E-mail tab, you can now select the OAuth authentication
method for your SMTP mail server even if you purchased Sage 100 through a perpetual
license. Previously the OAuth authentication method was available only if you purchased
Sage 100 through a subscription plan.

Changes in Version 2022

The following enhancements were added in Sage 100 2022.
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Changes in Version 2022

Sage 100 Desktop Changes

The following changes were made to the Sage 100 Desktop.

Add Public Favorites

You can add tasks and other items to the new Public Favorites group. These items are
listed on the Favorites panel when you click Public Favorites, and they are available to all
Sage 100 users. For Sage 100 tasks, access is based on the users' security setup. For
instructions, see Add ltems to the Favorites Content Group in the Sage 100 help.

Global Changes

The following changes are carried throughout multiple modules.

Exclude Inactive Items From Lookups

A Display Inactive Iltems check box has been added to the ALE Lookups section on the
Preferences tab in Company Maintenance. Clear this check box to exclude items from
Lookups if the Inactive check box in Item Maintenance is selected for the item.

For more information, see the field help for the Display Inactive Iltems check box.

-‘@'— We're listening! This idea was a suggestion from 90 Minds, Inc., and it received
multiple votes on the Sage 100 ideas site.

Option to Save Date Selections for Reports

When creating or modifying a report setting, you can specify whether you want to save
the dates entered in the Selections grid. To save the dates, select the Save Date
Selections check box that has been added to the Save As Report Setting window. Clear
the check box to omit the dates from the report setting. The check box is selected by
default.

—‘@'— We're listening! This idea was a suggestion from 90 Minds, Inc., and it received
multiple votes on the Sage 100 ideas site.

Default Years to Retain History

In module options tasks in which you can specify how many years to save history, the
default setting is now five years. The minimum required number of years to retain history
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has not changed, and this update will not affect your existing settings.

Accounts Receivable

The following changes were made in the Accounts Receivable module.

Pay Cycle Option

A new check box, Allow employees with other pay cycles for bonus and commissions,
has been added to the Pay Cycle window that opens when you're updating the
Commission Edit Register.

Select this check box when you're processing a pay run that falls outside of employees'
regular pay cycle assigned in Employee Maintenance. For example, select the check
box if employees are typically paid weekly, but you're paying a monthly bonus.

Note: This check box is available only if you're using Sage 100 Payroll version
2.22 or later.

Search for Quotes

A Quotes check box has been added to the Search for Open Orders window accessed
from the S/Os tab in Customer Maintenance. Select this check box to find quotes for the
current customer.

-‘é’- Your Sage 100 business partners at work! This idea was a suggestion from 90
Minds, Inc. where “More Minds Are Better Than One.”

Business Insights

The following views have been added to the Business Insights Explorer menu and the
Production Management Explore menu. The views that are indented underneath each
primary view are the secondary views available in the Explore navigation pane when you
access the primary view.
» History Work Tickets View

» History Work Ticket Steps

o Work Ticket Line ltems
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e Purchase Order Line Items PM
» Open Work Tickets View

e Open Work Ticket Steps

e Work Ticket Line ltems

e Purchase Order Line ltems PM
» Work Ticket Labor View

» Open Work Tickets

e Open Work Ticket Steps

Inventory Management

The following changes were made in the Inventory Management module.

More Options When Uploading Images

When you're uploading images in ltem Maintenance, you can now use the following
image types:

» JPEG

« PNG

o TIFF

You can still use the types that were previously available as well (JPG, GIF, and BMP).

We’'re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the

ideas site to share your ideas and vote for your favorites.

Order Type Options on Search for Sales Orders Window

When searching for orders using the Search for Sales Orders window, you can select
check boxes corresponding to the order types to include in your search results. All sales
order types are now available, including quotes, master orders, and repeating orders.

Also a Quoted field has been added to the bottom of the tab. The field displays the item's
quantity used in Sales Order quotes.

The Search for Sales Orders Window can be accessed from Item Maintenance and ltem
Inquiry.
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—‘@’- We're listening! This idea was a suggestion from 90 Minds, Inc., and it received
multiple votes on the Sage 100 ideas site.

Changes Related to Production Management

The following changes, which are related to the Production Management module, were
made in Inventory Management.

Note: If custom labels have been entered in the Terminology fields in Production
Management Options, the custom text appears in place of the default terminology.

Changes in Item Maintenance
The following changes are applicable if the Production Management module is activated.

» The options in the Procurement field on the Main tab are Make to Stock, Buy to
Stock, Buy to Order, and Subcontract.

e An On WT column is included in the Quantities box on the Main tab and on the
Quantity tab. The column shows the total quantity being produced for the parent item
on work tickets with a status of Released.

* AReq for WT column is included in the Quantities box on the Main tab and on the
Quantity tab. The column shows the total quantity being consumed for the raw
material on work tickets that have a Released status.

If the Include Open Work Ticket Materials as Inventory Demand check box in
Production Management Options is selected, then open work tickets are also
reflected in this column.

» On the Additional tab, the Template No. field appears instead of the Routing No.
field.

» On the Quantity tab, the following columns have been added:
e ONWT
e Reqfor WT
» On the Transactions tab, the following columns have been added:
e Work Ticket No.
» Step No.
» Work Ticket Description
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» On the Orders tab, the following have been added:
» Work Ticket display option
» Work Ticket No. column
» Work Ticket Description column

o Step No. column

Other Changes

* The text on the Configure Quantity Available Calculation window and the summary
window references work tickets instead of work orders if the Production Management
module is installed.

» You can choose whether to include work ticket quantities in the quantity available
calculation when you're running the Inventory Management Setup Wizard if the
Production Management module is installed.

¢ The text on the Item Status window references work tickets instead of work orders if
the Production Management module is installed.

* In Product Line Maintenance, if the Production Management module is activated,
the options in the Procurement field are Make to Stock, Buy to Stock, Buy to Order,
Subcontract.

Production Management

The following changes were made in the Production Management module.

Installing Production Management

The Production Management module is now part of the Sage 100 installation program.
The module is no longer available as a separate installation.

Setup Wizard

A new setup wizard has been added to guide you through setting up the module.

Production Management Options

The following changes were made in Production Management Options.
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» AYears to Retain Work Ticket History field has been added to the Main tab.

» A General Ledger check box has been added to the Integrate with section on the
Main tab.

» Arecord is written to the Activity Log after Payroll data is synchronized with
Production Management.

e The Dynamic Materials check box, which enables the feature, is now on the Entry
tab.

» A User Defined tab has been added. This tab replaces the Miscellaneous Codes
Maintenance task, which is no longer available. Use this tab to create generic code
classes that are used to categorize the codes created in User Defined Info Codes
Maintenance.

Work Ticket Template Maintenance

The following changes were made in Work Ticket Template Maintenance.

» When using the Copy From feature, you have the option to copy memaos.

» On the Materials tab, the following buttons have been added: Alias Item and ltem
Quantity Inquiry

 An Add Attachment button has been added to the Attachments tab.
Employee Maintenance

The following fields were added to the Employee Maintenance window:

e Telephone Ext

Telephone Type
E-mail Address

Pay Method

Autopay Hours

User Defined Info Codes Maintenance

User Defined Info Codes Maintenance has replaced Miscellaneous Codes Maintenance.
Use this task to create codes that can then be applied to work ticket templates. You must
first create code classes on the User Defined tab in Production Management Options.
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Attachment Category Maintenance

Attachment Category Maintenance has been added to the Setup menu. Use this task to
maintain attachment category codes and descriptions.

Work Ticket Entry

The following changes were made in Work Ticket Entry.

* You can now create and maintain memos for work tickets and steps.

» The More button has been removed and an Attachments button has been added.
* ALabor Issue Method field with a drop-down list has been added.

» A Materials Issue Method field with a drop-down list has been added.

» When creating a work ticket, bill numbers and template numbers are now entered on
the Header tab. The option to copy from bills and templates has been removed from
the Copy From window.

» When using the Copy From window, you now choose to copy from either an open
work ticket or work ticket history.

Labor Entry

Labor entries are now entered in a primary and secondary grid in which multiple records
for the same day can be viewed and modified.

Labor entries are no longer updated to the Payroll module by updating the Periodic Labor
Register. Instead, you now import labor entries into Payroll using the Labor button on the
Pay Cycle window. For more information, see "Payroll Integration Changes" (page 27).

Materials Where-Used Inquiry

In Materials Where-Used Inquiry, you have the option to view material usage in either
work tickets or templates. Also you can sort by multiple columns.

Payroll Integration Changes

The following changes related to integration with the Payroll module have been made in
Production Management.

Sage 100 Customer Upgrade Guide 27



Changes in Version 2022

e The Periodic Labor Register has been renamed Periodic Labor Report. This report is
no longer used to push labor entries to the Payroll module for use in Payroll Data
Entry.

» Labor entries are now imported into Payroll by clicking the Labor button on the Pay

Cycle window. Labor Entry records can be imported into Payroll only if Yes is
selected in the (Integrate with) Payroll field in Production Management Options.

Data Conversion for Work Order

If you're upgrading from an earlier version of Sage 100, Work Order data is included in
your source company, and the Production Management module is installed in your target
company, your Work Order data is converted to Production Management data.

Note: If you had purchase orders linked to work orders in your source data, the
purchase orders will not be linked to the converted work tickets after you run
conversion. You must manually relink the purchase orders.

Data Conversion for Earlier Version of Production Management

The Production Management module code has changed from JT to PM. When you
convert Production Management data from an earlier version of Sage 100, the converted
company data files are changed to use the PM prefix.

Important! If you're upgrading from the standalone version of Production
Management that was previously available, you must be on version 2021.x of the
standalone version before upgrading to the Production Management module that
is part of Sage 100 2022.

Note: Report settings saved in the standalone version of Production Management
are not migrated to the version of the module available with Sage 100 2022.

Sage Intelligence Reporting

Sage Intelligence Reporting now works with the 64-bit version of Sage 100 and Windows.

Sales Order

The following changes were made in the Sales Order module.
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View Order Type, Ship Date, and Expire Date in History

The following fields have been added to the Sales Order and Quote History Inquiry
window:

e Order Type
e Ship Date (for standard orders and back orders)
» Expire Date (for quotes)

These fields have also been added to the SO_SalesOrderQuoteHistoryWrk table, so they
can be added to forms.

-‘é’- We're listening! This idea was a suggestion from 90 Minds, Inc., and it received
multiple votes on the Sage 100 ideas site.

Visual Process Flows

The following changes were made to the Visual Process Flows Designer.

» You can select multiple elements at the same time by pressing the Shift key while
selecting them with your mouse. You can move and resize the elements together and
create permanent groups. For more information, see Visual Process Flow Designer
in the Sage 100 help.

» Buttons with up/down and left/right arrows have been added to the Actions window.
Use the buttons to move the Actions window to another area of the Designer window.

» Guidelines now appear when you start to move an element to help you align it with
other elements in the Designer window.

* An Underline button has been added to the text formatting toolbar.

¢ You no longer have to press the Enter key to add text to an element.

Work Order

The Production Management module has replaced Work Order. The Work Order module
is no longer part of the Sage 100 installation program.

When running conversion, if your source company has Work Order data and the
Production Management module is installed for version 2022, the Work Order data is
converted to Production Management data.
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Note: If your data includes work orders that are linked to purchase orders, you will
have to manually relink the purchase orders to work tickets after you convert the
data.

Microsoft 365

References to Office 365, including task names, have been changed to Microsoft 365.

Features No Longer Subscription Only

The following features were initially available only if you purchased Sage 100 through a
subscription plan. They are now available to all users, regardless of whether Sage 100
was purchased as a subscription or perpetual license.

» Spell Check: A red line appears underneath misspelled words. You can right-click

the word to view a list of suggestions, ignore the misspelling, or add it to your custom
dictionary.

» Full Text Search in Lookups: In Lookup views, in the Search list, you can select Full
Text. Your search criteria is then matched against all text in the records instead of a
single field.

» Theme Maintenance: This task, located on the Library Master Main menu, allows
you to customize the appearance of Sage 100 windows.

» Document Date Warnings: This feature allows you to display a warning message
when a user enters a date that is outside of settings defined in Company
Maintenance.
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Changes in Version 2021

This chapter describes the enhancements added in Sage 100 2021 and subsequent
updates for that version. Global changes are listed first, followed by module-specific
changes, any updates to Microsoft 365 integration, and then retired features.

For a list of program fixes, see the release notes for version 2021 and the release notes
for version 2021 updates.

Changes in Version 2021.6

The following enhancements were added in Version 2021.6.

Accounts Payable

The following changes were made in the Accounts Payable module.

Form 1099 Tax Reporting Version

Form 1099 Tax Reporting has been updated to version 2.98.

DBA Name for 1099 Forms

There has been a functionality change of where the 1099 DBA Name field prints on the
1099 Form.

If there is a name entered in the DBA Name field on the Additional tab in Vendor
Maintenance, it will now print on Line 1 of the Recipient Name box of the 1099 Form and
the Vendor Name will print on Line 2 of the Recipient Name box of the 1099 Form.

Updates for 1099 Form Tax Reporting

The following options have been added to support Form 1099 printing for tax year 2022:

Sage 100 Customer Upgrade Guide 31


https://cdn.na.sage.com/docs/en/customer/100erp/2021/open/SRNs.pdf
https://cdn.na.sage.com/docs/en/customer/100erp/2021/open/ProdUpdSRNs.pdf
https://cdn.na.sage.com/docs/en/customer/100erp/2021/open/ProdUpdSRNs.pdf

Changes in Version 2021.5

* Forthe 1099-DIV Form:
* Box 11 is now FATCA filing requirement check box.

» Subsequently, old box numbers 11 through 15 have been renumbered to
new box numbers 12 through 16, respectively. The new boxes are as
follows:

* Box 12 - Exempt-interest dividends
* Box 13 - Specified private activity bond interest dividends
* Box 14 - State
* Box 15 - State Identification No.
» Box 16 - State Tax Withheld
* Forthe 1099-MISC Form:
* Box 13 is now FATCA filing requirement check box

e Subsequently, old box numbers 13 through 17 have been renumbered to
new box numbers 14 through 18, respectively. The new boxes are as
follows:

* Box 14 - Excess golden parachute payments

Box 15 - Nonqualified deferred compensation

Box 16 - State tax withheld

Box 17 - State/Payer's state no.

Box 18 - State Income

Changes in Version 2021.5

The following enhancement was added in Version 2021.5.

Accounts Receivable

The following change was made in the Accounts Receivable module.
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Option to Print Zero Balance Customers with No Invoices

The Customers with No Invoices check box has been added to Statement Printing. You
can select this check box to print statements for zero balance customers that do not have
any invoice detail printing on the statement.

Changes in Version 2021.4

Version 2021.4 contains program fixes for Sage 100. For more information, please see
the release notes.

Changes in Version 2021.3

Version 2021.3 contains program fixes for Sage 100. For more information, please see
the release notes.

Changes in Version 2021.2

The following enhancements were added in Version 2021.2.

Accounts Payable

The following change was made in the Accounts Payable module.

DBA Name and Address for 1099 Forms

DBA (doing business as) name and address fields have been added to the Additional tab
in Vendor Maintenance and the Vendor Maintenance On-the-Fly window.

If a DBA name is entered, it is printed on the vendor's 1099 form jn addition to the vendor
name.

If a DBA address is entered, it is printed on the vendor’s 1099 form instead of the vendor
address.

The fields are available if an option other than None is selected in the Vendor Type field.

Updates for 1099 Form Tax Reporting

The following options have been added to support Form 1099 printing for tax year 2021:
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* Forthe 1099 MISC form:
* Box 11: Fish Purchased for Resale

* Forthe 1099 DIV form:
* Box 2e: Section 897 Ordinary Dividends
» Box 2f: Section 897 Capital Gain

Library Master
ODBC Password Support

Password fields are available when unified logon is enabled to support access through
third-party ODBC applications.

Changes in Version 2021.1

Version 2021.1 contains program fixes for Sage 100. For more information, please see
the release notes.

Changes in Version 2021

The following changes were made in version 2021.

Global Changes

The following changes are carried throughout multiple modules.

Company Types

You can now see at a glance whether the current company is live, a demo, and so forth.
After selecting types for your companies in Company Maintenance and setting up display
preferences in System Configuration, you can see the type in the title bar of your task
windows.
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Type Field in Company Maintenance

A Type field has been added in Company Maintenance. You must select one of the
following options: Live, Archive, Demo, Test.

When you upgrade from an earlier version of Sage 100, Live is automatically selected for
all companies that are converted, but you can change the type if needed.

When you install demo data, Demo is automatically selected as the company type.

Display Options in System Configuration

On the Preferences tab in System Configuration, check boxes for each company type
have been added in the Display Company Type in Windows Title Bar section.

Select one or more of these check boxes to display the company type after the company
code in the title bar for task windows.

For example: Customer Maintenance (ABC - Demo) 5/31/2025

Security Option to Delete or Overwrite Companies

A new security option has been added in Role Maintenance. If the Allow Delete/Overwrite
Live and Archive Companies check box is selected, the applicable users will be able to
delete or overwrite companies with Live or Archive selected as the type. A message
appears to confirm the intention to delete or overwrite the company.

We’'re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the

ideas site to share your ideas and vote for your favorites.

Check Number Field Expanded

The check number field has been expanded to hold 10 characters. Task windows, forms,
and reports have been updated to reflect this change.

This enhancement was carried throughout the following modules:
* Accounts Payable
* Bank Reconciliation

* General Ledger
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» Payroll (requires Sage 100 Payroll 2.21 or later)
e Purchase Order

We’'re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the

ideas site to share your ideas and vote for your favorites.

Select Which User Identifier to Display

A User Display Option field has been added to the Preferences tab in System
Configuration. Use this field to select which user identifier appears in various locations
throughout Sage 100, including report footers, the Activity Log, and so forth. The following
options are available:

e UserLogon
* Name
* User Code (the default selection)

* E-mail Address

User Logon is the default selection.

I Note: This feature is available if you purchased Sage 100 through a subscription
plan.

64-Bit Version of Sage 100

A 64-bit version of Sage 100 is now available. When running the Sage 100 installation
wizard on a computer with a 64-bit version of Windows, you’ll have the option to install
either the 32-bit version or the 64-bit version.

Warnings!

e Afterinstalling the 64-bit version of Sage 100, any 32-bit versions installed on
the same computer will no longer work.

* Ifyouinstall the 64-bit version of Sage 100 then only workstations with the 64-

bit version of Windows will be able to run Sage 100.
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If you're installing Sage 100 on a computer with a 32-bit version, you can install the 32-bit
version of Sage 100 2021, and then run the Sage 100 32-bit/64-bit Switch Utility Wizard
after you’ve converted your data and completed your testing. This utility converts your 32-
bit version of Sage 100 2021 to 64 bit.

If necessary you can also use the utility to convert from the 64-bit version of Sage 100 to
the 32-bit version.

For more information, see "Converting to 64-bit Version of Sage 100" (page 210).

Payment Center Rebranding

Paya (formerly known as Sage Payment Solutions) has retired the Payment Center
website and replaced it with the Paya Exchange website. Labels within Sage 100 have
been changed from Payment Center to Paya Exchange.

Credit card and ACH payment processing work flows have not changed. Paya Desktop
Connect has replaced Sage Exchange Desktop as the locally installed application that is
required.

Edge Used for Embedded Browser

Microsoft Edge is now used as the embedded browser in the Sage 100 Desktop if you
have a version of Edge installed that was released on or after January 15, 2020.

Edge is a more modern browser that delivers better page rendering and performance.

Map Sage 100 Users to Sage ID Accounts

A User Merge Utility has been added to the Administrative Tools window to help you map
user records created in the Sage Provisioning Portal to user records created in Sage 100.

Use this utility when you’re migrating data from an on-premises version of Sage 100 to
one in the Sage Partner Cloud. For more information, see User Merge Utility in the help.

Accounts Payable

The following changes were made in the Accounts Payable module.
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Form 1099-NEC Option in Form 1099 Tax Reporting

Nonemployee Compensation has been added to the Form Type list in Form 1099 Tax
Reporting.

A/P Open Invoices Paid Today Utility

An Open Invoices Paid Today Utility has been added to the Sage 100 Utilities menu
available from the Run Program window. Use this utility to ensure that the Paid Today
field in the Open Invoice file is set correctly when related records are missing due to
power loss or some other unusual circumstance. You can schedule the utility to run
automatically using Task Scheduler.

Accounts Receivable

The following changes were made in the Accounts Receivable module.

Use Original or Current Cost When Applying Credit Memo

When applying a credit memo to an invoice in Invoice Data Entry, you have the option to
recall Accounts Receivable invoice information from history. This option is available if Yes
or Summary is selected in the (Invoice History) Retain in Detail field in Accounts
Receivable Options.

After you enter an invoice humber, a message asks if you want to copy invoice
information from history.

If Yes is selected in the (Invoice History) Retain in Detail field, line details are included. If
Summary is selected only the invoice header information is used.

If you click Yes to use information from the history files, a second message asks if you
want to recall the item cost from history. You can click the Details button in the message
window to view the cost information from both history and inventory for each item on the
invoice. Check with your accountant about the appropriate costing method for returned
inventory.

Note: This feature is available if you purchased Sage 100 through a subscription
plan.

Sage 100 Customer Upgrade Guide 38



Changes in Version 2021

-‘@'— Your Sage 100 business partners at work! This idea was a suggestion from 90
Minds, Inc. where “More Minds Are Better Than One.”

Settings Saved When Creating Form Code in A/R Invoice Printing

When you save a new form code in A/R Invoice Printing, all of the settings are now saved.
Previously only the Paperless Office output setting was saved.

-‘@'— Your Sage 100 business partners at work! This idea was a suggestion from 90
Minds, Inc. where “More Minds Are Better Than One.”

Bank Reconciliation

The following changes were made in the Bank Reconciliation module.

Exclude Wire Transfers from Positive Pay Export

When running the Positive Pay Export Wizard, you can specify whether to include wire
transfers when the file is created.

Custom Office

The following changes were made in the Custom Office module.

Select Role When Adding UDT to UDT Maintenance

When adding a UDT to the UDT Maintenance menu, you no longer need to access Role
Maintenance to set up security for the UDT task.

In User-Defined Field and Table Maintenance, when you click the Add UDT to Desktop
button, the Menu Wizard now starts. The Select Roles page in the wizard allows you to
specify which roles will have access to the UDT task.

-‘@'— Your Sage 100 business partners at work! This idea was a suggestion from 90
Minds, Inc. where “More Minds Are Better Than One.”
Two-Line Column Descriptions

You can now create two-line column descriptions for customized grids. In the Column
Properties window, insert a carriage return token ( <CR>) to create a line break in a
column description.
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Only one line-break is allowed in the description. In a dual-grid panel with no column
description for the secondary grid, the description displays in one row when the column is
moved from the primary grid to the secondary grid.

Fixed Assets

The following enhancements were added to the Fixed Assets module.

Update in Period End Processing

The posting book check boxes in the Period End Processing window have been replaced
by a grid with Book Name and Close Book columns. The Close Book column contains
check boxes that you can select for the books that you want to process for period end.

The change was made to support the additional posting books added in Sage Fixed
Assets version 2021.

Inventory Management

The following changes were made in the Inventory Management module.

Default Date Range for Transactions

You can select a default date range for the Transactions tab in ltem Maintenance and
Item Inquiry.

The default date range is based on the selection in the Transaction Date Search Default
Selection field that has been added to the Additional tab in Inventory Options.

When viewing the Transactions tab, you can change the default date range by clicking the
Search button and entering different criteria in the Transaction Date row.

I Note: This feature is available if you purchased Sage 100 through a subscription
plan.

Library Master

The following changes were made in the Library Master module.
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Role Security Enhancements

Several security-related enhancements have been made to simplify the security setup
process.

We’'re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the

ideas site to share your ideas and vote for your favorites.

Note: Unless otherwise noted, these features are available if you purchased Sage
100 through a subscription plan.

Security Menu

A Security Menu has been added to the Library Master module. This menu includes the
tasks listed below. Some tasks are new and some were relocated from other menus.

Administrator Tools

* Export Roles (subscription only)

e Import Roles (subscription only)

* Role Maintenance

e Role Report

* Role/User Inquiry (subscription only)
* User Maintenance

e User Report

Note: The Security menu is available for both subscription and non-subscription
versions of Sage 100. However, some tasks are available only in the subscription
version.

Role Maintenance Enhancements

The following changes were made in Role Maintenance.

Role Types

A Type field has been added with types such as Admin, Auditor, Employee, and so forth.
You'll be required to select a type when creating new roles. Existing roles created in
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earlier versions of Sage 100 will automatically have Converted as the selected type, but
you can change it.

Note: The Type field is available for both subscription and non-subscription
versions of Sage 100.

Role Templates

When creating a role, you can click Copy and then select one of several predefined role
templates. Templates have been added for most modules and are available based on
which modules are installed.

To view a detailed list of permissions available with each role template, print the Role
Report and select Role Template Details in the Type of Report to Print field. You can also
view an existing template in Role Maintenance by clicking the Role Template List button
and selecting a template.

Task Tab

On the Tasks tab, you can sort the module list alphabetically or by the default menu order.
When the modules are sorted alphabetically, the subcategories are still sorted using the
default menu order.

The security alias feature has been removed for various tasks. For example, Iltem Inquiry
appears on the Sales Order Inquiries menu. In earlier versions of Role Maintenance, you
would have to go to the Inventory Management section to grant access to Iltem Inquiry in
the Sales Order module. Item Inquiry is now included in the Sales Order section.

Security Options

Security events and module options have been combined onto one tab in Role
Maintenance, and they are now referred to as Security Options.

On the Security Options tab, you can sort by module, group, or security option. When you
sort by group, the security options are still organized by module, but there are
subcategories such as Batches, Data Entry, and so forth.

Help text for the selected security option is displayed at the bottom of the window.
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Filtering Role Settings

A Filter button has been added in Role Maintenance. Click this button to open the Filter
Role Settings window, which you can use to filter the information that appears in the tree
view on the various tabs.

This window provides several filter options, such as by module and menu group. You can
apply the filter to all tabs or certain ones.
Applying Role Changes to Other Roles

After making a change to a role, you can click the Apply button to open the Apply Role
Changes window. In this window, you can select which changes to apply and to which
roles they should be applied.

Assigning Users to Roles

Click the Assign button to open the Assign Users to Role window. Use this window to

assign the current role to users in some or all companies.

Removing Users from Roles

Click the Remove button to open the Remove Users from Role window. Use this window
to remove users from the current role.

Importing and Exporting Roles

Click the Import and Export buttons to import and export roles. You must click the buttons
before selecting a role.

When you export roles, they are exported to the file and location that you specify. When
you Import a role, you can select which of the roles included in the import file that you
want to import.

Role Report Enhancements

When printing the Role Report, you can select Role Template Details in the Type of
Report to Print field to view a list of all permissions available for one or more role
templates. A Role Template field has been added to the Selections grid.

The Include Tasks and Events with No Access check box that was added in the 2020.1
update has been replaced with an Include Tasks and Options field. Use this field to
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specify whether to print tasks and security options for which the role has access, no
access, or both.

Options for sorting tasks and security options have been added.

The role type now prints on the report for both subscription and non-subscription plans.

Exclude Role Option in User Maintenance

An Exclude check box has been added to the Maintenance tab in User Maintenance. Use
this check box if you’ve assigned a role to a user for all companies, but want to exclude
them from the role in specific companies.

User Report Enhancements

The Include Tasks and Events with No Access option that was added in the 2020.1
update has been replaced with an Include Tasks and Options field. Use this field to
specify whether to print tasks and security options for which the user has either access,
no access, or both.

Options for sorting tasks and security options have been added.

Role/User Inquiry

Role/User Inquiry has been added to the Security menu. Use this task to select a role,
user, task, or security option and view related information about the selected item. The
information is displayed in a tree view and can be exported to Excel.

Maintain Default Form Codes

A new task, Default Form Maintenance, has been added to the Library Master Setup
menu.

Use this task to:
* Maintain default form codes by company and role or individual user.

» Select a template for Standard form codes if it there is no template already
associated with the code.

* Prevent users from changing the default form code within the form tasks.

Sage 100 Customer Upgrade Guide 44



Changes in Version 2021

I Note: This feature is available if you purchased Sage 100 through a subscription
plan.

-‘@'— Your Sage 100 business partners at work! This idea was a suggestion from 90
Minds, Inc. where “More Minds Are Better Than One.”

Copy Custom Forms, Custom Reports, and Settings

When copying a company in Company Maintenance, you have the option to copy form
and report settings, default form selections, custom forms, and custom reports.

Select the Forms check box to copy the form settings, default form selections, and
custom forms from the source company to the destination company.

Select the Reports check box to copy report settings and custom reports from the source
company to the destination company.

I Note: This feature is available if you purchased Sage 100 through a subscription
plan.

-‘@'— Your Sage 100 business partners at work! This idea was a suggestion from 90
Minds, Inc. where “More Minds Are Better Than One.”

Build Search Index for Specific Company Types

When running the Build Search Index utility for the advanced auto-complete feature, you
can now specify which company types to index.

In Task Scheduler, you can specify the company type codes in the Run Time Arguments
field, which has been added to the Tasks tab. This new field appears when Build Search
Index is selected in the Task field.

Access Administrative Tools

You can now access the Administrative Tools window from the Library Master Main
menu.

OAuth Authentication for SMTP Mail Server

On the E-mail tab in Company Maintenance, you can now select between two
authentication methods to use when connecting to the SMTP server:
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» Basic: This option works the same as earlier versions of Sage.

* OAuth (Open Authorization): This new option is an open standard authorization
protocol used to grant access using access tokens instead of sharing a user name
and password.

If you're going to use the OAuth method, you will need to obtain your OAuth client
credentials from your authenticating application, such as those offered by Microsoft and
Google. To learn more, visit oauth.net.

I Note: This feature is available if you purchased Sage 100 through a subscription
plan.

ACA PIl Worktable Available in Report Manager

When adding a Payroll report using the Report Manager wizard, you have the option to
include the ACA PII (personally identifiable information) worktable in the report.

Paperless Office

The following changes were made in the Paperless Office module.

Default Delivery Options

A new Default Delivery Options task has been added to the Paperless Office Setup menu.
Use this task to make default form selections that are automatically set in the Paperless
Office Delivery Options window when creating a new customer or vendor record. You can
change the defaults if needed.

I Note: This feature is available if you purchased Sage 100 through a subscription
plan.

We’'re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the

ideas site to share your ideas and vote for your favorites.

Electronic Delivery Log

An Electronic Delivery Log button has been added to the following tasks:
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» Customer Viewer

* Vendor Viewer

* Employee Viewer

* Journal and Register Viewer
e Period End Reports Viewer

* Report Viewer

Select a document and then click this button to view the most recent date and time that
the document was sent, the user logon of the person who sent it, the status of the
submission attempt, and the recipient's email or fax number.

Click the Electronic Delivery Submissions List button to view a list of all attempts to send
the document.

View List of Documents That Have Been Sent
Two inquiry tasks have been added to the Paperless Office Main menu:
» Customer Electronic Delivery Inquiry

* Vendor Electronic Delivery Inquiry
Use these tasks to view a list of documents that have been sent to customers and
vendors.

You have several options for filtering the list, including the delivery type and status. The
status reflects whether emails were successfully submitted to the SMTP server and
whether faxes were successfully submitted to the fax server.

You can resend the documents from the list box or export the list to Microsoft Excel.

Note: These features are available if you purchased Sage 100 through a
subscription plan.

—‘@'— Your Sage 100 business partners at work! This idea was a suggestion from 90
Minds, Inc. where “More Minds Are Better Than One.”
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Email Additional Salespeople

When sending forms to customers, you can also send them to all salespeople who are
receiving a commission on the sale.

To enable this feature, select the E-mail Add’l Slspn check box that has been added to
the Paperless Office Delivery Options window accessed through Salesperson
Maintenance. You can enable the feature for:

¢ Statements
e Sales orders

e Sales Order invoices

Document Lookup in Paperless Office Delivery Options

A Document Lookup button has been added next to the Document field in Paperless
Office Delivery Options. Click the button to view a list of forms that have been set up for
the selected customer or vendor.

New Options for Associated Documents

You are no longer limited to PDF files when associating documents with journals and
registers. Any document type can be associated, including Word documents, Excel
workbooks, images, and so forth. Field labels in various windows have been updated to
reflect the change.

In the Journal and Register Viewer, you can click the Edit Associated Document button to:
» Select a different document to associate with the journal or register.

» Add a document if none was previously associated.

* Remove an associated document.

The button is available based on a new security option, Allow Editing of Associated
Document for Journal and Register PDF Documents.

Documents are Updated Only If Printed and Sent

Forms are no longer flagged as updated when they are printed as PDFs but not
electronically delivered due to an interruption in the process.
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Previously when the printing and delivery process was interrupted, forms were
sometimes flagged as updated when they were printed but not sent.

This update affects the following forms:
* Accounts Receivable Invoice Printing
* Job Cost Invoice Printing

e Purchase Order Printing

* Return Order Printing

* Customer RMA Printing

* RMA Receiver Printing

e Sales Order Printing

» Sales Order Invoice Printing

-‘@'— Your Sage 100 business partners at work! This idea was a suggestion from 90
Minds, Inc. where “More Minds Are Better Than One.”

Purchase Order

The following changes were made in the Purchase Order module.

-‘@'— Your Sage 100 business partners at work! This idea was a suggestion from 90
Minds, Inc. where “More Minds Are Better Than One.”

Purchases Clearing From History Report

The Purchases Clearing From History Report has been added to the Purchase Order
Period End Processing menu.

Unlike the Purchases Clearing Report, you can run this report after running period end
processing, so you can get the information needed to reconcile the purchases clearing
account at any time.

Invoice Lines Added in Receipt History Inquiry

When viewing a receipt of invoice record in Receipt History Inquiry, the invoice lines now
appear on the Lines tab.
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Invoice Lines Added to Receipt History Report

Line details from receipt of invoice records are now included on the Receipt History
Report when you select the Print Line Information check box if you’re retaining history in
Purchase Order Options.

Drill Down Options in Purchase Order Entry and Inquiry

Two drill-down buttons have been added to the Totals tab in Purchase Order Entry and
Purchase Order Inquiry.

A Receipt History Inquiry button has been added next to the Last Receipt Date field. If
one or more receipts exist for the purchase order, you can click the button to view the
receipt(s).

An Invoice History Inquiry button has been added next to the Last Invoice Date field. If
one or more invoices exist for the purchase order, you can click the button to view the
invoice(s).

Note: During data conversion, the program attempts to populate the P/O Receipts
History Detail file using line detail from the A/P Invoice History Detail file for
existing Receipt of Invoice Records. However, the line detail will not be populated
if the line detail does not exist in the A/P file.

Form 1099-NEC Option Available

You can select the 1099-Nonemployee Comp form when entering a document in the
following tasks:

Purchase Order Entry

Receipt of Goods Entry

Receipt of Invoice Entry

Return of Goods Entry

We’'re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the

ideas site to share your ideas and vote for your favorites.
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Sales Order

The following changes were made in the Sales Order module.

Suppress Prompts in Daily Sales Reports/Updates

You can now suppress the prompts that ask you to print the reports listed below when
printing from Daily Sales Reports/Updates. The reports will print automatically.

» Daily Sales Recap Reports
» Gross Profit Journal

e Shipping Exception Report
» Job Transaction Journal
 Daily Back Order Report

» Daily Deposit Recap

To automatically print the reports without prompts, go to Sales Order Options and, on the
Printing tab, select the Automatically Print All Additional Reports That Apply check box.

The reports listed above are available based on how the Sales Order module is set up.

Note: This feature is available if you purchased Sage 100 through a subscription
plan.

—‘@'— Your Sage 100 business partners at work! This idea was a suggestion from 90
Minds, Inc. where “More Minds Are Better Than One.”

Use Original or Current Cost When Applying Credit Memo

When applying a credit memo to an invoice in Invoice Data Entry, you have the option to
recall invoice information from history. This option is available if Yes or Summary is
selected in the (Invoice History) Retain in Detail field in Accounts Receivable Options.

After you enter an invoice number, a message asks if you want to copy invoice
information from history.

If Yes is selected in the (Invoice History) Retain in Detail field, line details are included. If
Summary is selected only the invoice header information is used.
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If you click Yes to use information from the history files, a second message asks if you
want to recall the item cost from history. You can click the Details button in the message
window to view the cost information from both history and inventory for each item on the
invoice. Check with your accountant about the appropriate costing method for returned
inventory.

Note: This feature is available if you purchased Sage 100 through a subscription
plan.

-‘é’- Your Sage 100 business partners at work! This idea was a suggestion from 90
Minds, Inc. where “More Minds Are Better Than One.”

Visual Integrator

The following changes were made in the Visual Integrator module.

Options for Managing Log Files

A Setup menu has been added to the Visual Integrator module. Visual Integrator Options
has been added to the menu.

In Visual Integrator Options you can manage the log files that are generated when
running import and export jobs and when automatically scheduled jobs are run.

You can specify whether to reuse the existing log files when jobs are run or create new
ones. You can also select the location where log files are saved.

Visual Process Flows

Visual Process Flows are now based on HTMLS5 instead of Adobe Flash. The new visual
process flows feature a blue and white color scheme and new images. Some images are
no longer available.

Tool tips no longer appear when hovering over an icon. Instead you must click the icon to
see the tool tip. If a visual process flow had multiple tool tips, they have been combined.

By default, tool tips, print options, report options, and inquiry selections are shown. After
opening a visual process flow, click twice on an icon to hide the corresponding
information. After you’ve hidden the information, you can click once to show it or hide it
again.
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If you’ve created custom visual process flows in earlier versions of Sage 100, they will still
work, with the exception of the show/hide functionality. However, you should review them
because adjustments may be needed.

The editor for customizing visual process flows has been redesigned.

Office 365 Integration

A new task, Self Service Invitations, has been added to the Office 365 Integration menu
in the Library Master module. Use this task to send email invitations to employees so that
they can start using the employee self service features.

You must have the Payroll module to use the employee self service features, and the
employees must have records created in Employee Maintenance.

Sage 100 Customer Upgrade Guide 53



Changes in Version 2020

Changes in Version 2020

This chapter describes the enhancements added in Sage 100 2023 and subsequent
updates for that version. Global changes are listed first, followed by module-specific
changes, any updates to Microsoft 365 integration, and then retired features.

For a list of program fixes, see the version 2020 release notes and the release notes for
version 2020 updates.

Changes in Version 2020.6

The following change was made in update 6 for Sage 100 2020.

Library Master

The following change was made in the Library Master module.

OAuth Authentication for SMTP Mail Server

On the E-mail tab in Company Maintenance, you can now select between two email
authentication methods to use when connecting to the SMTP server:

« Basic Email Authentication: This option works the same as earlier versions of Sage.

* Modern Email Authentication or Open Authorization (OAuth): This new option is an
open standard authorization protocol used to grant access using access tokens
instead of sharing a user name and password.

If you're going to use the OAuth method, you will need to obtain your OAuth client
credentials from your authenticating application, such as those offered by Microsoft® and
Google®. To learn more, visit oauth.net.

For instructions on setting up OAuth in Sage 100, see How to Configure Sage 100 OAuth

Email Settings.

Changes in Version 2020.5

Update 5 for Sage 100 2020 contains program fixes. For more information, please see
the release notes.
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Changes in Version 2020.4

The following changes were made in update 4 for version 2020.

Accounts Payable

The following changes were made in the Accounts Payable module.

Updates for 1099 Form Tax Reporting

The following options have been added to support Form 1099 printing for tax year 2021:
e Forthe 1099 MISC form:

» Box 11: Fish Purchased for Resale

e Forthe 1099 DIV form:
» Box 2e: Section 897 Ordinary Dividends
» Box 2f: Section 897 Capital Gain

Changes in Version 2020.3

Update 3 for Sage 100 2020 contains program fixes. For more information, please see
the release notes.

Changes in Version 2020.2

The following changes were made in update 2 for Sage 100 2020.

Global Changes

The following change was made in update 2.

Map Sage 100 Users to Sage ID Accounts

A User Merge Utility has been added to the Administrative Tools window to help you map
user records created in the Sage Provisioning Portal to user records created in Sage 100.
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Use this utility when you’re migrating data from an on-premises version of Sage 100 to
one in the Sage Partner Cloud. For more information, see User Merge Utility in the help.

Library Master

The following changes were made in the Library Master module.

Access Administrative Tools

You can now access the Administrative Tools window from the Library Master Main
menu.

ACA PIl Worktable Available in Report Manager

When adding a Payroll report using the Report Manager wizard, you have the option to
include the ACA PII (personally identifiable information) worktable in the report.

Purchase Order

The following changes were made in the Purchase Order module.

Form 1099-NEC Option Available

You can select the 1099-Nonemployee Comp form when entering a document in the
following tasks:

Purchase Order Entry

Receipt of Goods Entry

Receipt of Invoice Entry

Return of Goods Entry

Changes in Version 2020.1

The following changes were made in update 1 for Sage 100 2020.

Accounts Payable

The following changes were made in the Accounts Payable module.
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Easily Add Distribution Balance to Current Line

A Net Balance button has been added in the following locations:

 Invoice Data Entry Lines tab
» Repetitive Invoice Entry Lines tab

» General Ledger Distribution window accessed through Manual Check and Payment
Entry

Click the Net Balance button to add the undistributed balance to the current line.

-‘@'— Your Sage 100 business partners at work! This idea was a suggestion from 90
Minds, Inc. where “More Minds Are Better Than One.”

Form 1099-NEC Option in Form 1099 Tax Reporting

Nonemployee Compensation has been added to the Form Type list in Form 1099 Tax
Reporting.

The 1099-NEC form was added in other locations in the 2020 update. For more
information, see 1099-NEC Form Added under What's New in Version 2020.

Accounts Receivable

The following changes were made in the Accounts Receivable module.

Payments Tab Added to Invoice History Inquiry

A Payments tab has been added to Invoice History Inquiry. The tab shows all payments
applied to the selected invoice.

You can click the Cash Receipts History button to view more details about payments
processed through Cash Receipts Entry.

You can click the Payment Information button to view more details about credit card and
ACH payments.

-‘@'— Your Sage 100 business partners at work! This idea was a suggestion from 90
Minds, Inc. where “More Minds Are Better Than One.”

Sage 100 Customer Upgrade Guide 57



Changes in Version 2020.1

Run Utility for Payments Today Fields as Scheduled Task

The utility used to update the Payments Today field, previously named ARWAR4, has
been renamed AR_OpenlinvoicePaymentsToday_ui. You can set up a scheduled task to
run this utility in Task Scheduler.

Note that the logic behind the utility now runs automatically when you’re working in Cash
Receipts Entry and A/P from A/R Clearing.

Fixed Assets

The following changes were made in the Fixed Assets module.

Update in Period End Processing

The posting book check boxes in the Period End Processing window have been replaced
by a grid with Book Name and Close Book columns. The Close Book column contains
check boxes that you can select for the books that you want to process for period end.

This change was made to support the additional posting books added in Sage Fixed
Assets version 2021.

Inventory Management

The following changes were made in the Inventory Management module.

Ability to Trace Item Use by Lot and Serial Number

You now have multiple options to trace where items from a particular lot or with a
particular serial number have been used, including items used as bill and kit components.

Note that the ability to trace items is applicable only to transactions processed after
you've installed this update .

I Note: This feature is available if you purchased Sage 100 through a subscription
plan.
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Where-Used Inquiry Window

A Where Used button has been added to the Lot/Serial Inquiry window accessed from the
Main menu or from Item Maintenance. You can click the Where Used button to see where
items from the current lot or with the current serial number were used as a component of a
sales kit or a bill. The button is available when you select a Sales Order invoice with the
type Sl, or a Production Entry transaction with the type BI.

Other Changes in Lot/Serial Inquiry

Additional changes have been made to the Lot/Serial Inquiry window accessed from the
Main menu.

» The item code and description now appear on the main window instead of in the list
box.

e If alot or serial number has more than one item associated with it, the Item List
window automatically opens so that you can select an item.

e The item code has also been removed from the Search for Lot/Serial Transactions
window.

e The Zoom button has been renamed History Inquiry.
* When you click the OK button, the information displayed in the window is cleared,
and you can select a different lot or serial number.

Customer Recall Report

The new Customer Recall Report has been added to the Reports menu, and it can be
accessed from Lot/Serial Inquiry when the task is accessed from the Main menu.

Use this report to view a list of customers to whom you have sold or shipped lot or serial
items that must be recalled.

Lot Serial Transaction History Report

A Print Where-Used Items check box has been added to the Lot Serial Transaction
History Report. When this check box is selected, the report shows the transactions in
which lot and serial items have been used either as a standalone item or as a component
of a bill or sales kit.

We’re listening! Lot and serial traceability was a suggestion on the Sage 100 ideas

site. Visit the ideas site to share your ideas and vote for your favorites.
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Library Master

The following changes were made in the Library Master module.

Exclude Tasks and Events from Reports Based on Access

You can exclude unnecessary information from reports by clearing the Include Tasks and
Events with No Access check box.

The check box has been added to the following report tasks:
* Role Report

e User Report

If this check box is cleared, the tasks and events to which the role or user has no access
are excluded from the reports.

I Note: This feature is available if you purchased Sage 100 through a subscription
plan.

-‘@'— Your Sage 100 business partners at work! This idea was a suggestion from 90
Minds, Inc. where “More Minds Are Better Than One.”

Visual Integrator

The following changes were made in the Visual Integrator module.

Filter Options for Job Log

A Filter List button has been added to the Job Log window. You can filter by the status
(failed or skipped) or you can filter by records that passed but have one or more invalid
fields.

Export Option for Job Log

After filtering records for an import job using the new Filter List button, you can click the
Export List button to export two files:

» Afile that contains the filtered records. This file is the same type as the original
source file, and the records are formatted the same way so that you can make
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corrections and then import the file again.

If the job definition indicated that the first record in the original source file is a list of
field names, this record is copied as the first record in the new output file.

» Atext file with information on why each record failed.

The files are exported to the same folder where the original file is stored. The file names
will match the original source file name with the time and date appended.

Row Number in Job Log

When importing data using either an ASCI| file or a delimited file as the source, the row
number from the source file appears in the Job Log.

ALE Lookups For Job Numbers

ALE lookups are now used when selecting jobs in the following locations:
» Export Job Selection window that opens when you start Export Job Maintenance
» Import Job Selection window that opens when you start Import Job Maintenance

e Copy From button and Chain To fields in Export Job Maintenance and Import Job
Maintenance

e Job Select

Browse Buttons on Log Detail Window

Browse buttons have been added to the Record Detail window. Use the buttons to
navigate to the next, previous, first, and last record.

Company Colors Used for Import and Export Jobs

If you have a company-specific background color set up in Company Maintenance, the
color is now used for certain screens in Visual Integrator when you’re working with import
and export jobs. For example, you’ll see the color when you select a job, and view the job
log. Not all screens are affected because Visual Integrator is not company-specific.

—‘@'— Your Sage 100 business partners at work! This idea was a suggestion from 90
Minds, Inc. where “More Minds Are Better Than One.”
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Changes in Version 2020

The following changes were made in Sage 100 2020.

Global

The following changes are carried throughout multiple modules.

Expanded Name Fields
The following fields have been expanded to 50 characters:

e Customer name

Customer contact name

Vendor contact name

Confirm to name

Requested by name

The fields previously held 30 characters. Note that the field for vendor names was
expanded to 50 characters in a previous release.

We’'re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the

ideas site to share your ideas and vote for your favorites.

Expanded Fields for Address Information

The following fields have been expanded for customer, vendor, and employee
addresses:

¢ Address lines: from 30 to 40 characters
 City: from 20 to 30 characters

e Country name: from 30 to 50 characters

Changes for Telephone and Fax Fields

The following changes have been made for telephone and fax number fields.
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» Telephone and fax number fields have been expanded from 17 to 20 characters.
* The telephone extension field has been expanded from 5 to 6 characters.

» A Type field has been added for customer, vendor, and contact telephone numbers.
You can select Work, Cell, Home, or Other.

* A Primary check box has been added for the two telephone number fields in
Customer Contact Maintenance and Vendor Contact Maintenance.

International Address Support

You can now enter an international address for customers, vendors, and contacts. To
support international addresses, the following changes have been made:

* The Country field has been moved above the address lines. A country code is
needed to ensure that the correct city and state or province is entered based on the
ZIP or postal code.

» ZIP Code fields have been renamed ZIP/Postal Code.

» State fields have been renamed State/Province.

e Telephone and fax number fields support international number formats.
* In Company Maintenance, the following changes were made:

¢ On the Main tab, the following fields were added: Country, ZIP/Postal Code, City,
State/Province.

* An Additional tab was added to this task. The federal and state tax ID number fields
were moved to this tab, and fields for contact information and a trade name were
added.

* On the Preferences tab, a Default Country Code field was added.

Maintenance Task for State and Province Codes

State/Province Code Maintenance has been added to the Library Master Setup menu.
State and province codes are maintained for each country code. You can enter and
maintain the state or province name, alternate code, and geocode. The state and
province codes for Canada and the United States are prepopulated.
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Default Country Code

A Default Country Code field has been added to the Preferences tab in Company
Maintenance. The default code will be automatically used in data entry and maintenance
tasks, but it can be changed.

Data Conversion

When you convert your company data from an earlier version of Sage 100, USA will
automatically be entered as the default country code on the Preferences tab in Company
Maintenance.

Various Task Window Updates

To accommodate the expanded fields and longer field labels, some task windows have
been resized, and fields were rearranged on others. In some instances in which the field
is view-only, it may be truncated due to space constraints.

Report and Listing Updates

Reports and listings have been modified to accommodate updated fields and formats.
The longer customer and contact names are accommodated if they print on a separate
line or if there is enough space.

Form Updates

The expanded field sizes are reflected in the work tables, but the forms have not been
updated to accommodate the expanded fields.

The Country, City, State/Province, and ZIP/Postal Code fields added in Company
Maintenance have been added to the work tables, but they have not been added to the
forms. The forms still print the information in the four address lines that were on the
window prior to this release.

Country Code Selections Grid Option

A Country Code field has been added to the Selections grid for various form printing
tasks. For any source documents with no value in the Country Code field, the default
country code entered in Company Maintenance will be used for selection purposes.
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Import Jobs

Any Visual Integrator import jobs that include address information must be modified to
include the CountryCode column, and it must be imported before the ZipCode column.

Payroll Version

If you're using Sage 100 Payroll, you must upgrade to version 2.20.1. Earlier versions
have not been updated to support international addresses, and you will encounter errors.
More changes to support international addresses are planned for Sage 100 Payroll
2.20.2.

We’'re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the

ideas site to share your ideas and vote for your favorites.

Map Service Choices

You now have a choice of which map service to use when you click a Map button next to
address field. A Select Map Service field has been added to the following locations:

* The Preferences tab in User Maintenance.

* The User Settings window accessed from the File menu.

You can select Bing Maps, Google Maps, or MapQuest.

Note: This feature is available if you purchased Sage 100 through a subscription
plan.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the

ideas site to share your ideas and vote for your favorites.

Export to Excel Button Added for List Boxes

An Export to Excel button allows you to export the contents of a list box to Microsoft
Excel. The button has been added for numerous list boxes throughout Sage 100.

As part of this enhancement, the related module option in Role Maintenance has been
renamed Allow Export to Excel from Lookups/Grids/Lists.
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Add PIll Work Tables To Custom Reports

You can add multiple work tables that contain personally identifiable information (PII) to
custom reports. When running the Menu Wizard accessed through Report Manager, if
you’re adding a custom report for which work tables that contain PII are available, you'll
have the opportunity to add them. Note that users’ ability to view Pl is dependent on their
role security. Currently only the General Ledger and Payroll modules include work tables
that contain PII.

Admin Rights Not Required for Workstation Synchronization

You no longer need administrative rights on your workstation to run the Workstation
Synchronization program that automatically starts after some Sage 100 updates are
installed on the server.

To eliminate the need for administrative rights, some files are now installed in a different
location. The Sage folder that was previously installed in this location:

C:\Program Files (x86)\Common Files
Is now installed in this location:

C:\Program Data

New Desktop Utilities

You can access two utilities from the Sage 100 Desktop File menu.

Customization Import

Use this utility to import custom settings if you were using the classic Desktop in an earlier
version of Sage 100 and made any of the following customizations:

* Added tasks to a public or private folder on the My Tasks tab

* Added tasks or shortcuts to other programs to the button bar

If you’re using the latest version of Sage 100 on the same workstation as your earlier
version, the utility adds your public and private tasks and shortcuts to other programs to
the Favorites panel on the standard Desktop.

To start this utility, on the Desktop File menu, point to Desktop Utilities, and click
Customization Import.
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Logging Level

Use this utility if asked to do so by Sage customer support. This utility was previously
accessed by browsing to the ..\MAS90\Launcher\ folder and double-clicking
launcher.logging.exe.

To start this utility, on the Desktop File menu, point to Desktop Utilities, and click Logging
Level.

Links to Sage University Training

A Sage University button (ﬁ) has been added to additional task windows in the

Common Information and Library Master modules and to the Visual Process Flows
Manager window.

Click the button to view a list of training videos related to the task. Depending on your
Business Care plan, there may be no charge to watch the videos.

Accounts Payable

The following changes were made in the Accounts Payable module.

Encrypt PII for Inactive Vendors

As a means to comply with consumer privacy laws that require you to either delete or
deidentify personally identifiable information (Pll) so that it can’t be used to identify an
individual, there are two ways to encrypt an inactive vendor’s PII:

* An Encrypt button has been added to the Additional tab in Vendor Maintenance.

* An Encrypt Vendor Personally Identifiable Information utility has been added to the
Accounts Payable Utilities menu. You can use this utility to encrypt vendor PlI if the
vendor’s record has already been deleted in Vendor Maintenance.

After Pll is encrypted, it no longer appears in task windows or reports. Furthermore, the
data cannot be viewed in Data File Display and Maintenance or accessed through Visual
Integrator or external reporting using an ODBC data source. For more information, see
Encryption for Inactive Vendors' Personally Identifiable Information in the help.
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I Note: This feature is available if you purchased Sage 100 through a subscription
plan.

Reverse Check Run Utility

A Reverse Check Run utility has been added to the Accounts Payable Utilities menu. You
can use this utility to reverse an entire check run. Check runs are selected by entering
either a register number or a bank code and check number. Checks with a type of Auto (a
standard check) and Electronic that are posted to the cash disbursements journal can be
reversed.

I Note: This feature is available if you purchased Sage 100 through a subscription
plan.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the

ideas site to share your ideas and vote for your favorites.

New Options for Retaining Paid Invoices
Two new fields have been added to the Additional tab in Accounts Payable Options:
* Months to Retain Paid Invoices (replaces Days to Retain Paid Invoices)

» Purge Paid Invoices During

You can enter a value ranging from 0 to 9,999 in the months field, and select whether
paid invoices are purged during period-end or year-end processing.

Note: These fields are available if you purchased Sage 100 through a subscription
plan; otherwise, you’ll still have the Days to Retain Paid Invoices field.

We’'re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the

ideas site to share your ideas and vote for your favorites.

1099-NEC Form Added

The IRS is introducing Form 1099-NEC, used to report nonemployee compensation, for
tax year 2020. Nonemployee Comp (to be used for Form 1099-NEC) is now available to
select in the following locations:
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Vendor Maintenance — Default Form field on Additional tab

1099 Payment History window — 1099 Form Type field

A/P Invoice Data Entry — (1099 Payment) Form field on the Header tab

Manual Check and Payment Entry — 1099 Form field on the Lines tab

Because From 1099-NEC is now used for nonemployee compensation, changes have
been made to Form-1099 MISC. Included in the changes, Box 7 is now used for the Payer
Made Direct Sales of $5,000 or More check box. For more details on the form changes,
see the IRS website: www.irs.gov/instructions/i1099msc

In Vendor Maintenance, the Misc Box 9 check box has been renamed Payer Made Direct
Sales $5000+. This check box is now used for Box 7 on Form 1099-MISC.

If you’ve already recorded nonemployee compensation for tax year 2020 in Box 7, a utility
is available to more the totals to Box 1. Contact Sage Support for more information.

Unlimited Cost Types in Open Invoice By Job Report

You are no longer limited to selecting only 12 cost types when printing the Open Invoice
by Jobs Report. In the Cost Types to Print section of the task window, the check boxes for
individual cost types have been replaced with a Select Cost Types button. Click this
button to open the Cost Type Selection window and select all cost types needed for the
report.

Relocation of Paperless Option in Vendor Maintenance

To access the Paperless Office Delivery Options window from Vendor Maintenance, click
the arrow in the top-right corner of the window, and then select Paperless Delivery
Options.

Accounts Receivable

The following changes were made in the Accounts Receivable module.

elnvoicing for Accounts Receivable Invoices

Through the elnvoicing feature that works with Paya Connect Desktop, you can send your
customers emails that include an invoice summary and a link for online payments.
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Customers can use the payment link to make online credit card and ACH payments. If
you’re using Paperless Office for invoicing, the invoice PDF is attached to the email. After
customers make online payments, you can import them into Cash Receipts Entry.

There are two ways to enable elnvoicing for customers:

* To enable the feature for an individual customer, select the elnvoice Payments check
box on the Additional tab in Customer Maintenance.

* To enable the feature for a range of customers, use the Global Customer Field
Change utility.

An elnvoice Payments check box has been added to the Header tab in Invoice Data
Entry. The check box is selected by default if the elnvoice Payments check box in
Customer Maintenance is selected, but you can clear it as needed.

If the check box is selected, the invoice information is sent to Paya when the Sales
Journal is updated, and the email with the invoice information and Pay Now link is then
sent to the customer.

An elnvoice Payments button has been added to the Cash Receipts Deposit window.
Click this button to import online payments.

A merchant account with Paya (formerly Sage Payment Solutions) is required to use
elnvoicing. Paya will provide you with a user ID and API key, which you must enter in
System Configuration.

Next, enable the feature in Company Maintenance, and then you can enable it for
customers in Customer Maintenance. For more information, see the elnvoicing article in
the Sage 100 help.

A utility, elnvoicing Error Log Viewer, has been added to the Accounts Receivable
Utilities menu. After you update the Sales Journal, a message lets you know if there were
any invoices that should have been sent to Paya Connect but were not. Use the viewer to
see which invoices were not sent, view error information, and send the invoices to Paya
Connect.

Note: This feature is available if you purchased Sage 100 through a subscription
plan.
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Viewing Addresses in Invoice History Inquiry

In Invoice History Inquiry, the address no longer appears on the Main tab. Click the new
Addresses button to view the bill-to and ship-to addresses for the invoice.

New Options for Retaining Paid Invoices

Two new fields have been added to the Additional tab in Accounts Receivable Options:
* Months to Retain Paid Invoices (replaces Days to Retain Paid Invoices)

e Purge Paid Invoices During

You can enter a value ranging from 0 to 9,999 in the months field, and select whether paid
invoices are purged during period-end or year-end processing.

Note: These fields are available if you purchased Sage 100 through a subscription
plan; otherwise, you'll still have the Days to Retain Paid Invoices field.

We’'re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the

ideas site to share your ideas and vote for your favorites.

Encrypt Pl for Inactive Customers

As a means to comply with consumer privacy laws that require you to either delete or
deidentify personally identifiable information (Pll) so that it can’t be used to identify an
individual, there are two ways to encrypt an inactive customer’s PII:

* An Encrypt button has been added to the Additional tab in Customer Maintenance.

* An Encrypt Customer Personally Identifiable Information utility has been added to the
Accounts Receivable Utilities menu. You can use this utility if the customer’s record
has been deleted in Customer Maintenance.

After Pll is encrypted, it no longer appears in task windows or reports. Furthermore, the
data cannot be viewed in Data File Display and Maintenance or accessed through Visual
Integrator or external reporting using an ODBC data source. For more information, see
Encryption for Inactive Customers' Personally Identifiable Information in the help.

Note: This feature is available if you purchased Sage 100 through a subscription
plan.
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Relocation of Paperless Option in Customer Maintenance

To access the Paperless Office Delivery Options window from Customer Maintenance,
click the arrow in the top-right corner of the window, and then select Paperless Delivery
Options.

Custom Office

The following changes were made in the Custom Office module.

Improved Grid Customization

When you’re editing a panel with a grid, right-clicking within the grid now opens the
Customize Grid Definition window. The appearance of the grid is virtually identical to its
appearance in Sage 100 task windows. As you edit the grid

» Drag and drop columns to rearrange them.

« Ifthe panel has a primary and secondary grid, drag and drop columns to move them
from one grid to another.

* Click a column label to open the Column Properties window, which lets you specify
various properties, such the column length and description, and whether it’s locked.

¢ Click the Add Column button to add additional columns.

e Access the Bulk Hide window, which lets you set the Hidden option for all columns in
the grid.

Note: This feature is available if you purchased Sage 100 through a subscription
plan.

We’'re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the

ideas site to share your ideas and vote for your favorites.

Apply Grid Customizations to a Customization Group

When selecting a customization group from the User list in the Customizer Panel
Selection window, you can now customize the grid(s) included in the panel. The
customized grids will be available to all users in the customization group.
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Save UDF Changes in Pending Status

It's no longer necessary to choose between updating your user-defined field (UDF)
changes right away or discarding them. UDF additions and modifications are now saved
in a pending table. In the User-Defined Fields window, when you click Cancel, a message
will let you know that your changes have been saved. You can return to the User-Defined
Fields window at a later time to continue working on your changes and update them when
you’re ready.

A new task, Pending Changes Summary, has been added to the Custom Office Main
menu. You can also access this task by clicking the Summary of Pending Changes button
in User-Defined Field and Table Maintenance.

Use this task to view a list of pending changes. Click the Update All button to update all
changes. If you have changes for multiple tables, a message appears after each table
has been updated. You can click Continue to update the remaining tables or click Stop to
leave the remaining changes in pending status to be updated at a later time.

When you have changes in pending status, a Pending folder appears beneath the module
listin User-Defined Field and Table Maintenance. Expand the folder to view a list of
tables with pending changes. You can select a table and click the Delete Pending
Changes button to delete all pending changes for the table.

You can schedule an update of the pending changes using Task Scheduler.

Note: This feature is available if you purchased Sage 100 through a subscription
plan.

Mask Information in Data Entry Fields

A Mask Display check box has been added to the Options tab in the Multi-Line Definition
window. Select this check box to display filled-in circles in place of the actual characters
when data is entered into this field.

Note that the data is not encrypted and it is masked only when displayed in task windows.
For example, the actual characters would appear if this field is added to a lookup view or if
you viewed the table in Data File Display and Maintenance.
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A Mask Display check box has also been added to the Add/Edit Field window. If you
select this check box, the Mask Display check box in the Multi-Line Definition window is
selected by default when you add the UDF to a panel.

Inventory Management

The following changes were made in the Inventory Management module.

Expiration Dates for Lot and Serial Items

Expiration dates can be added for items with lot or serial numbers when items are
received into inventory or produced through Bill of Materials. Expiration dates can be
manually entered, or you can enter settings to automatically calculate them. You can also
calculate sell-by, use-by, and return dates to determine how many days before or after an
item's expiration date it can be distributed.

Note: This feature is available if you purchased Sage 100 through a subscription
plan.

The expiration date feature must be enabled in Inventory Management Options, and the
related settings are entered in this task. However, you can override the settings for
product lines and individual items in Product Line Maintenance and ltem Maintenance.

For more information, see Set Up Expiration Dates for Lot and Serial ltems in the Sage
100 2020 help.

Utility for Adding and Changing Expiration Dates

The Change Lot and Serial Expiration Dates utility has been added to the Inventory
Management Utilities menu. Use this utility to add expiration dates for existing items and
to change any expiration dates that have already been entered.

Note: Before using the utility, you must:
e Enable the expiration date feature in Inventory Management Options.

e Forapplicable items, select the Track Lot/Serial Expiration Date check box in
the Lot/Serial Expiration Settings window, accessed using the More button in
Item Maintenance.
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For more information, see Change or Add Expiration Dates for Lot and Serial ltems in the
Sage 100 help.
Change Lot/Serial Expiration Date from ltem Maintenance

To change expiration dates for lots or serial numbers one at a time, click the Change
Lot/Serial Expiration Date button, which has been added to the Cost Detail tab in ltem
Maintenance.

Option to Exclude Expired Items From Reorder Calculations

An Include All Expired Lot/Serial Items in Quantity Available check box has been added
to the following windows:

* Auto Reorder Selection (Purchase Order)

* Inventory Reorder Report (Inventory Management)

You can clear this check box to exclude expired items from the calculation of the available
quantity.

Forms, Reports, and Registers

A new report, Lot Serial Expiration Status Report has been added to the Inventory
Management Reports menu. Use this report to view a list of items' expiration dates. You
can also use the report to view a list of items that are missing an expiration date or a list of
items that are expired as of a specified date.

The expiration date is printed on the reports and registers listed later in this section if the
Track Lot/Serial Expiration Dates check box is selected in Item Maintenance.

If applicable, the expiration date prints on the following registers:
« Bill of Materials registers:

e Production Register

» Disassembly Register

* Inventory Management registers:
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* Transaction Register
* Physical Count Variance Register
e Count Card Variance Register
e Purchase Order registers:
* Receipt of Goods Register
* Return of Goods Register

» Material Requisition Register

If applicable, the expiration date is printed on the following reports:

Bill of Materials reports

* Production History Report

Inventory Management
* Inventory Detail Transaction Report

* Lot/Serial Transaction History Report

Purchase Order

* Receipt History Report (if the Print Lot/Serial Information check box is
selected)

Return Merchandise Authorization reports (if the Print Lot/Serial Information check
box is selected)

e Return Reason Report

* RMA Receipts History Report

Sales Order reports (if the Print Lot/Serial Distributions check box is selected)
* Shipping History Report
e Open Sales Order Report
e Open Sales Order by Item Report

e Open Sales Order by Promise Date Report
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e Open Sales Order by Job Report
* Lot and Serial Number History Report

The expiration date has been added to the worktables for the following forms to make it
easier to add the field to the forms if needed.

* A/Rinvoice (historical)
e B/M production label
* |/M receipts label

* P/O return order

* R/A customer RMA

* R/A RMA receiver

» S/O sales order

* S/O picking sheet

» S/Oinvoice

* S/O packing list

We’'re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the

ideas site to share your ideas and vote for your favorites.

Job Cost

The following changes were made in the Job Cost module.

Option for Expensing Work-In-Process Costs

A new field, Recognize WIP when Billing % Complete Jobs, has been added to the Main
tab in Job Cost Options. This field is available when the (Post to General Ledger) Work in
Process check box is selected.

There are two options available in this field:

» Select Actual Costs to expense WIP costs using actual costs posted to the job that
have not been previously billed as of the job billing date.
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» Select % of Estimate to expense the WIP costs as cost of goods sold by multiplying
the revised estimated cost by the job's completion percentage less the previously
recognized estimated costs.

After converting company data from an earlier version of Sage 100, the default selection
is Actual Costs. For new companies, the default selection is % of Estimate.

If you change the selection in this field, and there are open jobs that have been billed
using the original method, the next time you process an invoice in which WIP is accrued,
that accrual will include a reversal for costs recognized when you were using the
previously selected WIP accrual method. Consider processing a zero-dollar invoice after
making the change to process the reversal.

Actual % Complete Field

A new field, Actual % Complete, has been added to the locations listed below so that you
can enter the job’s completion percentage when processing invoices for the job.

* S/O Invoice Data Entry Header tab

e Shipping Data Entry Shipping tab

This field is available if:

e The Job Cost module is integrated with Sales Order.

* In Job Cost Options, % of Estimate is selected in the Recognize WIP when Billing %
Complete Jobs field.

* In Job Maintenance, for the selected job, Percentage of Completed is selected in the
Acct Method field, and Fixed is selected in the Billing Method field.

A view-only Job No. field has also been added to the Shipping tab in Shipping Data Entry.

elnvoicing for Job Cost Invoices

Through the elnvoicing feature that works with Paya Connect Desktop, you can send
your customers emails that include an invoice summary and a link for online payments.
Customers can use the payment link to make online credit card and ACH payments. If
you’re using Paperless Office for invoicing, the invoice PDF is attached to the email. After
customers make online payments, you can import them into Cash Receipts Entry.

Sage 100 Customer Upgrade Guide 78



Changes in Version 2020

An elnvoice Payments check box has been added to the Header tab in Job Billing Data
Entry. The check box is available and selected by default if the elnvoice Payments check
box in Customer Maintenance is selected, but you can clear it as needed.

If the check box is selected, the invoice information is sent to Paya when the Job Billing
Register is updated, and the invoice is then emailed to the customer. For more
information, see the elnvoicing article in the Sage 100 help.

A merchant account with Paya (formerly Sage Payment Solutions) is required to use
elnvoicing. Paya will provide you with a user ID and API key, which you must enter in
System Configuration. Next, enable the feature in Company Maintenance, and then you
can enable it for customers in Customer Maintenance. For more information, see the
elnvoicing article in the Sage 100 help.

Note: This feature is available if you purchased Sage 100 through a subscription
plan.

Library Master

The following changes were made in the Library Master module.

Conversion Options

Two new options in the Convert Module Data Files window allow you to do more when
converting company data.

Convert SAP Crystal Reports

If you select the Convert SAP Crystal Reports check box, the custom reports and forms
for active modules are converted to the current level when you run conversion.

After the company data conversion is complete, anyone logged into Sage 100 can
continue working while the reports and forms are being converted.

The amount of time needed to convert company data is not affected by the SAP Crystal
Reports conversion.

Update Custom Office Panels to Current Level

If you select the Update Custom Office Panels to Current Level check box, the Custom
Office panel update is run for any customized panels for the companies being converted.
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This update runs without any prompts.

Purchase Order

The following changes were made in the Purchase Order module.

Apply Multiple Purchase Orders to An Invoice or Receipt

In Receipt of Invoice Entry and Receipt of Goods Entry, an Apply Purchase Orders button
has been added next to the Purchase Order Number field on the Header tab. After
selecting the first order for the invoice or receipt, click this button to add additional orders.

I Note: This feature is available if you purchased Sage 100 through a subscription
plan.

The first purchase order applied is considered the primary order. To add additional
orders, the information in the following fields must match:

e Terms code
» Sales tax schedule for purchase order
» Sales tax schedule for purchase address

» Shipping code (entered in Ship Via field)

Reports, Forms, and Registers

The documents listed below have been modified to display "Multiple" in the purchase
order number field if more than one order has been applied to the applicable document.

* Receipt of Goods Register

Receipt of Invoice Register

Daily Purchases Journal

Receipt History Report

A/P Invoice History Report
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Inquiry Windows

In Receipt History Inquiry and A/P Invoice History Inquiry, "Multiple" appears in the
purchase order number field if multiple purchase orders were applied to the receipt or
invoice. You can click the Multiple Purchase Orders zoom button to view a list of orders
applied to the document.

In both inquiry windows, if multiple purchase orders with prepayments were applied to the
receipt or invoice, the total prepayment amount from all orders appears in the prepayment
field. You can click the Prepayments button to view a list of applied purchase orders,
along with the prepayment amount and check number.

Landed Cost Calculation

If entry of landed cost is enabled in Purchase Order Options and Automatic Update is
selected for the FRGHT cost type in Landed Cost Maintenance, the landed cost for all
purchase orders applied to a receipt of goods is totaled and allocated to each line item.

If entry of landed cost is not enabled, the freight amount for all orders applied to the
receipt is totaled and allocated to each line item based on the selection in the Allocate
Freight on a Line ltem Basis field in Purchase Order Options.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the

ideas site to share your ideas and vote for your favorites.

Sales Order

The following changes were made in the Sales Order module.

elnvoicing for Sales Order Invoices

Through the elnvoicing feature that works with Paya Connect Desktop, you can send your customers emails
that include an invoice summary and a Pay Now link. Customers can click the Pay Now link to make online
credit card and ACH payments. If you're using Paperless Office for invoicing, the invoice PDF is attached to
the email. After customers make online payments, you can import them into Cash Receipts Entry.

An elnvoice Payments check box has been added to the Header tab in Invoice Data
Entry. The check box is available and selected by default if the elnvoice Payments check

box in Customer Maintenance is selected, but you can clear it as needed.
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If the check box is selected, the invoice information is sent to Paya when the Sales
Journal is updated, and the invoice is then emailed to the customer. For more
information, see the elnvoicing article in the Sage 100 help.

A merchant account with Paya (formerly Sage Payment Solutions) is required to use
elnvoicing. Paya will provide you with a user ID and API key, which you must enter in
System Configuration.

Next, enable the feature in Company Maintenance, and then you can enable it for
customers in Customer Maintenance or by using the Global Customer Field Change
utility. For more information, see the elnvoicing article in the Sage 100 help.

Note: This feature is available if you purchased Sage 100 through a subscription
plan.

Visual Integrator

The following changes relate to the Visual Integrator module.

Change for Import Jobs that Include Addresses

Any import jobs that include address information must be modified to include the
CountryCode column, and it must be imported before the ZipCode column. This
requirement is related to changes made to support international addresses. For more
information, see "International Address Support" (page 63).

Office 365 Integration

A new screen has been added to the Sage 100 Office Configuration wizard. On the
Microsoft Power Apps and Power Automate screen, if you select the check box, the
information needed to create a custom connector appears on the last page of the wizard.

The same information is automatically copied to the Windows clipboard so that you can
paste it into a document to reference when setting up your custom connector. This is
required if you plan to use Power Automate or Power Apps that work with your Sage 100
data.

Retired Features

The following features are no longer available in version 2020.

Sage 100 Customer Upgrade Guide 82



Changes in Version 2020

Classic Desktop

The classic version of the Sage 100 Desktop is no longer available. To learn more about
the standard version of the Desktop, refer to the following resources:

» To watch a video providing an overview of the standard Desktop, click the Help tab at
the top of the Desktop, and then click Tour the Desktop.

» Toread detailed instructions on using and customizing the Desktop, see the Getting
Started Guide, which is available on the Sage 100 documents page.

If you were using the classic Desktop and had created public or private tasks or
customized the button bar, you can run a utility to add those tasks and/or programs to the
Favorites panel in the standard Desktop. For more information, see "Customization

Import" (page 66).
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Changes in Version 2019

Changes in Version 2019

This chapter describes the changes made in the Sage 100 2019 release and the
subsequent updates for that version. Installation and global changes are listed first
followed by module changes, third-party features, and then retirements.

Global

Global changes are carried throughout multiple modules.

The following changes were made in version 2019.2.

Automatic Update of Daily Transaction Register

A security event has been added to Role Maintenance that allows you to automatically
update the Daily Transaction Register. For any series of journal and register updates that
concludes with the Daily Transaction Register, you will not receive a prompt to print and
update the register if the security event check box is selected for your role. The Daily
Transaction Register will be printed and updated automatically.

The security event has been added for the following modules:
e Accounts Payable

* Accounts Receivable

» Bank Reconciliation

* Bill of Materials

* Inventory Management

» Job Cost

e Purchase Order

» Sales Order

 Work Order
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Warning Message for Document Dates

A Use Document Date Warning check box has been added to the Preferences tab in
Company Maintenance. After selecting this check box, you can enter a value in one or
both of the following fields:

* Document Date - Prior Periods to Allow Outside of Current Period

* Document Date - Future Periods to Allow Outside of Current Period

These values are compared to the current period entered in the module's Options task to
determine when a date falls outside of the valid date range. Alternately, in Bill of
Materials, Inventory Management, Purchase Order, Return Merchandise, and Sales
Order, the values are compared to the current calendar month and year if Calendar
Months is selected in the Base Inventory Periods On field in Inventory Management
Options.

If you start to create a document with a date that falls outside of the valid range, you'll
receive one of two messages:

* If you're using the default date for that session, a warning message appears, and you
can click OK to continue.

 If you manually enter the date, a warning message asks if you want to proceed. If you
click Yes to continue with the date entered, a record is written to the Activity Log.

If you import records with a document date falling outside of the specified range through
Visual Integrator, a warning is written to the Import Log.

Document dates are checked in the following tasks:
» Bank Reconciliation

* Reconcile Bank

e Check Deposit and Adjustment Entry
* Bill of Materials

* Disassembly Entry

* Production Entry
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Accounts Payable
* Invoice Data Entry
* Repetitive Invoice Selection

e Manual Check and Payment Entry

Accounts Receivable
* Invoice Data Entry
* Cash Receipts Deposit

* Repetitive Invoice Selection

Inventory Management

* Transaction Entry

Job Cost

» Job Billing Selection

Purchase Order

* Material Requisition Issue Entry

Purchase Order Entry

Receipt of Goods

Receipt of Invoice Entry

Return of Goods

* Return Merchandise Authorization
* Generate Transactions
« RMA Entry
* Receipts Entry

e Sales Order
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e Sales Order Entry

* Invoice Data Entry

I Note: This feature is available if you purchased Sage 100 through a subscription
plan.

Links to Sage University Training

A Sage University button (with a graduation cap icon) has been added to additional
Purchase Order and Sales Order task windows. Click the button to view a list of training
videos related to the task. Depending on your Business Care plan, there may be no
charge to watch the videos.

The following changes were made in version 2019.1.

View Paperless Documents from Journal Drill Down
Window

A Paperless Viewer button has been added to the Journal Drill Down window. If you've
set up Paperless Office and have the appropriate security setup, you can click the button
to open the Journal and Register Viewer. The button is available when you access the
Journal Drill Down window from the following tasks:

A/P Invoice History Inquiry

A/P Payment History Inquiry

A/R Invoice History Inquiry

G/L Account Maintenance/Inquiry

G/L Source Journal Maintenance

I/M Item Maintenance/Inquiry

P/O Receipt History Inquiry

Links to Sage University Training

A Sage University button (with a graduation cap icon) has been added to additional task
windows. Click the button to view a list of training videos related to the task. Depending
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on your Business Care plan, there may be no charge to watch the videos.

The following changes were made in version 2019.

Auto-Complete for Account Numbers

The auto-complete feature has been added for general ledger account number fields.
You can now search for an account by entering any of the following in an account number
field:

e Account number

* Main account

* Account description
e Account group

As you type, a list of accounts matching your entry appears, and you can select one from
the list.

This feature is automatically enabled for all users. You can disable the feature for
individual users in Library Master > User Maintenance.

To enable this feature, run the Build Search Index utility on the Library Master Utilities
menu to create an index. As you add accounts, you’ll need to run the utility again to index
the new records.

Print Status Updated When Using Keep Open Check
Boxes

In the tasks listed below, when you print a document while the Keep Window Open After
Print or Keep Window Open After Preview check box is selected, the document’s print
status will reflect that the document has been printed. Previously the document’s print
status would have been set to not printed.

* Invoice Printing (Job Cost)
e Purchase Order Printing

e Return Order Printing
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Sales Order Printing

Picking Sheet Printing

Shipping Label Printing

Invoice Printing (Sales Order)

Security Update for E-mail Delivery

Transport Layer Security (TLS) 1.2 is now supported when sending e-mails through
Paperless Office and eBusiness Manager.

Message Enhancements

Some message windows now have a More Info link. When you click this link, you will see
another message with additional information or a related help article.

When you’re opening a task and a message appears indicating that a file is locked, you
can click More Info to see who has the file locked and in which task.

Copy Feature for Custom Lookup Views

A Copy button has been added to the User Lookup Wizard. You can now copy a custom
lookup for other companies and users. Also, selecting companies and users is now
easier—check boxes have been added to the company and user list.

Links to Sage University

A Sage University button (with a graduation cap icon) has been added to additional task
windows.

You can click the button to view a list of training videos related to the task. Depending on
your Business Care plan, there may be no charge to watch the videos.

The Sage University button has been added to the tasks windows listed below.
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e Accounts Payable

ACH Maintenance

Expense Distribution Table Maintenance

Invoice Payment Selection

Repetitive Invoice Selection

Vendor Maintenance
* Accounts Receivable
e Cash Receipts Entry
* Commission Edit Maintenance
* Customer Maintenance
* Invoice Printing
* Repetitive Invoice Entry
* Repetitive Invoice Selection
e Salesperson Maintenance
* Bank Reconciliation
» Auto Check Reconciliation
» Bank Code Maintenance
* Check, Deposit and Adjustment Entry
» Positive Pay Export
* General Ledger
e Transaction Journal Entry
* Job Cost
» Contractor Maintenance
* Job Maintenance

 Library Master
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 Activity Log

Payroll Module Removed from Installation Program

The Payroll module is no longer part of the Sage 100 installation program. To install the
module, use the standalone installation program. For information on installing the Payroll
module, see the Sage 100 Payroll Installation and Upgrade Guide. The guide is available
online at: http://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm

Custom Office

You can now customize the columns and buttons on the following Paperless Office
viewers:

» Journal and Register Viewer
* Period End Report Viewer

* Report Viewer

General Ledger

The following changes were made in the General Ledger module.

Consolidate Journal Entries in General Journal PDF

When printing the General Journal and selecting PDF output, you can now consolidate all
General Journal entries into one PDF. A module option, Print Multiple PDFs for General
Journal, has been added in Role Maintenance. Clear the check box for this option to
consolidate the entries.

Account Appears on All Pages of Detail Reports

The account number and description are now printed on each page of the General Ledger
Detail Report and General Ledger Detail by Source Report.
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Encrypted Bank Information

Bank descriptions and account numbers are now encrypted. Bank descriptions are still
visible in windows and on reports and forms.

A new security event, “Allow Viewing, Printing and Editing of Highly Sensitive Personally
Identifiable Information,” determines whether users will be able to view and print bank
account numbers.

For more information, see Additional Security for Bank Information in the help.

Inventory Management

The following changes were made in the Inventory Management module.

Option to Include Inactive Items in Physical Count

An Include Inactive ltems check box has been added to the Physical Count Worksheet
task window. If you select this check box, inactive items are printed on the worksheet and
included in Physical Count Entry and on the Variance Register. If the check box is
cleared, inactive items are excluded from the physical count process.

Option to Print Variances Only

An Only Print Variances on Register check box has been added to the Physical Count
Variance Register task window. If you select this check box, all items for which there is no
variance are omitted from the register.

Item Quantity Inquiry Button in Physical Count Entry

An ltem Quantity Inquiry button has been added to the Lines tab in Physical Count Entry.
Click this button to view quantity information for the selected item.

You can click the arrow next to this button and select Item Inquiry to open the Item Inquiry
window, or select Iltem Memo to view, create, or maintain memos for the selected item.

Note: To see the Item Memo option, it must be enabled in Memo Manager
Maintenance:
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1. Select Inventory Management > Setup > Memo Manager Maintenance.
In the Memo Type field, select ltem.
Selectarole.

To add Physical Count Entry to the Task list, click the Reset All to Defaults button.

a > e DN

For Physical County Entry, in the Memo option column, select Show or Maintain.

Library Master

The following changes were made in the Library Master module.

Data File Display and Maintenance

Data File Display and Maintenance has been upgraded with several new features.

 If you're using Sage 100 Premium, you can now access files stored in a SQL
database.

» To select afile in the File Name field, you can enter the company code, followed by a
colon, followed by the file name. For example: ABC:AR_Customer

* Forfiles in modules upgraded to Business Framework, the Data File Display and
Maintenance - Edit window now lists all fields and values in a grid.

Encrypted fields are not available to edit, but you can select the Allow Read-Only
Fields to Be Changed check box to edit the read-only fields.

Validation is now performed on date and numeric fields.

* For multi-segment keys, the key scan filter allows you to filter the records using one
or more segments of the key. Enter the selected key column separators as needed to
indicate which segments of the key your search criteria must match.

For example, the key for customer records is ARDivisionNo:CustomerNo. To search
for customer number 02-CAPRI, you can enter the following in the Key field:

:CAPRI
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Alternately, you can select a different character to separate the segments of the key
in the Key Column Separator field. If you select the tilde (T) character, you can then
search by entering the following in the Key field:

“CAPRI

Note that you don’t need to enter the full value contained in the segment. Continuing
with the above example above, you could also enter the following:

~CAP

You can filter by multiple segments. For example, to view records in the GL_
DailyPosting file from 2018 with AP as the source journal, enter the following in the
Key field:

2018:AP

* For modules that have been upgraded to Business Framework, you can click Add to
add a record.

« If you adjust the width of the Data File Display and Maintenance - Key Scan window,
and then close the window to run a second scan, the window reopens at the width
that you used previously. The Key and Data columns are automatically adjusted to fill
the width of the window.

* In the Data File Display and Maintenance - Key Scan window, when entering search
criteria in the Search field, you can use a special character to define the scope of the
search:

» To search for text in any location within the current key, add an asterisk (*)
at the beginning of your search text. For example: *14072

» To search for text within the current key and the data record, add a percent
symbol (%) at the beginning of your search text. For example: %14072

¢ The Print button has been removed.

When starting Data File Display and Maintenance using the Run Program window
accessed on the File menu, you can now enter SY_FileDisplay_Ul.

Activity Log

The following changes have been made to the Activity Log:

Sage 100 Customer Upgrade Guide 94



Library Master

» Changes made in Role Maintenance and User Maintenance are now tracked. A new
activity type, Security, has been added and is used to categorize these changes.

» You now have the option to track changes in Company Maintenance and System
Configuration. For more information, see "Activity Log Configuration Window" (page

95).

» To improve performance, there is now a configurable limit on the number of records

that display when you open the Activity Log window. If the number of records in the

log file exceeds this threshold, the Activity Log / window automatically opens before
any records are loaded. Use the Activity Log - Filter window to filter the records and
then view them in the Activity Log window.

To change the auto-load threshold, click the Configure button on the Activity Log
window.

» A Cancel button is now available while the progress bar indicates that records are
loading so that you can cancel the process if needed.

» A Refresh button has been added to the window. Click this button to reload the
records, including any new ones created after you started the session.

» The newly added first column in the grid contains an asterisk (*) if a log file is
available for the record.

» The Purge button now appears below the list of records. Also, a purge utility has been
added to the Utilities menu. For more information, see "Activity Log Purge Utility"

(page 96).

» When purged, records are either deleted or added to an archive file based on settings
in the Activity Log Purge Configuration window.

» You can view purged records stored in an archive file by clicking the History button
and, in the Select Archive Year window, selecting a year. Archived records from that
year are then displayed in the Activity Log window.

Activity Log Configuration Window

The Activity Log Configuration Window, accessed by clicking the Configure button in the
Activity Log window, allows you to set various options. You can use this window to:

» Control how many records are loaded by default, either by entering a value or setting
a date range.
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» Specify whether to track changes made in Company Maintenance and System
Configuration.

» Specify how data is purged.
» Specify what information is recorded when errors occur in Sage 100.

For more information, refer to the on-screen help that appears at the bottom of the
configuration window when you click one of the rows.

Activity Log Purge Utility

You can use the Activity Log Purge utility to purge records from the Activity Log file. To
access the utility:

 Click the Purge button on the Activity Log window.

» Select the task on the Library Master Utilities menu.

When purged, records are either deleted or added to an archive file based on settings in
the Activity Log Purge Configuration window, which is described in more detail in the next

section. You can schedule automatic purges using Task Scheduler. Archive files are
stored here: .\MAS90\MAS_System\Archive

Activity Log Purge Configuration Window

Click the Activity Log Purge Configuration button to open the configuration window. Use
this window to control how many records are loaded by default and specify how data is
purged.

Note that the default setting for the Minimum Days to Keep field is 365; therefore, the
Records to Purge list may be empty when you initially start the utility.

Activity Log Filter Window

The Activity Log Search window has been renamed Activity Log Filter. In addition, the
following changes have been made:

* You can filter records by company code and module code.

* You can enter search text to filter records by the text in the Description column.

» File Display/Maintenance and Visual Integrator have been added as options to filter
records.
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Activity Log Report
The following changes were made to the Activity Log Report task window:

» An Archive Year field has been added to the Activity Log Report. If you have archived
records, you can select a year in this field, and only the archived records from that
year are included in the report.

» Toinclude unarchived records on the report, select Current Activity in the Archive
Year field.

» You can filter the report by module using the Module Code fields in the Selections
grid.

User ID Field Expanded

The User ID field on the E-mail tab in Company Maintenance has been expanded to hold
254 characters.

Keep Window Open Check Box in Rebuild Key Files

A Keep Window Open check box has been added to the Rebuild Key Files window. If you
select this check box, the window remains open after you rebuild files, but the company,
module, and file selections are cleared.

Paperless Office

The following changes were made in the Paperless Office module.

Text Formatting Options for Messages

A new message editor has been added to Electronic Delivery Message Maintenance and
to the Edit Message window accessed through the Customer, Employee, and Vendor
Viewer windows. The editor features a tool bar with text formatting options, including the
ability to:

Change the text color, font, and size

Use bold or italic text

Create bulleted and numbered lists

Insert links and images
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Square Brackets Replace Angled Brackets for Merge Fields

Previously the merge fields were enclosed in angled brackets (< >). However, the new
message editor is HTML based, and angled brackets are reserved for a specific purpose
in HTML. Therefore, square brackets ([] ) are now used to enclose the merge fields.

If you have existing messages that contain merge fields in your earlier version of Sage
100, the angled brackets will be replaced with square brackets when you convert your
data. For example, <DocumentNo> will be converted to [DocumentNo].

If you have message fields that contain an angled bracket that is not being used to
enclose a merged field, the bracket is not converted, and an entry is written to the
Conversion Log.

Angled brackets used for merge fields in the Subject field are also converted, but the
Subiject field does not support formatted text; only plain text is allowed.

Be sure to test any messages that were saved in your prior version of Sage 100 after
converting your data.

Size of Message Field Increased

The message field holds 7168 characters, increased from 4096. However, the special
characters used in the HTML code count toward this limit.

New Merge Fields

Three new merge fields have been added in Electronic Delivery Message Maintenance:
» [CustomerPoNo] for sales orders and Accounts Receivable and Sales Order invoices
 [InvoiceDueDate] for invoices

» [ShipDate] for sales orders and Sales Order invoices

The merge fields are available depending on which module and document is selected.

Also a Copy Merge Field to Clipboard button has been added to the window. Click this
button to copy the selected merge field to the Windows clipboard and then paste it in
multiple locations.
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Cc and Bcc Options for E-mail Address

You can now specify whether the e-mail addresses used when e-mailing documents are
added to the To, Cc, or Bcc field when e-mails are sent.

In the locations listed below, a Recipient field has been added; use this field to select To,
Cc, or Bcc.

» Paperless Office Delivery Options (accessed from Customer Maintenance and
Vendor Maintenance)

» Electronic Delivery (accessed from the customer, employee, and vendor viewers)

» Paperless Office Selection (accessed from all reports supported by Paperless Office)

When converting data, To is automatically selected in the Recipient field for the existing
e-mail addresses.

In the Paperless Office Delivery Options window accessed through Employee
Maintenance, the E-Mail Address field has been relabeled as the To field, and Cc and
Bcc fields have been added. When converting data, existing e-mail addresses are added
to the To field.

E-mail addresses entered in the Cc and Bcc fields are included in the customer,
employee, and vendor listings if the option to print Paperless Office delivery options is
selected.

Additional Attachments When Emailing Forms

In the Electronic Delivery for Forms window, you can now select additional attachments to
include when emailing forms. You can select multiple attachments, and there is no
restriction on the file type.

PDF File Name Options

A PDF File Name field has been added in Form Maintenance. In this field, if you select
Document No., the document number is used as the file name for the PDF that is
attached to the email. The full description is still used for the PDF file that is stored in the
PDF directory.
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If you select Full Description, the file name will vary depending on the document type.
The file naming convention for this option is the same that was used in earlier versions of
Sage 100.

Option to Copy Salespeople When E-mailing Forms

A Paperless button has been added in Salesperson Maintenance. Click this button to
open the Electronic Delivery Options window and specify whether the salesperson will
receive a copy of orders, invoices, and statements when they are e-mailed to customers
from data entry, inquiry, and history tasks.

Search by Posting Date in Journal and Register Viewer

A Posting Date column has been added to the list box in the Journal and Register Viewer.
When you click the Search button, you can include a posting date or range of posting
dates in the search criteria.

Updated Printer Driver

The Amyuni PDF Converter, the virtual printer driver used to create PDF documents, has
been updated to version 6.0.1.1.

Purchase Order

The following changes were made in the Purchase Order module.

Change for Drop-Ship Purchase Orders

In Purchase Order Entry and Receipt of Invoice Entry, if Drop Ship is selected in the
Order Type field, the Work Order field on the Lines tab is not available.

When copying from a purchase order in Purchase Order Entry, if Drop Ship is selected in
the Order Type field for the new purchase order, no history or work order information is
copied from the source document.
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Data Conversion

When converting your data after upgrading to version 2019, work order fields for drop-
ship inventory lines and the corresponding history detail lines are cleared in purchase
order and receipt of invoice records. History detail records that do not have corresponding
data entry records are not affected.

Sales Order

The following changes were made in the Sales Order module in version 2019.1.

Add Tracking Number to Email Messages

In Electronic Delivery Message Maintenance, when you're creating a message for a
Sales Order invoice, you can add the tracking number to the subject or the body of the
message. To add the tracking number, insert the new TrackingNo merge field.

If you add the tracking number to the subject, they are displayed in plain text and multiple
tracking numbers are separated by commas. In the body of the message, the tracking
numbers are links that the recipient can click to track the shipment.

Sage 100 Customer Upgrade Guide 101



Changes in Version 2018

Changes in Version 2018

This chapter describes the changes made in the Sage 100 2018 release and the

subsequent updates for that version. Installation and global changes are listed first

followed by module changes, third-party features, and then retirements.

Global Changes in 2018.4

The following changes were made throughout Sage 100 in version 2018 4.

Links to Sage University

A Sage University button (with a graduation cap icon) has been added to several task

windows.

You can click the button to view a list of training videos related to the task. Depending on

your Business Care plan, there may be no charge to watch the videos.

The Sage University button has been added to the tasks windows listed below.

Accounts Payable:

Invoice Data Entry

Manual Check and Payment Entry
Check Printing and Electronic Payment
Period End Processing

Accounts Receivable Invoice Data Entry
Bank Reconciliation Reconcile Bank
General Ledger General Journal Entry
Payroll:

Check Printing

Deduction Code Maintenance
Employee Maintenance

Payroll Data Entry

Punch In/Out
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Tax Profile Maintenance

Time Off Maintenance

Time Track Entry

Purchase Order Return of Goods

Sales Order Invoice Data Entry

Global Changes in 2018.3

The following changes are carried throughout multiple modules in version 2018.3.

Reset Button for Period End Report Selection

A Reset Default Reports button has been added to the Period End Report Selection
window in all modules in which this window is present. Click the button to reset the report
list to its original settings.

Improved Navigation in Calendar Window

The following changes have been made to the Calendar window:

» The last day(s) of the prior month are displayed when the first week of the month
doesn’t begin on a Sunday. Also the first day(s) of the next month display when the
last week of the month doesn’t end on a Saturday.

» Pressing the up arrow key moves focus to the same day of the previous week.
Pressing the down arrow key moves focus to the same day of the next week.

» When focus is on the first day of the month, pressing the left arrow key displays the
prior month. Pressing the Page Up key does the same. When focus is on the last day
of the month, pressing the right arrow key displays the next month. Pressing the
Page Down key does the same.

Global Changes in 2018

The following changes are carried throughout multiple modules in version 2018.
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Spell Checking
An in-line spell checker has been added. Misspelled words are underlined, and you can
right-click them to open a menu with the following options:

» Select a replacement for the misspelled word

» Add the word to your personal dictionary so that it will no longer be shown as
misspelled. This does not affect other users.

« Ignore all instances of the misspelled word. The word will not be shown as
misspelled as long as the current session of the task remains open.

The spell check feature has been added in the following locations:

 Memos

» Messages that print on forms, such as invoices, statements, and checks

» Paperless Office Electronic Delivery windows

» Comments

» Notes in Customer Contact Maintenance and Vendor Contact Maintenance

» E-mail Notification Maintenance (accessed from eBusiness Manager)

o Test E-Mail and Test Fax subject fields (accessed from Company Maintenance)
» Broadcast Message (accessed from Master Console)

When adding a multi-line user-defined field (UDF) to a screen, you can select whether to
enable spell check.

Updated Desktop

The following changes have been made to the Sage 100 Desktop.

Option to Minimize the Desktop

A Toolbar Mode button has been added to the top-right corner of the Desktop. Click this
button to minimize the Desktop. You will then see only the tab labels for the ribbon and
the status bar. When you click a tab label, the full ribbon is displayed until you make a
selection.

When the Desktop is minimized, you can click the Expand the Ribbon button next to the
Toolbar Mode button to keep the full ribbon in view even after making a selection.
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If you start an application, such as Paya Exchange, that runs in the embedded browser,
the Desktop will be automatically expanded.

Web Content
« A Web Content tab has been added to the ribbon.

* An Open in New Window check box has been added to the Link window that appears
when you add a new link or edit an existing one. If you select this check box, the web
page will open in your default browser instead of the browser embedded in the
Desktop.

Navigation Buttons for Embedded Browser

Forward and Back navigation buttons have been added for the embedded browser.

SAP Crystal Reports 2016

SAP Crystal Reports 2016 for Sage (version 2016SP04) now ships with Sage 100. The
following new features are included in this version:

» Conditional formatting of boxes and lines, including the ability to conditionally
suppress

» Vertical text alignment at Top, Middle, or Bottom

» A GetValueDescriptions function to display parameter value descriptions in your
report layout

¢ Direct data access for SQL Server 2014

Important! You must uninstall earlier versions of SAP Crystal Reports before
installing SAP Crystal Reports 2016 for Sage.

For Sage Fixed Assets Customers

If you have Sage Fixed Assets installed on the same computer as Sage 100 2018, you
may receive an error when trying to preview reports in Sage Fixed Assets. The error
occurs because the two programs use a different version of the SAP Crystal Reports
runtime engine.

An upcoming release of Sage Fixed Assets will resolve this issue. For information on how
to resolve the issue in your current version of Sage Fixed Assets, see article ID 86606 in
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the Sage Knowledgebase:
https://support.na.sage.com/selfservice/viewdocument.do?externalID=86606

Service Notification Maintenance

A new task, Service Notification Maintenance, has been added to the following locations:

 Library Master Main menu.

e Payroll Setup menu

Use this task to manage who will receive e-mails related to Sage services. E-mails are
sent to let you know about scheduled maintenance, unplanned outages, or other events
that affect your ability to use the service.

Currently the only service available is the Payroll Tax Calculation Engine, but additional
services may be added in the future. Until you designate at least one person to receive
service notifications, a message appears each time anyone accesses the Payroll module
alerting them that a user must be set up in Service Notification Maintenance.

Installation Changes in 2018.1

The following change was made in version 2018.1.

Workstation Synchronization Update for Sage 100
Standard

The Workstation Synchronization program has been enhanced to update Sage 100
Standard workstations when you install a product update.

Accounts Payable Changes in 2018.2

The following changes were made in the Accounts Payable module in version 2018.2.

Search Invoice History from Vendor Maintenance

In Vendor Maintenance, you can open the new Invoice History Inquiry window by clicking
the arrow button in the top-right corner of the screen and then clicking Invoices Inquiry.
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The window lists invoices and shows the invoice number, date, amount, purchase order
number, order date, and ship-to location code.

From the Invoice History Inquiry window, you can:

¢ Select an invoice and then click the Zoom button to view invoice details in the Invoice
History Inquiry window.

» Click the Search button to search for invoices by the invoice number, date, purchase
order number, and ship-to location code.

Accounts Payable Changes in 2018

The following changes were made in the Accounts Payable module in version 2018.

Form 1099 Tax Reporting

The 1099 eFiling and Reporting task has been renamed Form 1099 Tax Reporting. Also,
the Minimum YTD Payment field has been replaced with a Minimum YTD button. Click
this button to open the Minimum YTD Payment window and enter the minimum payments
for the corresponding Form 1099 boxes.

Accounts Receivable Changes in 2018

The following changes were made in the Accounts Receivable module in version 2018.

Fields Added to Pay Cycle Window

As part of the enhancements to the Payroll module, the following fields have been added
to the Pay Cycle window that appears when updating the Commission Edit Register:

e Period Starting Date
e Check Date

Bank Reconciliation Changes in 2018.5

The following changes were made in the Bank Reconciliation module in version 2018.5.
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Sage Bank Feeds

Sage Bank Feeds simplifies the process of reconciling your bank statements by importing
bank transactions into Check, Deposit, and Adjustment Entry and matching them against
Sage 100 transactions.

You can connect your banks to Sage Bank Feeds in Bank Maintenance when you access
the task through the Bank Reconciliation menu. A wizard walks you through the process.
Note that the wizard will need your ZIP Code; therefore, you must enter one on the
Registration tab in System Configuration before connecting a bank.

To learn how to connect a bank, see Connect a Bank to Sage Bank Feeds in the help.

For information on how transactions are matched, see the help for Check, Deposit, and
Adjustment Entry.

Bill of Materials Changes in 2018.3

The following changes were made in the Bill of Materials module in version 2018.3

Update Changes to Miscellaneous Charge ltems

A new field, Sync Misc Charge Changes with Bill Tables, has been added to Bill of
Materials Options. There are three options for updating bills with changes made for
miscellaneous change items in Miscellaneous ltem Maintenance:

» Select Yes to update bills with the changes made in Miscellaneous Item
Maintenance.

» Select No if you do not want to update the bills.

» Select Prompt to receive a message when you update a field for a charge item in
Miscellaneous Item Maintenance asking if you want to update the field in Bill of
Materials.

Changes are updated only if the content in Bill of Materials matches the content that was
in Miscellaneous Iltem Maintenance before the change was made. If you're using
revisions, all revisions are updated with the change.
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Business Insights Dashboard Changes in 2018

To protect sensitive employee information, the Workforce Statistics option has been
removed from Business insights Dashboard in version 2018.

Credit Card Processing Changes in 2018.4
Processing payment cards with EMV chips through Paya (formerly Sage Payment
Solutions) is supported when using the following card readers:

 Ingenico ipp320

e Equinox L5300

The supported device list is subject to change. Please see the Integrated Solutions
Compatibility Matrix for the latest information. You can find the matrix in the Sage
Knowledgebase. See article ID 48274.

Before processing payments with chip cards, you must update your settings in Sage
Exchange Desktop:

1. In the Windows system tray, right click the Sage Exchange 2.0 icon and then click
Settings.

2. Inthe Sage Exchange - Settings window, under Hardware, select EMV Devices.
3. Select your card reader device.

4. Select the Generate EMV receipts check box.

A PDF receipt will be generated after processing a payment in the Sage Exchange -
Authorization window.

Custom Office Changes in 2018.3

The following changes were made in the Custom Office module in version 2018.3.

Calculator Option for Numeric Fields

A Calculator check box has been added to the Multi-Line Definition window. Select this
check box to include the Calculator button next to the field. The check box is available for
numeric fields only.
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Inventory Management changes in 2018.3

Buttons Appear in Screen Editor

In the Customizer screen editor, Calendar, Calculator, and Lookup buttons now appear
as they do when using the screen in Sage 100.

Ability to Exclude UDFs from Selection Grids

An Exclude from Report Selection check box has been added to the Add Field and Edit
Field windows. Use this check box when adding a user-defined field (UDF) to a table for a
main entity, such as AR_Customer, to exclude the UDF from selection grids for reports
that use the table.

Inventory Management changes in 2018.3

The following changes were made in the Inventory Management module in version
2018.3.

Item Images Open in Windows Photo Viewer

In Item Maintenance and Item Inquiry, when you click the Show Image button, the image
now opens in Windows Photo Viewer. You can then email the image, copy it to the
Windows clipboard, and adjust the zoom level.

Inventory Management Changes in 2018

The following changes were made in the Inventory Management module in version 2018.

Warehouse Status Field in Warehouse Code
Maintenance

A Status field has been added to Warehouse Code Maintenance. The three status
options are Active, Inactive, and Restricted.

Inactive Warehouse Status

The Inactive status is intended for warehouses that are no longer in use. If a warehouse
status is Inactive, you cannot select the warehouse in any data entry tasks.

Sage 100 Customer Upgrade Guide 110



Job Cost Changes in 2018.5

A warehouse cannot be set to inactive if there is a record of inventory in the warehouse or
if the warehouse is used in data entry or maintenance records, such as an open sales
order or a ship-to address. If you try to change a warehouse status to inactive while the
warehouse is in use, a message appears letting you know that the warehouse cannot be
set to inactive. You can click the Details button in the message windows to see a list of
records in which the warehouse is used.

Display Inactive Warehouse in Lookup Views

A new check box, Display Inactive Warehouses in ALE Lookups, has been added to the
Preferences tab in Company Maintenance. The check box is selected by default. Clear
the check box if you don’t want to display inactive warehouses in lookup views.

Restricted Warehouse Status

The Restricted status is intended for a warehouse that is still in use but activity needs to
be temporarily suspended, for example, to take inventory. If a warehouse status is
Restricted, it cannot be selected in data entry tasks unless an exception is created in the
new Allow Entry of Restricted Warehouse window.

To create exceptions, click the Allow Inactive Warehouse button, which is next to the
Warehouse Status field and available when Restricted is the selected status. You can
then select data entry tasks, and the restricted warehouse can be used in those tasks.

You can enter dates in the Restricted Start Date and End Date fields to automatically start
and end a period in which the warehouse is restricted.

A permanent code, RESWH (Restricted Warehouse), has been added to S/O Cancel and
Reason Code Maintenance.

Job Cost Changes in 2018.5

The following changes were made in the Job Cost Module in version 2018.5.

Certified Payroll Reporting

Certified Payroll Reporting has been added to the Reports menu in Sage 100 Payroll
2.18.5. This section describes changes made to the Job Cost module to collect
information for the reports.
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To learn more about Certified Payroll Reporting, see the Sage 100 Payroll Installation
and Upgrade Guide, available here:
https://cdn.na.sage.com/docs/en/customer/100erp/2_18/open/Payroll_Upgrade.pdf

Certified Payroll Reporting Window

In Job Cost Maintenance, a More button has been added in the top-right corner of the
window. Click this button or the arrow next to it and select Certified Payroll to open the
Certified Payroll Reporting window. Use this window to enter information for the current
job that will be used in the Certified Payroll Report.

This window is also available from Job Inquiry, but it's view-only. You can access the
window from Job History Inquiry by clicking the Certified Payroll button that has been
added to the window.

Job Contractor Maintenance

Job Contractor Maintenance has been added to the Job Cost Setup menu. Use this task
to create and maintain records for each of the contractors with whom you do business.
The records are available to select as the prime contractor and awarding contractor in the
Certified Payroll Reporting window accessed through Job Maintenance.

Job Listings

A Certified Payroll check box has been added to the Job Listing and Job History Listing
task windows. Select this check box to include the certified payroll information for each
job in the listing.

Cost Code Detail Window

The Cost Code Detail window accessed in Job Maintenance has been added to the menu
for the More button. The Cost Code button has been removed.

Job Cost Changes in 2018.2

The following changes were made in the Job Cost module in version 2018.2.
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Time Track

Time Track is the new time entry feature that comes with the TimeCard module. Time
Track replaces the features previously available in TimeCard, most of which have been
kept and redesigned for better usability. Job numbers and cost codes can be associated
with time entries created in the Payroll module so that you can update the labor costs to
Job Cost.

For a list of TimeCard Tasks and their Time Track replacements, see "Time Track Task

Locations " (page 211).

For information on the Time Track features in the Payroll module, see the Sage 100
Payroll 2.18 Installation and Upgrade Guide.

For setup instructions, see Set Up Time Track for Job Costin the Sage 100 help.

Job Cost Options

The Enable Time Track for TimeCard check box has been added in Job Cost Options.

Time Track Menu

A Time Track menu has been added in the Job Cost module. This menu contains the
following tasks:

» Time Track Selection: Use this task to select time entry records so that the
associated labor costs can be updated to Job Cost.

For more information, see Post Time Track Entry Costs for Jobs in the help.

« Time Track Register / Update: Use this register to view information for the jobs
included when running Time Track Selection. The register lists the employees who
entered time for each job, the earnings code used, the hours worked, the cost code,
and the cost amount per cost code.

Note: Select Employee in the Sort By field when printing this register to use itas a
replacement for the J/C Selection Audit Report that was previously available in the
TimeCard module.
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Job Cost Changes in 2018

 Job Daily Production Report: This report provides a summary, by job, of the number
of hours worked for each day of the week, and lists the week-to-date total, job-to-date
hours, job-to-date estimate, and variance.

Job Cost Maintenance

The Exclude from Certified Payroll Report check box has been added in Job Cost
Maintenance. This field is available if the Payroll module is integrated with Job Cost.

Select the check box to exclude the job from the Certified Payroll Worksheet, which has
been added to the Payroll Main menu.

Cost Code Maintenance

An Earnings button is available in Cost Code Maintenance when Time Track is enabled
for Job Cost and the option to validate cost code/earnings code combinations is enabled
in Time Track Options (on the Payroll Setup menu).

Click Earnings to open the Valid Earnings Codes window and select earnings codes that
are valid for the selected cost code. Combinations of cost codes and earnings codes are
validated in Time Track Entry and Punch In/Out.

Job Transaction Detail Report & Job Transaction Detail History
Report

The Source Journals to Print field was renamed Source Modules to print. If you converted
data that included TimeCard entries, they are still reflected in the TC module information.
New Time Track entries are included when you select the JC source module.

Time Track Task Locations

To view a list of TimeCard tasks and the name and location of the Time Track tasks that
have replaced them, see "Time Track Task Locations " (page 211).

Job Cost Changes in 2018

In version 2018, the Job Cost module has been rearchitected to improve performance
and usability.
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User Interface Enhancements

These changes have been incorporated to make it easier to access data and complete
tasks.

» Data entry grids are used to improve efficiency.

Selection grids are available on most report task windows and elsewhere.

Calculator buttons have been added to dollar amount fields.

Calendar buttons have been added to date fields.

Hyperlinks to related tasks have been added where applicable.

Batch Entry

Batch entry can be used in the following tasks:

e Job Posting Entry
» Job Billing Entry
» Field Report Entry

» You can enable batch entry for each of these tasks and set the next batch number on
the Entry tab in Job Cost Options.

History

On the History tab in Job Cost Options, you can select whether to retain history and set
the number of years to retain history. The minimum is two years.

Utilities Menu

The utilities used to control the archiving, restoring and purging of Job Cost history have
been updated for the new number of years option, and are now available on the Utilities
menu.

The Summarize Cost Detail utility has been moved to the Utilities menu.

Forms and Reports

» Report setting options nhow appear on the header area of the applicable report
window. You can avoid reentering selections each time you print a report by creating
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a new report setting. For more information, see Create a Report Setting in the help.

» SAP Crystal Reports is now used for all reports and forms. Non-graphical forms are
no longer available.

» Selection grids have been added so that it's easier to filter report data.

» The option to keep the task window open after printing or previewing a report has
been added to report task windows.

« If you use Job Cost for billing, the invoice form will need to be reformatted.

Period, Year, and Job-to-Date Totals

The Job and Job Cost Code Detail tables no longer contain period-to-date, year-to-date,
and job-to-date totals. If you have custom reports that contain this information, you must
create a sub-report to summarize the data from the Job Cost Code History table to
calculate the totals.

Period End Processing Reports

A Print Period End Reports check box has been added to the J/C Period End Processing
window. If you select this check box, the J/C Period End Reports window opens when you
click Proceed. The reports selected in Period End Report Selection are listed, and you
can select which ones that you want to print. If no reports are selected in Period End
Report Selection, the check box is not available.

Mobility for Bar Code Changes in 2018

The Bar Code module has been renamed in version 2018; it is now the Mobility for Bar
Code module. This section provides an overview of the changes. For more details on how
the new features work, see the help.

Mobility Remote Setup for Scanco Mobile App

The Mobility Module Setup task has been added as part of the setup process for
Scanco’s mobile app for Apple iOS and Android devices.
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Mobility for Bar Code Options (formerly Bar Code
Options)
The Bar Code Options task has been renamed Mobility Options and offers a simple

configuration for number of days to retain import history. Also the File tab has been
removed.

EZ Import Tasks

The following four tasks have been added to import data collected on mobile devices.

 Inventory EZ Import for Physical Count Entry, Count Card Entry, receipts, issues,
adjustments, alias entry, and job issues. This task replaces Import Inventory
Transactions.

» Sales Order EZ Import for Invoice Data Entry and Shipping Data Entry. This task
replaces Import Sales Order Transactions.

e Purchase Order EZ Import for Receipt of Goods. This task replaces Import Purchase
Order Transactions.

« Bill of Materials EZ Import for Production Entry. This task replaces Import Bill of
Materials Transactions.

» EZ Import can be used to import any transaction type.

You can use EZ Import exclusively; or you can use the module-specific import tasks listed
above, in conjunction with Role Maintenance, to manage which types of transactions that
users are able to import.

The new tasks show all data imported by type. For example, data for Physical Count and
Issues is shown separately.

EZ Import Inquiry

Use the new EZ Import Inquiry task to view and print all imported data within a specified
date range.

EZ Import Reject Maintenance

The new EZ Import Reject Maintenance task displays detailed information in a grid view
which you can use to make corrections as needed. This task replaces Rejected Import
Maintenance.
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EZ Import Reporting

The following reports show all data collected on mobile devices:

o EZ Import Report for all records currently in process.
o EZ Import History Report for all records that have been processed.

» EZ Import Rejection Report for all records that have been rejected due to
discrepancies

Other Renamed or Removed Tasks

The following tasks have been renamed or replaced.

» Purge Bar Code History has been renamed Purge EZ Import History.

» The Unattended Bar Code Transaction Import task has been removed from the Main
menu. Use the EZ Import tasks instead.

Paperless Office Changes in 2018

The following changes were made in version 2018 as part of the redesign of the Payroll
module.
* You can now create and email employee payroll checks in PDF format. In Forms

Maintenance, a check option has been added to the Documents list for the Payroll
module.

» The Employee Viewer task has been added to the Main menu. The Form Type field
has Check and Direct Deposit Stub options.

» In Employee Self Service, the View Documents button has replaced the View Stubs
button. The button opens the Employee Viewer window in which you can view both
checks and direct deposit stubs.

Payroll Changes in 2018

The Payroll module has been redesigned to improve performance and usability. For
details, see the Payroll What’s New guide available here:
https://cdn.na.sage.com/docs/en/customer/100erp/2018n/open/payroll_upgrade.pdf
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Purchase Order Changes in 2018.3

The following changes were made in the Purchase Order module in version 2018.3.

Auto Generate from Sales Orders

When creating purchase orders using Auto Generate from Sales Orders, any drop-ship

items that are used in multiple lines in a sales order can now remain on separate lines in
the purchase order. Previously the duplicate lines were consolidated into one line in the
purchase order.

The Summarize Multiple Items by Line check box is now available for both drop-ship and
non-drop-ship lines. Also the check box is available when Sales Order Line No. is
selected in the Sort Purchase Order Lines By field in Purchase Order Options.

If you don’t want to consolidate duplicate sales order drop-ship lines into one line on the
purchase order, select the Summarize Drop Lines By Vendor check box, and clear the
Summarize Multiple Items by Line check box.

To consolidate the duplicate drop-ship lines on the purchase order, select both the
Summarize Drop Ship Lines by Vendor check box and the Summarize Multiple Items by
Line check box.

Sales Order Changes in 2018.4

The following changes were made in the Sales Order module in version 2018.4.

Consolidate Multiple Orders in Shipping Data Entry

You can now consolidate multiple sales orders into one shipment in Shipping Data Entry.

Shipping Setup Options
Two new fields have been added on the Entry tab in Shipping Setup Options.

e Consolidate Orders on One Invoice

» Select Yes to automatically consolidate sales orders for one invoice as the
orders are processed in Shipping Data Entry.
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» Select Prompt to display a message when you click Accept asking if you
want to add another order.

» Consolidate by Customer PO No. (Available if you select Yes or Prompt in the
Consolidate Orders on One Invoice field)

» Select Yes to consolidate orders into one invoice only if the purchase order
number is the same.

» Select No to consolidate orders with different purchase order numbers into
one invoice.

» Select Prompt to display a message asking if an order should be added to
an existing shipment when the purchase order numbers are different.

Shipping Data Entry

In Shipping Data Entry, when multiple orders have been added to the current shipment,
you can select the Show Detail for All Orders check box to view the lines for all of the
orders. If the check box is cleared, the grid displays lines only for the order entered in the
Order No. field.

Shipping History Inquiry

If you’re viewing a shipment that includes multiple sales orders, the word Multiple
appears in the Order No. field. If more than one customer purchase order number is
associated with the orders, Multiple appears in the Cust PO field. Click the Zoom button
next to either field to view details in the Sales Orders Applied on Invoice field.

Forms and Reports

On packing lists and the Shipping History Report, if a shipment includes more than one
order, “Multiple” prints in the Order Number field in the heading area, and the individual
order numbers print in the area with the line details.

View Multiple Sales Order and Purchase Order Numbers

When you’re viewing an invoice to which multiple sales orders are applied, you can click
the Zoom button next to the Order No. field to view a list of the orders. If there are multiple
customer purchase order numbers associated with the orders, a Zoom button also
appears next to the Customer PO field.

The Zoom buttons have been added to the following tasks:
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S/O Invoice Data Entry (for customer purchase order numbers)

A/R Invoice History Inquiry (accessed from both the Sales Order and Accounts
Receivable modules)

Shipping History Inquiry

Shipping List lookup window (accessed from Shipping History Inquiry)

View Multiple Deposits

If you’re viewing an invoice to which multiple sales orders are applied and one or more
orders includes a deposit, "Deposits from Applied Sales Orders" appears in place of the
Deposit Payment Type field, and the Deposits on Applied Sales Orders Zoom button
appears. Click the button to view the deposit details in the Deposits on Sales Orders
window.

Sales Order Changes in 2018.3

The following changes were made in the Sales Order module in version 2018.3.

Apply Multiple Sales Orders to an Invoice

In Invoice Data Entry, an Apply Sales Orders button has been added next to the Sales
Order Number field on the Header tab. After selecting the first order for the invoice, click
this button to select additional orders.

You can apply multiple sales orders to invoices if the invoice type is either Standard or
Cash Sale, and only if there has been no credit card deposit or credit card payment
applied to the invoice before you apply the sales orders.

Sales orders can be applied to an invoice if they have not been used for any other invoice,
and if there has been no credit card deposit or credit card payment applied to the order.
You can add a credit card payment or deposit to the invoice after applying all of the sales
orders.

For each order added to an invoice, the fields listed below must all contain the same
value. The first order selected in Invoice Data Entry is used to determine whether
additional orders are valid. Some fields may not be available depending on your settings.
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e Terms code

e Ship-to code

» Discountrate

» Sales tax schedule

» Salesperson (or salespersons) and commission rate(s)
e Job number

» Ship-via shipping code and shipping zone

« Bill-to customer

e ACH Payment ID (The payment IDs must match or you can combine with an order
that has no payment ID.)

e CRM person ID, CRM company ID, and CRM opportunity ID

Reports, Forms, and Registers

In the header section of the documents listed below, “Multiple” is printed in sales order
number and customer purchase order number fields when applicable. The sales order
number and customer purchase order number are printed in the line detail section.

e Sales Order invoice

Sales Journal

Gross Profit Journal

Daily Deposit Recap Report

Accounts Receivable Invoice History Report

When printing an invoice that includes multiple sales orders, the order date for the first
order selected prints on the invoice.

Accounts Receivable Invoice History Inquiry

In Invoice History Inquiry, “Multiple” appears in the Order No. field and, on the Main tab, in
the Customer PO field when applicable. To view a sales order number or customer
purchase order number, select a line on the Lines tab, and click the Additional

Information button. The order number and customer purchase order number are shown in
the Additional Fields window.
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If a deposit was entered for multiple orders, the total deposit amount appears on the Main
tab in the Deposit field, and a Deposit Information button appears next to the field. Click
the button to open the Deposit Inquiry window, which lists the individual deposits.

Sales Order Changes in 2018.2

The following changes were made in the Sales Order module in version 2018.2.

Reprint Sales Orders and Quotes from History

A Print button has been added to the Sales Order and Quote History Inquiry window. You
can click the button to print the selected order or quote.

If you need to reprint a range of orders or quotes, you can use the new Sales Order and
Quote History Printing task, which has been added to the Sales Order Reports menu. You
can select whether to include active, complete, and deleted orders as well as active and
deleted quotes.

Exclude Orders Being Invoiced from Reports

You now have the option to exclude sales orders that are in the process of being invoiced
when printing the following reports:

e Open Sales Order Report

» Open Orders by Iltem Report

» Open Orders by Promise Date Report

e Open Orders by Job Report

TimeCard Changes

As a result of the extensive improvements to the Payroll module, the TimeCard module is
not compatible with Payroll for version 2018.

Time Track is the new time entry feature that replaces the features previously available in
the TimeCard module. To use Time Track, you must install Sage 100 2018.2.

For information on using Time Track with the Job Cost module, see "Time Track" (page

113).

Sage 100 Customer Upgrade Guide 123



Visual Integrator Changes in 2018

For information on using Time Track with the Payroll module, see the Sage 100 Payroll

2.18 Installation and Upgrade Guide.

Visual Integrator Changes in 2018

The following changes made in version 2018 apply to the Visual Integrator module.

Module Options for Managing Job Access

You can now control whether users can create and run import and export jobs on a

module-by-module basis. Module options to manage job access have been added to

Role Maintenance for the following modules:

Accounts Payable

Accounts Receivable

Bar Code

Bill of Materials

Bank Reconciliation

Common Information

Customer Relationship Management
eBusiness Manager

Fixed Assets

General Ledger

Inventory Management

Library Master

Purchase Order

Payroll

Return Merchandise Authorization
Sales Order

Job Cost and Payroll Import and Export Jobs

All import and export jobs for the Job Cost and Payroll modules must be recreated.
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Renamed and Replaced Tasks

Renamed and Replaced Tasks

This section lists tasks that have been renamed or replaced with another task in version
2018.

Accounts Payable

Form 1099 eFiling and Reporting has been renamed Form 1099 Tax Reporting.

Mobility (Formerly Bar Code)

* Inventory EZ Import replaces Import Inventory Transactions.

o Sales Order EZ Import replaces Import Sales Order Transactions.

e Purchase Order EZ Import replaces Import Purchase Order Transactions.
« Bill of Materials EZ Import replaces Import Bill of Materials Transactions.
» Purge Bar Code History has been renamed Purge EZ Import History.

» The Unattended Bar Code Transaction Import task has been removed from the Main
menu. Use the EZ Import tasks instead.

Sage Contact for Office 365

When you integrate Office 365 with Sage 100 version 2018, you can use the Sage
Contact app to view Sage 100 customer information in Outlook, including the following:

* Recentinvoices and payments

» Credit information

o Contacts’ name, address, phone, and email

e Customer memos

You can also edit contact information and create new customer contact records in
Outlook, and the changes are updated to Sage 100.

An Office 365 Business Premium or Enterprise subscription plan and an Azure Active
Directory subscription are required. For more details, see the Sage 100 Integrated
Solutions Compatibility Matrix in the Sage Knowledgebase (article ID 48274).

For setup instructions, see Set Up Office 365 Integration in the help.
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Retired Features

The integration between the General Ledger module and the BenefitMall payroll service
is no longer supported beginning with version 2018. Sage Payroll Services is now the
only supported payroll service. Based on your implementation, it is possible that the
integration for the BenefitMall payroll service may continue to function. However Sage
has discontinued our ongoing development efforts.
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Changes in Version 2017

This chapter describes the changes made in the 2017 release that you should be aware
of. Installation and global changes are listed first followed by module changes and
retirements.

Global

The following changes are carried throughout multiple modules.

Enhanced Auto-Complete

When using the auto-complete feature, your search criteria is compared with all words
within the searched fields. Previously the feature considered only the beginning of the
text in the searched fields.

Note: To activate the enhanced auto-complete feature, run the Build Search
Index utility after upgrading to version 2017. Run the utility as new customer,
vendor, and item records are created to see the records in auto-complete search
results.

For example, if you have a customer named Allen’s Appliance Repair and a customer
named Appliance Services, typing Appl in the Customer No. field results in a list that
incudes both customers.

In addition, the number of fields included in the search has been expanded. For example,
to search for a vendor by phone number, start typing the phone number, digits only, in the
Vendor No. field.

After adding new records, you’ll need to run the Build Search Index utility on the Library
Master Utilities menu to index those records so that they appear in the auto-complete
search.

For more information on this feature, see Auto-Complete Search in the help.

Build Search Index Utility

To activate the enhanced auto-complete feature, run the Build Search Index utility on the
Library Master Utilities menu. If you do not run the utility, auto-complete will work as it did
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before this update.

Run the utility after creating new customer, vendor, and item records so that the records
are indexed and appear in the auto-complete results. Running the utility updates the
index for all of your companies.

You can use Task Scheduler to automatically run the indexing utility on a regular basis.

Full Text Search Option in Lookup Windows

A Full Text option has been added to the Search list in Lookup windows. When you select
Full Text, your search criteria is compared with the data in all columns available in the
Lookup window.

Note that your search criteria must match the beginning of a word. For example, if you
have a customer named Hydromart and a customer named Martin Supply, when you type
Mart, Martin Supply will appear in the search results, but Hydromart will not.

Search for Empty Fields in Lookup Windows

You can now search for fields that do not contain any value in Lookup windows. After
selecting a field from the Search list, select Is Empty from the operand list, and then click
Find.

Maintain Commodity Codes for Miscellaneous and
Inventory Items

You can now maintain a list of commodity codes and associate them with miscellaneous

and inventory items. Commodity codes are included with the data sent when processing

Level 3 credit card transactions in the Sales Order module.

o Commodity Code Maintenance has been added to the Common Information Setup
menu. Use this task to maintain a list of commodity codes and their descriptions. The

codes and descriptions are available in the lookup views for Commodity Code fields.
You can click the Apply button to assign a commodity code to a range of items.

e The Commodity Code Import Wizard, available on the Common Information Utilities
menu, guides you through importing commodity codes from tab-delimited text files.
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« A Commodity Code field has been added to the Main tab in Miscellaneous Item
Maintenance and the Additional tab in ltem Maintenance. You can enter an existing
code or create a new one on the fly.

» A Commodity Code field has been added to the Main tab in Product Line
Maintenance. A Commodity Code check box has been added to the Apply Product
Line Information window so that you can apply the code entered in Product Line
Maintenance to the selected inventory items within the product line.

* When an item is selected in Sales Order Entry and S/O Invoice Data Entry, the code
entered in the item’s maintenance task is the default value in the Commodity Code
field, but it can be changed.

» A new Commodity Desc field displays the commodity code description in Sales Order
Entry and S/O Invoice Data Entry.

Note: The Commaodity Code field appears in Sales Order Entry and S/O Invoice
Data Entry only if a credit card set up for Level 3 processing is selected as the
payment method.

Prior and Next Buttons for Calendar Window

Prior and Next buttons have been added to the Calendar window. You can use the
buttons to quickly change from month to month.

Resizable Memo Maintenance Window

You can now resize the Memo Maintenance window by dragging the lower-right corner of
the window.

Ability to Suppress "Remove Forms" Message

A module option in Role Maintenance allows you to suppress the message that reminds
you to replace forms with paper after printing.

To no longer see this message, clear the Show Prompt to Remove Forms From Printer
check box in the Common Information section.

Larger Font for Selected Reports

The font size used for selected reports has been increased to improve readability. These
reports previously used a 6 point font. The new font is horizontally equivalent to the
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previous font, but it is 30 to 40 percent taller.

Cancel Button Available When Printing Reports

You can now cancel report printing by clicking the Cancel button on the message window
that appears while the report is processing. Note that clicking the Cancel button will cause
the report's task window to close, even if you have selected the Keep Open After Print
check box.

New Options on Help Ribbon

Several buttons have been added to the Help ribbon on the standard Desktop. The new
options include the ability to:

» Access the Sage 100 knowledgebase
» Start a chat session with Sage 100 tech support

» Create a support ticket

You must log in to use some of these features.

Accounts Receivable
Ability to Accept ACH Payments

You can now enter ACH payments in the following tasks:

* A/R Invoice Data Entry

» Cash Receipts Entry

* Repetitive Invoice Entry

To enable this feature, you must have a Paya account that is set up for ACH payments.
You can then enable the feature on the Payments tab in Company Maintenance and set

up ACH payment types in Payment Type Maintenance. For more information, see Set Up
Credit Card and ACH Payment Processing in the help.

To accommodate this feature, some tasks, fields, and tabs have been renamed to
reference "payments" instead of "credit cards." Details are in the following sections.
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ACH Payment Processing

ACH payments are submitted to Paya Exchange as part of the Cash Receipts Journal
and A/R Sales Journal update process. They cannot be processed individually. For more
information, see Process ACH Payment Transactions in the help.

Data Entry Tasks

The following changes were made in the data entry tasks.

» The Credit Card tab has been renamed; it is now the Payment tab. Fields related to
ACH payments have been added, and the Payment ID field has replaced the Card ID
field.

» On the Payment tab, the Fix button is available based on the Allow to Override ACH
Payment Transaction security event in Role Maintenance.

» ACH payment related fields have been added to the Cash Receipts Deposit window
and the Cash Receipts Entry Header tab.

Maintenance Tasks
The following changes were made in maintenance tasks:

» In Payment Type Maintenance, you can now select ACH Payment as the payment
method.

e On the Customer Maintenance Additional tab, the Payment ID field has replaced the
Card ID field. ACH payment-related fields have been added.

» On the Customer Maintenance Invoices and Transactions tabs, ACH payments now
appear in the secondary grid.

e The Customer Credit Card Maintenance window has been renamed Customer Credit
Card and ACH Payment Maintenance. ACH payment-related fields have been added
to the window.

« In Invoice History Inquiry, an ACH account field displays the last four digits of the
ACH payment bank account for invoices with ACH payments. A Payment Information
button has replaced the Credit Card Information button. The button opens the new
Payment Information window to view additional details about the payment.
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Reports and Listings

» The option to print customers’ ACH payment information has been added to the
Customer Listing task window. The last four digits of the bank account appear on the
listing.

» On the Deposit Transaction Report, the last four digits of the bank account appear for
ACH payments in the renamed Credit Card/ACH/Reference/Check Number column.

» The Credit Card Settlement Report has been renamed Credit Card and ACH
Settlement Report. ACH payments are included on the report.

Changing Transaction Information

A new security event, Allow to Override ACH Payment Transactions, has been added.
This security event enables the Fix button on the Payments tab in A/R Invoice Data Entry
and Cash Receipts Entry, which lets users update ACH payment transaction information.

Renamed Tasks, Tabs, and Fields

As part of the ACH payments enhancement, the following changes were made:

» In Accounts Receivable Options, the Allow Credit Cards field was renamed Allow
Credit Cards / ACH Payments.

» In Customer Maintenance, the Card ID field was renamed Payment ID, and the
Credit Cards button was renamed Credit Cards/ACH.

e The Customer Credit Card Maintenance window was renamed Customer Credit Card
and ACH Payment Maintenance.

 In Customer Credit Card and ACH Payment Maintenance, the following items were
renamed:

e The Card ID field was renamed Payment ID.
* The Add New Card button was renamed Add New.
o The Edit Card button was renamed Edit.

» The Customer Credit Card Listing was renamed Customer Credit Card and ACH
Payment Listing.

 In Invoice Data Entry, Repetitive Invoice Entry, and Cash Receipts Entry, the
following changes were made:
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» The Credit Card tab was renamed Payment.
e The Card ID field was renamed Payment ID.
e The Submit Card button was renamed Submit Card/ACH Account.

e The Credit Card Settlement Report was renamed Credit Card and ACH Settlement
Report.

e The Clear Credit Card Information utility was renamed Clear Credit Card and ACH
Information.

Bank Reconciliation

Option to Keep Bank Reconciliation Report Window
Open

The following check boxes have been added to the Bank Reconciliation Report task
window:

o Keep Window Open After Print

» Keep Window Open After Preview

Note that the task window will automatically close when updating the report, even if the
check boxes are selected.

Improved Export to Excel for Reports

When exporting Bank Reconciliation reports to Microsoft Excel, the resulting Excel file is
easier to view and manipulate.

e The minimum font size is 8 points.

e Empty columns and rows are minimized.

Credit Card Processing

Sage Exchange Desktop No Longer Automatically
Installed

Sage Exchange Desktop (SED) is no longer automatically installed when adding a
customer credit card or processing a credit card transaction. You must install the program
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on each workstation that will be used to process credit card or ACH payments.

The SED installation program has been added to the Productivity Applications screen
within the Sage 100 installation program and to the Workstation Setup installation
program. For more information, see the Sage Exchange section in the Sage 100
Installation and System Administrator’'s Guide, or refer to the data conversion checklist for
the Sage 100 version that you’re upgrading from. The checklists are in Appendix A.

Customer Relationship Management

Sage CRM 7.3 SP3 is now included with Sage 100. For information on what’s new in this
version, see Sage CRM 7.3 SP3 Release Notes. This document is available in the
Documentation folder within the Sage CRM installation program. To access this guide,
click the Documentation link on the Autorun screen that appears when you start the Sage
CRM installation program.

General Ledger

Improved Export to Excel for Financial Reports

When exporting financial reports to Microsoft Excel, the resulting Excel file is easier to
view and manipulate.

e The minimum font size is 8 points.

* Empty columns and rows are minimized.

Library Master

Search Added to Role Maintenance

After selecting a role in Role Maintenance, you can click the Search button and enter
search criteria. A list of matching tasks, security events, and module options appears, and
you can select one to go to its location on the applicable tab.
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Changes for ACH Payments
As part of the ACH payments enhancement, the following changes were made in
Company Maintenance:

e The Credit Card Processing tab was renamed Payments

» The Enable Credit Card Processing check box was replaced with an Enable
Payments field to accommodate both credit cards and ACH payments.

For more information on this enhancement, see "Ability to Accept ACH Payments" (page

130).

Sales Order
Ability to Accept ACH Payments

You can now enter ACH payments in the following tasks:

» Sales Order Entry

» S/O Invoice Data Entry

To enable this feature, you must have a Paya account that is set up for ACH payments.
You can then enable the feature on the Payments tab in Company Maintenance and set

up ACH payment types in Payment Type Maintenance. For more information, see Set Up
Credit Card and ACH Payment Processing in the help.

To accommodate this feature, the following changes were made in the data entry tasks.

» The Credit Card tab has been renamed; it is now the Payment tab. Fields related to
ACH payments have been added, and the Payment ID field has replaced the Card ID
field.

» On the Payment tab in Invoice Data Entry, the Fix button is available based on the
Allow to Override ACH Payment Transaction security event in Role Maintenance.

ACH Payment Processing

ACH payments are submitted to Paya Exchange as part of the Sales Journal update
process. They cannot be processed individually. For more information, see Process ACH
Payment Transactions in the help.
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Renamed Tabs, Fields, and Buttons

As part of the ACH payments enhancement, the following changes were made in Sales
Order Entry and S/O Invoice Data Entry.

e The Credit Card tab was renamed Payment.
e The Card ID field was renamed Payment ID.

e The Submit Card button was renamed Submit Card/ACH Account.
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Upgrade Checklists

These checklists provide instructions for migrating your data from your older Sage 100
installation and then upgrading the data to version 2023.

If you haven’t already, follow the instructions in the Sage 100 2023 Installation and
System Administrator’s Guide to install and set up Sage 100 2023. The guide is in the
Documents folder accessible within the installation program, and it’s also available on the
Sage 100 Documents page.

The data upgrade process consists of three steps:

1. Preparing your data for upgrading
2. Migrating your data to your version 2023 installation

3. Converting your data to version 2023

This guide contains the information you'll need to migrate and convert your data. Use one
of the following checklists based on the version of Sage 100 you're upgrading from.

¢ "Upgrading from Version 2022 to Version 2023" (page 138)

» "Upgrading from Version 2021 to Version 2023" (page 149)

¢ "Upgrading from Version 2020 to Version 2023" (page 160)

» "Upgrading from Version 2019 to Version 2023" (page 171)

* "Upgrading from Version 2018 to Version 2023" (page 182)

» "Upgrading from Version 2017 to Version 2023" (page 193)
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Upgrading from Version 2022 to Version 2023

When upgrading to version 2023, you must perform a parallel installation, and use the
Pre-Migration and Parallel Migration utilities from the Library Master Utilities menu to
upgrade your data. For more information, consult with your Sage business partner.

If you have custom modules or modifications to any of your modules, consult your Sage
business partner or development partner prior to beginning the upgrade process.

If your system is integrated with Sage CRM, you must follow the instructions for
upgrading Sage CRM in the Sage 100 Installation and System Administrator's Guide.
You can find the guide on the Sage 100 Documents page.

Pre-Upgrade Checklist

You must prepare your version 2022 data for upgrading. This should be done for each
company you plan to upgrade.

Complete these steps in your version 2022 installation.

1. Process all pending credit card transactions.

2. Print and update all journals and registers.

Important! Failure to complete this step may result in loss of data.

3. If you use the Payroll module:

» Update the Payroll Check Register.
* Complete and purge all direct deposit transactions.

You must install the Payroll module in addition to installing Sage 100. Payroll is
not part of the Sage 100 installation program. To avoid the need to run a
separate data conversion for Payroll, install the module before proceeding to
the Upgrade Checklist.

For more information, see the Sage 100 Payroll Installation and Upgrade Guide
available on the Sage 100 Documents page.

Sage 100 Customer Upgrade Guide 138


https://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm
https://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm

Upgrading from Version 2022 to Version 2023

4. If you're upgrading the Work Order module to Production Management, run Work
Order Purge to move closed work orders into the history files. Work Order Purge is
located on the Work Order Main menu.

5. Create a backup of your version 2022 MAS90 folder, which includes data for all of
your companies. Perform this step following your usual backup process. For specific
support on how to back up your data, refer to manuals for your backup software or
contact the vendor from whom you purchased that product.

6. Rebuild all data files.

« If you are upgrading from Sage 100 Standard or Advanced, use the Rebuild Key
Files and Rebuild Sort File utilities.

* If you are upgrading from Sage 100 Premium, use the Rebuild Sort File utility.
You must answer Yes to all recalculation questions.

7. Print all customized form definitions.

8. If you are using eBusiness Manager, back up any templates, .htm files, and the IW
folder before uninstalling the previous version of the Web Engine.

9. Run the Pre-Migration Utility on the Library Master Utilities menu. The utility
examines your data and displays a list of tasks that you should run before migrating
your data. For more information, see the Pre-Migration Utility help.

10. If you are upgrading Sage 100 Premium, configure your firewall to allow access to
port number 1433 on the server with your version 2022 installation. Port 1433 is the
default SQL Server port

Upgrade Checklist

After completing the "Pre-Upgrade Checklist" (page 138), you are ready to migrate your

data to your version 2023 system.
Complete these steps in your version 2023 installation.

» For Sage 100 Standard or Advanced, use the checklist below.

e For Sage 100 Premium, see "Upgrade Checklist for Sage 100 Premium " (page 140).

Note: If you’re going to convert data for the Payroll module, you’ll need access to
Tax Profile Maintenance. If you use Payroll departments, you must have access to
all departments in each company.
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Upgrade Checklist for Sage 100 Standard and Advanced

1. Create a backup of your version 2023 MAS90 folder. Creating a backup now will
save time if you need to revert to the folder’s original state.

2. Loginto Sage 100 2023 as the Administrator. From the Administrative Tools
window:

a. Start Role Maintenance and create a role that you'll use to run the Parallel
Migration Wizard.

b. Onthe Tasks tab, expand Library Master > Miscellaneous Tasks, and then
select the Parallel Migration check box.

c. Start User Maintenance, create a logon, and select the role that you
created.

d. Close the Administrative Tools window.

3. Loginto Sage 100 2023, and select Library Master > Utilities > Parallel Migration.
Follow the steps in the wizard to migrate your data.

4. After the migration is complete, log into Sage 100 2023 as the Administrator. Use
the tasks available from the Administrative Tools window to review user security
and set up and assign the appropriate roles to your users.

5. Review security tasks for new features in version 2023. Review ODBC security if it
is used.

6. If you are using Unified Logon and you upgraded your system files, you must add
the following statement on one workstation SOTA.ini: Logon=Yes.

7. If you customized your Desktop, review the customizations.

Important! After migrating data for companies that are connected to Bank Feeds,
you cannot use Bank Feeds in any pre-existing company that was not migrated
and converted. You will not be able to connect or disconnect banks or process
transactions.

Upgrade Checklist for Sage 100 Premium

Use this checklist to migrate your Sage 100 Premium data.
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Important!

» You must have administrator rights for the server with your prior version of Sage
100 and the server with your version 2023 installation.

» Clustered drives do not allow hidden shares. If you are using clustered drives,
follow the instructions in the Manual Workaround section of article number
76993 in the Sage Knowledgebase.

1. Foryour Sage 100 2023 installation, create a backup of the following:
a. The Sage 100 MAS90 folder
b. The MAS_System SQL Server database

Creating backups now will save time if you need to revert to the installation’s original
state.

2. Verify that the required rights and permissions are set up on the server(s) where
SQL Server is installed. If the instance of SQL Server for Sage 100 2023 is installed
on a different server than the instance used for your prior version, you must
complete these steps on both servers.

a. Open the Control Panel, select Administrative Tools, and then select
Services.

b. Inthe Services window, locate the SQL Server instance used for Sage 100
Premium, right-click it, and select Properties.

c. Inthe Properties window, click the Log On tab and select an option.

* Ifthe SQL Server instance that you're using for version 2023 is installed
on the same server as the instance used for your prior version of Sage
100 Premium, select Local System Account.

 Ifthe SQL Server instance that you’re using for version 2023 is installed
on a different server than the one used for your prior version of Sage
100 Premium, select This Account.

In the account field, enter: \ServerName\Administrator

Replace "ServerName" with the name of the server. Sage strongly
recommends using the actual Administrator or Domain Administrator
account.

Enter the password for the account.
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d. Apply your changes and then stop and restart the services.

€. If you're working with more than one server, make sure that all servers can
access each other through hidden shares.

For example: \\ServerName\C$, \\ServerName\D$

3. Start the Parallel Migration Wizard using one of the methods below, and follow the
steps in the wizard.

* If you are using Windows Server 2008, start the Parallel Migration Wizard from
the Sage program group on the Start menu.

* If you are using Windows Server 2012 or later, start the Parallel Migration
Wizard from the Start window.

The Migration Wizard creates .bak files in the ..\DATA folders for the two SQL

Server locations. The hidden shares are used to access the source databases to

create the .bak files. For example:

\\ServerName\c$\Program Files\Microsoft SQL
Server\MSSQL12.MSSQLSERVER\MSSQL\Data

After the .bak files are created, the wizard copies them to the hidden share of the
destination ..\DATA SQL Server folders.

To complete the process, the wizard then restores the databases into the new SQL
Server location and removes the .bak files from both the source and destination
locations.

If permissions were not set correctly on both servers, you may receive the following
error: "Error Number : 0x80040e14 Description: Access Denied 5 or Access Denied
2 Setup will now terminate”

If this error occurs, see article number 76993 in the Sage Knowledgebase.

4. After the migration is complete, log into Sage 100 2023 as the Administrator. Use
the tasks available from the Administrative Tools window to review user security
and set up and assign the appropriate roles to your users.

5. Review security tasks for new features in version 2023. Review ODBC security if it
is used.

6. If you are using Unified Logon and you upgraded your system files, you must add
the following statement on one workstation SOTA.ini: Logon=Yes.

~

. If you customized your Desktop, review the customizations.
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You're now ready to convert your data to version 2023.

Important! After migrating data for companies that are connected to Bank Feeds,
you cannot use Bank Feeds in any pre-existing company that was not migrated
and converted. You will not be able to connect or disconnect banks or process
transactions.

Data Conversion Checklist

Follow these steps to convert your data.

1. If your company data contains credit card information, install the latest version of
Paya Connect Desktop and verify that the workstation you are using has a working
internet connection. This is necessary so that credit card records can be transferred
to a Paya Exchange Vault account during conversion. Credit card records must be
transferred to a Paya Exchange Vault account before company data can be
converted.

To install Paya Connect Desktop:
a. Startthe Sage 100 installation program.
b. Click Productivity Applications.
c. Click Install Paya Connect Desktop to start the installation wizard.
d. Proceed through the wizard to install the program.

2. Select Library Master Main menu > Company Maintenance. Select a company, and
then click Convert to convert your data. You must convert data for each of your
companies. In addition, you can select one or more of the following options:

e Convert Data for All Companies: Select this check box to convert data for all of
your companies instead of doing it one-by-one. This check box may be
unavailable if you’re converting Payroll data, depending on which version of
Payroll you're upgrading from.

» Convert SAP Crystal Reports: Select this check box to convert all of your
custom reports and forms. The time required to convert your reports and forms
depends on how many of them you have that need to be converted. The
process runs in the background, and you can continue working in Sage 100

while it’s running.
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You can convert custom forms and reports later by running the Sage 100
Crystal Report Conversion Wizard.

e Update Custom Office Panels to Current Level: Select this check box to run the
Custom Office panel update for any customized panels for the companies being
converted. This update runs without any prompts.

You can update custom panels later by running the Update Customized Panels
to Current Level utility on the Custom Office Utilities menu.

3. If you were not processing transactions through Paya but plan to start doing so,
contact Paya to convert the Paya Exchange Vault-Only account created during
conversion to a processing account.

4. If your system is integrated with Sage CRM, go into CRM Server Options, and
update the following information as needed.

 Integration server port ID

» Sage CRM SQL server name

» Sage CRM SQL database name

The server name and database name should reference the mirror installation that
you created for integration with Sage 100 2023. For more information on this

process, refer to the Installing Sage CRM section in the Sage 100 Installation and
System Administrator’s Guide.

After updating the information, load the Sage CRM data.

5. If you synchronize payroll data between your General Ledger module and Sage
Payroll Services, verify that your Sage 100 company or companies are still linked to
the service.

a. Select General Ledger > Payroll Services > Payroll Services
Synchronization Wizard.

b. Sign in to Sage Payroll Services.

c. Proceed through the wizard.

d. Review the status messages shown in the Synchronizing Data with Sage
Payroll Services window.

If you see a "Synchronization Complete" message, no further action is
required.

Sage 100 Customer Upgrade Guide 144



Upgrading from Version 2022 to Version 2023

10.

If you see a "Synchronization failed" message, contact iSolved Support for
assistance with resetting the link.
Update customized panels by selecting Custom Office Utilities menu > Update

Customized Panels to Current Level. Review the placement of all user-defined
fields.

. If you have customized Advanced Lookup Engine (ALE) lookups, after converting to

the new version of the software and prior to accessing other modules, select Library
Master Utilities menu > Lookup Conversion to convert your lookups.

. Verify that all module links are functional by selecting Library Master Utilities menu >

Link Maintenance Utility. Links that appear in red are broken and will need to be
fixed using the Relink button in Link Maintenance Utility. For more information on
relinking files, see Copy/Move/Relink Files in your Help system.

If you are also upgrading your Payroll Module, review the list of enhancements and
upgrade instructions in the Sage 100 Payroll Installation and Upgrade Guide,
available on the Sage 100 Documents page.

Test your customized Crystal reports and forms.

* If you need to troubleshoot issues with customized reports and forms, run the
Crystal Form Comparison Report utility to compare your customized reports
and forms to the standard ones in version 2023.

To run the utility, select File menu > Run, and then type SYWFCU. The utility
tells you which tables, if any, have been added to a report or form. It does not
provide information about formatting changes, such as those affecting fonts,
logos, and so forth

* If you were previously using non-graphical forms, you will need to set them up
using SAP Crystal Reports.

* If you are using Sage 100 Standard or Sage 100 Advanced, use the Crystal
Reports Conversion Wizard to convert your Crystal reports and forms. For more
information, see SAP Crystal Reports FAQs in the Help system. If you do not
run the wizard now, it will automatically run the first time that someone runs a
form or report.

 If you are using Sage 100 Premium, refer to the Converting Reports for Sage
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11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

100 Premium section in the Sage 100 Installation and System Administrator's
Guide for more information.

If Sage 100 2023 is installed on the same computer as an earlier version of Sage
100, complete this step to avoid errors when printing forms and reports in the earlier
version:

Copy the pvxwin32.exe.config file from the ..\MAS90\Home folder in your 2022
installation to the same folder in your 2023 installation. You must complete this step
on both the server and the workstation.

If your system has custom reports, review the Custom Reports menus to make sure
they are available. If they are not, add them using Report Manager.

If you use Sage Intelligence Reporting, create a new repository for use with the
latest version of Sage 100 and import any custom reports into it. For detailed
instructions, see the "Upgrading Sage Intelligence Reporting" (page 206) checklist.

Review the Paperless Office module configuration for e-mailing statements, reports,
journals, registers, and other forms. For more information, see Set Up Paperless
Office in the Help.

Review your Business Insights Dashboard pages. For more information, see Set Up
Business Insights Dashboard in the Help.

To use the eBusiness Manager module:

a. Restore the copied templates back to the IW folder after re-installing the
Web Engine.

b. Copy the poweredby.gif image from the MAS90\Images folder to the IIS
Inetpup\wwwroot\images folder and restart the [IS Web service.

If you converted Work Order data to Production Management data, purchase orders
that were linked to work orders must be manually relinked to work tickets. You can
do this by selecting the purchase order in Purchase Order Entry and entering the
applicable work ticket number in the Work Ticket No. field on the Lines tab.

If you use Custom Financials Reporting, you must unhide the menu and tasks.
Select File menu > Run and type *unhidegl in the Run Program window.

Print all customized form definitions and compare them to the ones previously
printed. Default forms may be erased in the upgrade process.

If you purchased the Return Merchandise Authorization module, after setting up the
data files for the first time, select Return Merchandise Authorization Setup menu >
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21.

22.

23.

24.

25.

26.

Create Customer Invoice Search Records to create customer invoice search
records in RMA.

To run Microsoft Script links, you must have the Microsoft Windows Script Host
processor on your system. For information on installing the Microsoft Windows
Script Host processor, refer to the Microsoft Download Center website.

If you use Automatic Update or Task Scheduler, review your scheduled automatic
updates and reschedule those updates by selecting Library Master Main menu >
Automatic Update or Task Scheduler, as applicable.

If you were using the classic Desktop, which is no longer available, and had task
folders in your My Tasks area, you can add tasks to the Favorites list instead. For
more information, see Add Items to the Favorites Content Group in the Help.

Test all printers, including Device Configurator printers, that you normally use for
printing forms and reports. Each workstation must have a default printer defined.

To use the auto-complete feature with enhanced search, run the Build Search Index
utility to index your existing customer, vendor, and item records. To run the utility,
select Library Master > Utilities > Build Search Index.

Install Paya Connect Desktop on each workstation for each Windows user who
needs to access credit card and ACH payment information in Sage 100.

To install Paya Connect Desktop for Sage 100 Standard:

a. Use File Explorer to browse to the MAS90\Wksetup folder.

If you are installing Paya Connect Desktop on a workstation that connects to
a Sage 100 Standard installation on a server, browser to the
MAS90\Wksetup folder on the server.

b. Double-click Autorun.exe to open the Workstation Setup program; it takes a
few seconds to launch.

c. Click Install Paya Connect Desktop.

d. Proceed through the steps in the Paya Connect Desktop installation wizard
to install the program.

To install Paya Connect Desktop for Sage 100 Advanced and Premium:

a. Use File Explorer to browse to the server where Sage 100 is installed, and
locate the MAS90\Wksetup folder.
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b. Double-click Autorun.exe to open the Workstation Setup program; it takes a
few seconds to launch.

c. Click Install Paya Connect Desktop.

d. Proceed through the steps in the Paya Connect Desktop installation wizard
to install the program.

27. Ifyouinstalled the 32-bit version of Sage 100 and need to convert to the 64-bit
version, see "Converting to 64-bit Version of Sage 100" (page 210).
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Upgrading from Version 2021 to Version 2023

When upgrading to version 2023, you must perform a parallel installation, and use the
Pre-Migration and Parallel Migration utilities from the Library Master Utilities menu to
upgrade your data. For more information, consult with your Sage business partner.

If you have custom modules or modifications to any of your modules, consult your Sage
business partner or development partner prior to beginning the upgrade process.

If your system is integrated with Sage CRM, you must follow the instructions for
upgrading Sage CRM in the Sage 100 Installation and System Administrator's Guide.
You can find the guide on the Sage 100 Documents page.

Pre-Upgrade Checklist

You must prepare your version 2021 data for upgrading. This should be done for each
company you plan to upgrade.

Complete these steps in your version 2021 installation.

1. Process all pending credit card transactions.

2. Print and update all journals and registers.

Important! Failure to complete this step may result in loss of data.

3. If you use the Payroll module:

» Update the Payroll Check Register.
* Complete and purge all direct deposit transactions.

You must install the Payroll module in addition to installing Sage 100. Payroll is
not part of the Sage 100 installation program. To avoid the need to run a
separate data conversion for Payroll, install the module before proceeding to
the Upgrade Checklist.

For more information, see the Sage 100 Payroll Installation and Upgrade Guide
available on the Sage 100 Documents page.
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4. If you're upgrading the Work Order module to Production Management, run Work
Order Purge to move closed work orders into the history files. Work Order Purge is
located on the Work Order Main menu.

5. Create a backup of your version 2021 MAS90 folder, which includes data for all of
your companies. Perform this step following your usual backup process. For specific
support on how to back up your data, refer to manuals for your backup software or
contact the vendor from whom you purchased that product.

6. Rebuild all data files.

« If you are upgrading from Sage 100 Standard or Advanced, use the Rebuild Key
Files and Rebuild Sort File utilities.

* If you are upgrading from Sage 100 Premium, use the Rebuild Sort File utility.
You must answer Yes to all recalculation questions.

7. Print all customized form definitions.

8. If you are using eBusiness Manager, back up any templates, .htm files, and the IW
folder before uninstalling the previous version of the Web Engine.

9. Run the Pre-Migration Utility on the Library Master Utilities menu. The utility
examines your data and displays a list of tasks that you should run before migrating
your data. For more information, see the Pre-Migration Utility help.

10. If you are upgrading Sage 100 Premium, configure your firewall to allow access to
port number 1433 on the server with your version 2021 installation. Port 1433 is the
default SQL Server port

Upgrade Checklist

After completing the "Pre-Upgrade Checklist" (page 149), you are ready to migrate your

data to your version 2023 system.
Complete these steps in your version 2023 installation.

» For Sage 100 Standard or Advanced, use the checklist below.

» For Sage 100 Premium, see "Upgrade Checklist for Sage 100 Premium " (page 151).

Note: If you’re going to convert data for the Payroll module, you’ll need access to
Tax Profile Maintenance. If you use Payroll departments, you must have access to
all departments in each company.
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Upgrade Checklist for Sage 100 Standard and Advanced

1. Create a backup of your version 2023 MAS90 folder. Creating a backup now will
save time if you need to revert to the folder’s original state.

2. Loginto Sage 100 2023 as the Administrator. From the Administrative Tools
window:

a. Start Role Maintenance and create a role that you'll use to run the Parallel
Migration Wizard.

b. Onthe Tasks tab, expand Library Master > Miscellaneous Tasks, and then
select the Parallel Migration check box.

c. Start User Maintenance, create a logon, and select the role that you
created.

d. Close the Administrative Tools window.

3. Loginto Sage 100 2023, and select Library Master > Utilities > Parallel Migration.
Follow the steps in the wizard to migrate your data.

4. After the migration is complete, log into Sage 100 2023 as the Administrator. Use
the tasks available from the Administrative Tools window to review user security
and set up and assign the appropriate roles to your users.

5. Review security tasks for new features in version 2023. Review ODBC security if it
is used.

6. If you are using Unified Logon and you upgraded your system files, you must add
the following statement on one workstation SOTA.ini: Logon=Yes.

7. If you customized your Desktop, review the customizations.

Important! After migrating data for companies that are connected to Bank Feeds,
you cannot use Bank Feeds in any pre-existing company that was not migrated
and converted. You will not be able to connect or disconnect banks or process
transactions.

Upgrade Checklist for Sage 100 Premium

Use this checklist to migrate your Sage 100 Premium data.
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Important!

» You must have administrator rights for the server with your prior version of Sage
100 and the server with your version 2023 installation.

» Clustered drives do not allow hidden shares. If you are using clustered drives,
follow the instructions in the Manual Workaround section of article number
76993 in the Sage Knowledgebase.

1. Foryour Sage 100 2023 installation, create a backup of the following:
a. The Sage 100 MAS90 folder
b. The MAS_System SQL Server database

Creating backups now will save time if you need to revert to the installation’s original
state.

2. Verify that the required rights and permissions are set up on the server(s) where
SQL Server is installed. If the instance of SQL Server for Sage 100 2023 is installed
on a different server than the instance used for your prior version, you must
complete these steps on both servers.

a. Open the Control Panel, select Administrative Tools, and then select
Services.

b. Inthe Services window, locate the SQL Server instance used for Sage 100
Premium, right-click it, and select Properties.

c. Inthe Properties window, click the Log On tab and select an option.

* Ifthe SQL Server instance that you're using for version 2023 is installed
on the same server as the instance used for your prior version of Sage
100 Premium, select Local System Account.

 Ifthe SQL Server instance that you’re using for version 2023 is installed
on a different server than the one used for your prior version of Sage
100 Premium, select This Account.

In the account field, enter: \ServerName\Administrator

Replace "ServerName" with the name of the server. Sage strongly
recommends using the actual Administrator or Domain Administrator
account.

Enter the password for the account.
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d. Apply your changes and then stop and restart the services.

€. If you're working with more than one server, make sure that all servers can
access each other through hidden shares.

For example: \\ServerName\C$, \\ServerName\D$

3. Start the Parallel Migration Wizard using one of the methods below, and follow the
steps in the wizard.

* If you are using Windows Server 2008, start the Parallel Migration Wizard from
the Sage program group on the Start menu.

* If you are using Windows Server 2012 or later, start the Parallel Migration
Wizard from the Start window.

The Migration Wizard creates .bak files in the ..\DATA folders for the two SQL

Server locations. The hidden shares are used to access the source databases to

create the .bak files. For example:

\\ServerName\c$\Program Files\Microsoft SQL
Server\MSSQL12.MSSQLSERVER\MSSQL\Data

After the .bak files are created, the wizard copies them to the hidden share of the
destination ..\DATA SQL Server folders.

To complete the process, the wizard then restores the databases into the new SQL
Server location and removes the .bak files from both the source and destination
locations.

If permissions were not set correctly on both servers, you may receive the following
error: "Error Number : 0x80040e14 Description: Access Denied 5 or Access Denied
2 Setup will now terminate”

If this error occurs, see article number 76993 in the Sage Knowledgebase.

4. After the migration is complete, log into Sage 100 2023 as the Administrator. Use
the tasks available from the Administrative Tools window to review user security
and set up and assign the appropriate roles to your users.

5. Review security tasks for new features in version 2023. Review ODBC security if it
is used.

6. If you are using Unified Logon and you upgraded your system files, you must add
the following statement on one workstation SOTA.ini: Logon=Yes.

~

. If you customized your Desktop, review the customizations.
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You're now ready to convert your data to version 2023.

Important! After migrating data for companies that are connected to Bank Feeds,
you cannot use Bank Feeds in any pre-existing company that was not migrated
and converted. You will not be able to connect or disconnect banks or process
transactions.

Data Conversion Checklist

Follow these steps to convert your data.

1. If your company data contains credit card information, install the latest version of
Paya Connect Desktop and verify that the workstation you are using has a working
internet connection. This is necessary so that credit card records can be transferred
to a Paya Exchange Vault account during conversion. Credit card records must be
transferred to a Paya Exchange Vault account before company data can be
converted.

To install Paya Connect Desktop:
a. Startthe Sage 100 installation program.
b. Click Productivity Applications.
c. Click Install Paya Connect Desktop to start the installation wizard.
d. Proceed through the wizard to install the program.

2. Select Library Master Main menu > Company Maintenance. Select a company, and
then click Convert to convert your data. You must convert data for each of your
companies. In addition, you can select one or more of the following options:

e Convert Data for All Companies: Select this check box to convert data for all of
your companies instead of doing it one-by-one. This check box may be
unavailable if you’re converting Payroll data, depending on which version of
Payroll you're upgrading from.

» Convert SAP Crystal Reports: Select this check box to convert all of your
custom reports and forms. The time required to convert your reports and forms
depends on how many of them you have that need to be converted. The
process runs in the background, and you can continue working in Sage 100

while it’s running.
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You can convert custom forms and reports later by running the Sage 100
Crystal Report Conversion Wizard.

e Update Custom Office Panels to Current Level: Select this check box to run the
Custom Office panel update for any customized panels for the companies being
converted. This update runs without any prompts.

You can update custom panels later by running the Update Customized Panels
to Current Level utility on the Custom Office Utilities menu.

3. If you were not processing transactions through Paya but plan to start doing so,
contact Paya to convert the Paya Exchange Vault-Only account created during
conversion to a processing account.

4. If your system is integrated with Sage CRM, go into CRM Server Options, and
update the following information as needed.

 Integration server port ID

» Sage CRM SQL server name

» Sage CRM SQL database name

The server name and database name should reference the mirror installation that
you created for integration with Sage 100 2023. For more information on this

process, refer to the Installing Sage CRM section in the Sage 100 Installation and
System Administrator’s Guide.

After updating the information, load the Sage CRM data.

5. If you synchronize payroll data between your General Ledger module and Sage
Payroll Services, verify that your Sage 100 company or companies are still linked to
the service.

a. Select General Ledger > Payroll Services > Payroll Services
Synchronization Wizard.

b. Sign in to Sage Payroll Services.

c. Proceed through the wizard.

d. Review the status messages shown in the Synchronizing Data with Sage
Payroll Services window.

If you see a "Synchronization Complete" message, no further action is
required.
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10.

If you see a "Synchronization failed" message, contact iSolved Support for
assistance with resetting the link.
Update customized panels by selecting Custom Office Utilities menu > Update

Customized Panels to Current Level. Review the placement of all user-defined
fields.

. If you have customized Advanced Lookup Engine (ALE) lookups, after converting to

the new version of the software and prior to accessing other modules, select Library
Master Utilities menu > Lookup Conversion to convert your lookups.

. Verify that all module links are functional by selecting Library Master Utilities menu >

Link Maintenance Utility. Links that appear in red are broken and will need to be
fixed using the Relink button in Link Maintenance Utility. For more information on
relinking files, see Copy/Move/Relink Files in your Help system.

If you are also upgrading your Payroll Module, review the list of enhancements and
upgrade instructions in the Sage 100 Payroll Installation and Upgrade Guide,
available on the Sage 100 Documents page.

Test your customized Crystal reports and forms.

* If you need to troubleshoot issues with customized reports and forms, run the
Crystal Form Comparison Report utility to compare your customized reports
and forms to the standard ones in version 2023.

To run the utility, select File menu > Run, and then type SYWFCU. The utility
tells you which tables, if any, have been added to a report or form. It does not
provide information about formatting changes, such as those affecting fonts,
logos, and so forth

* If you were previously using non-graphical forms, you will need to set them up
using SAP Crystal Reports.

* If you are using Sage 100 Standard or Sage 100 Advanced, use the Crystal
Reports Conversion Wizard to convert your Crystal reports and forms. For more
information, see SAP Crystal Reports FAQs in the Help system. If you do not
run the wizard now, it will automatically run the first time that someone runs a
form or report.

 If you are using Sage 100 Premium, refer to the Converting Reports for Sage
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11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

100 Premium section in the Sage 100 Installation and System Administrator's
Guide for more information.

If Sage 100 2023 is installed on the same computer as an earlier version of Sage
100, complete this step to avoid errors when printing forms and reports in the earlier
version:

Copy the pvxwin32.exe.config file from the ..\MAS90\Home folder in your 2021
installation to the same folder in your 2023 installation. You must complete this step
on both the server and the workstation.

If your system has custom reports, review the Custom Reports menus to make sure
they are available. If they are not, add them using Report Manager.

If you use Sage Intelligence Reporting, create a new repository for use with the
latest version of Sage 100 and import any custom reports into it. For detailed
instructions, see the "Upgrading Sage Intelligence Reporting" (page 206) checklist.

Review the Paperless Office module configuration for e-mailing statements, reports,
journals, registers, and other forms. For more information, see Set Up Paperless
Office in the Help.

Review your Business Insights Dashboard pages. For more information, see Set Up
Business Insights Dashboard in the Help.

To use the eBusiness Manager module:

a. Restore the copied templates back to the IW folder after re-installing the
Web Engine.

b. Copy the poweredby.gif image from the MAS90\Images folder to the IIS
Inetpup\wwwroot\images folder and restart the [IS Web service.

If you converted Work Order data to Production Management data, purchase orders
that were linked to work orders must be manually relinked to work tickets. You can
do this by selecting the purchase order in Purchase Order Entry and entering the
applicable work ticket number in the Work Ticket No. field on the Lines tab.

If you use Custom Financials Reporting, you must unhide the menu and tasks.
Select File menu > Run and type *unhidegl in the Run Program window.

Print all customized form definitions and compare them to the ones previously
printed. Default forms may be erased in the upgrade process.

If you purchased the Return Merchandise Authorization module, after setting up the
data files for the first time, select Return Merchandise Authorization Setup menu >
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21.

22.

23.

24.

25.

26.

Create Customer Invoice Search Records to create customer invoice search
records in RMA.

To run Microsoft Script links, you must have the Microsoft Windows Script Host
processor on your system. For information on installing the Microsoft Windows
Script Host processor, refer to the Microsoft Download Center website.

If you use Automatic Update or Task Scheduler, review your scheduled automatic
updates and reschedule those updates by selecting Library Master Main menu >
Automatic Update or Task Scheduler, as applicable.

If you were using the classic Desktop, which is no longer available, and had task
folders in your My Tasks area, you can add tasks to the Favorites list instead. For
more information, see Add Items to the Favorites Content Group in the Help.

Test all printers, including Device Configurator printers, that you normally use for
printing forms and reports. Each workstation must have a default printer defined.

To use the auto-complete feature with enhanced search, run the Build Search Index
utility to index your existing customer, vendor, and item records. To run the utility,
select Library Master > Utilities > Build Search Index.

Install Paya Connect Desktop on each workstation for each Windows user who
needs to access credit card and ACH payment information in Sage 100.

To install Paya Connect Desktop for Sage 100 Standard:

a. Use File Explorer to browse to the MAS90\Wksetup folder.

If you are installing Paya Connect Desktop on a workstation that connects to
a Sage 100 Standard installation on a server, browser to the
MAS90\Wksetup folder on the server.

b. Double-click Autorun.exe to open the Workstation Setup program; it takes a
few seconds to launch.

c. Click Install Paya Connect Desktop.

d. Proceed through the steps in the Paya Connect Desktop installation wizard
to install the program.

To install Paya Connect Desktop for Sage 100 Advanced and Premium:

a. Use File Explorer to browse to the server where Sage 100 is installed, and
locate the MAS90\Wksetup folder.
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b. Double-click Autorun.exe to open the Workstation Setup program; it takes a
few seconds to launch.

c. Click Install Paya Connect Desktop.

d. Proceed through the steps in the Paya Connect Desktop installation wizard
to install the program.

27. Ifyouinstalled the 32-bit version of Sage 100 and need to convert to the 64-bit
version, see "Converting to 64-bit Version of Sage 100" (page 210).
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Upgrading from Version 2020 to Version 2023

When upgrading to version 2023, you must perform a parallel installation, and use the
Pre-Migration and Parallel Migration utilities from the Library Master Utilities menu to
upgrade your data. For more information, consult with your Sage business partner.

If you have custom modules or modifications to any of your modules, consult your Sage
business partner or development partner prior to beginning the upgrade process.

If your system is integrated with Sage CRM, you must follow the instructions for
upgrading Sage CRM in the Sage 100 Installation and System Administrator's Guide.
You can find the guide on the Sage 100 Documents page.

Pre-Upgrade Checklist

You must prepare your version 2020 data for upgrading. This should be done for each
company you plan to upgrade.

Complete these steps in your version 2020 installation.

1. Process all pending credit card transactions.

2. Print and update all journals and registers.

Important! Failure to complete this step may result in loss of data.

3. If you use the Payroll module:

» Update the Payroll Check Register.
* Complete and purge all direct deposit transactions.

You must install the Payroll module in addition to installing Sage 100. Payroll is
not part of the Sage 100 installation program. To avoid the need to run a
separate data conversion for Payroll, install the module before proceeding to
the Upgrade Checklist.

For more information, see the Sage 100 Payroll Installation and Upgrade Guide
available on the Sage 100 Documents page.
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4. If you're upgrading the Work Order module to Production Management, run Work
Order Purge to move closed work orders into the history files. Work Order Purge is
located on the Work Order Main menu.

5. Create a backup of your version 2020 MAS90 folder, which includes data for all of
your companies. Perform this step following your usual backup process. For specific
support on how to back up your data, refer to manuals for your backup software or
contact the vendor from whom you purchased that product.

6. Rebuild all data files.

« If you are upgrading from Sage 100 Standard or Advanced, use the Rebuild Key
Files and Rebuild Sort File utilities.

* If you are upgrading from Sage 100 Premium, use the Rebuild Sort File utility.
You must answer Yes to all recalculation questions.

7. Print all customized form definitions.

8. If you are using eBusiness Manager, back up any templates, .htm files, and the IW
folder before uninstalling the previous version of the Web Engine.

9. Run the Pre-Migration Utility on the Library Master Utilities menu. The utility
examines your data and displays a list of tasks that you should run before migrating
your data. For more information, see the Pre-Migration Utility help.

10. If you are upgrading Sage 100 Premium, configure your firewall to allow access to
port number 1433 on the server with your version 2020 installation. Port 1433 is the
default SQL Server port.

Upgrade Checklist

After completing the "Pre-Upgrade Checklist" (page 160), you are ready to migrate your

data to your version 2023 system.
Complete these steps in your version 2023 installation.

» For Sage 100 Standard or Advanced, use the checklist below.

e For Sage 100 Premium, see "Upgrade Checklist for Sage 100 Premium " (page 162).

Note: If you’re going to convert data for the Payroll module, you’ll need access to
Tax Profile Maintenance. If you use Payroll departments, you must have access to
all departments in each company.
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Upgrade Checklist for Sage 100 Standard and Advanced

1. Create a backup of your version 2023 MAS90 folder. Creating a backup now will
save time if you need to revert to the folder’s original state.

2. Loginto Sage 100 2023 as the Administrator. From the Administrative Tools
window:

a. Start Role Maintenance and create a role that you'll use to run the Parallel
Migration Wizard.

b. Onthe Tasks tab, expand Library Master > Miscellaneous Tasks, and then
select the Parallel Migration check box.

c. Start User Maintenance, create a logon, and select the role that you
created.

d. Close the Administrative Tools window.

3. Loginto Sage 100 2023, and select Library Master > Utilities > Parallel Migration.
Follow the steps in the wizard to migrate your data.

4. After the migration is complete, log into Sage 100 2023 as the Administrator. Use
the tasks available from the Administrative Tools window to review user security
and set up and assign the appropriate roles to your users.

5. Review security tasks for new features in version 2023. Review ODBC security if it
is used.

6. If you are using Unified Logon and you upgraded your system files, you must add
the following statement on one workstation SOTA.ini: Logon=Yes.

7. If you customized your Desktop, review the customizations.

Important! After migrating data for companies that are connected to Bank Feeds,
you cannot use Bank Feeds in any pre-existing company that was not migrated
and converted. You will not be able to connect or disconnect banks or process
transactions.

Upgrade Checklist for Sage 100 Premium

Use this checklist to migrate your Sage 100 Premium data.
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Important!

» You must have administrator rights for the server with your prior version of Sage
100 and the server with your version 2023 installation.

» Clustered drives do not allow hidden shares. If you are using clustered drives,
follow the instructions in the Manual Workaround section of article number
76993 in the Sage Knowledgebase.

1. Foryour Sage 100 2023 installation, create a backup of the following:
a. The Sage 100 MAS90 folder
b. The MAS_System SQL Server database

Creating backups now will save time if you need to revert to the installation’s original
state.

2. Verify that the required rights and permissions are set up on the server(s) where
SQL Server is installed. If the instance of SQL Server for Sage 100 2023 is installed
on a different server than the instance used for your prior version, you must
complete these steps on both servers.

a. Open the Control Panel, select Administrative Tools, and then select
Services.

b. Inthe Services window, locate the SQL Server instance used for Sage 100
Premium, right-click it, and select Properties.

c. Inthe Properties window, click the Log On tab and select an option.

* Ifthe SQL Server instance that you're using for version 2023 is installed
on the same server as the instance used for your prior version of Sage
100 Premium, select Local System Account.

 Ifthe SQL Server instance that you’re using for version 2023 is installed
on a different server than the one used for your prior version of Sage
100 Premium, select This Account.

In the account field, enter: \ServerName\Administrator

Replace "ServerName" with the name of the server. Sage strongly
recommends using the actual Administrator or Domain Administrator
account.

Enter the password for the account.
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d. Apply your changes and then stop and restart the services.

€. If you're working with more than one server, make sure that all servers can
access each other through hidden shares.

For example: \\ServerName\C$, \\ServerName\D$

3. Start the Parallel Migration Wizard using one of the methods below, and follow the
steps in the wizard.

* If you are using Windows Server 2008, start the Parallel Migration Wizard from
the Sage program group on the Start menu.

* If you are using Windows Server 2012 or later, start the Parallel Migration
Wizard from the Start window.

The Migration Wizard creates .bak files in the ..\DATA folders for the two SQL

Server locations. The hidden shares are used to access the source databases to

create the .bak files. For example:

\\ServerName\c$\Program Files\Microsoft SQL
Server\MSSQL12.MSSQLSERVER\MSSQL\Data

After the .bak files are created, the wizard copies them to the hidden share of the
destination ..\DATA SQL Server folders.

To complete the process, the wizard then restores the databases into the new SQL
Server location and removes the .bak files from both the source and destination
locations.

If permissions were not set correctly on both servers, you may receive the following
error: "Error Number : 0x80040e14 Description: Access Denied 5 or Access Denied
2 Setup will now terminate”

If this error occurs, see article number 76993 in the Sage Knowledgebase.

4. After the migration is complete, log into Sage 100 2023 as the Administrator. Use
the tasks available from the Administrative Tools window to review user security
and set up and assign the appropriate roles to your users.

5. Review security tasks for new features in version 2023. Review ODBC security if it
is used.

6. If you are using Unified Logon and you upgraded your system files, you must add
the following statement on one workstation SOTA.ini: Logon=Yes.

~

. If you customized your Desktop, review the customizations.
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You're now ready to convert your data to version 2023.

Important! After migrating data for companies that are connected to Bank Feeds,
you cannot use Bank Feeds in any pre-existing company that was not migrated
and converted. You will not be able to connect or disconnect banks or process
transactions.

Data Conversion Checklist

Follow these steps to convert your data.

1. If your company data contains credit card information, install the latest version of
Paya Connect Desktop and verify that the workstation you are using has a working
internet connection. This is necessary so that credit card records can be transferred
to a Paya Exchange Vault account during conversion. Credit card records must be
transferred to a Paya Exchange Vault account before company data can be
converted.

To install Paya Connect Desktop:
a. Startthe Sage 100 installation program.
b. Click Productivity Applications.
c. Click Install Paya Connect Desktop to start the installation wizard.
d. Proceed through the wizard to install the program.

2. Select Library Master Main menu > Company Maintenance. Select a company, and
then click Convert to convert your data. You must convert data for each of your
companies. In addition, you can select one or more of the following options:

e Convert Data for All Companies: Select this check box to convert data for all of
your companies instead of doing it one-by-one. This check box may be
unavailable if you’re converting Payroll data, depending on which version of
Payroll you're upgrading from.

» Convert SAP Crystal Reports: Select this check box to convert all of your
custom reports and forms. The time required to convert your reports and forms
depends on how many of them you have that need to be converted. The
process runs in the background, and you can continue working in Sage 100

while it’s running.
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You can convert custom forms and reports later by running the Sage 100
Crystal Report Conversion Wizard.

e Update Custom Office Panels to Current Level: Select this check box to run the
Custom Office panel update for any customized panels for the companies being
converted. This update runs without any prompts.

You can update custom panels later by running the Update Customized Panels
to Current Level utility on the Custom Office Utilities menu.

3. If you were not processing transactions through Paya but plan to start doing so,
contact Paya to convert the Paya Exchange Vault-Only account created during
conversion to a processing account.

4. If your system is integrated with Sage CRM, go into CRM Server Options, and
update the following information as needed.

 Integration server port ID

» Sage CRM SQL server name

» Sage CRM SQL database name

The server name and database name should reference the mirror installation that
you created for integration with Sage 100 2023. For more information on this

process, refer to the Installing Sage CRM section in the Sage 100 Installation and
System Administrator’s Guide.

After updating the information, load the Sage CRM data.

5. If you synchronize payroll data between your General Ledger module and Sage
Payroll Services, verify that your Sage 100 company or companies are still linked to
the service.

a. Select General Ledger > Payroll Services > Payroll Services
Synchronization Wizard.

b. Sign in to Sage Payroll Services.

c. Proceed through the wizard.

d. Review the status messages shown in the Synchronizing Data with Sage
Payroll Services window.

If you see a "Synchronization Complete" message, no further action is
required.
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10.

If you see a "Synchronization failed" message, contact iSolved Support for
assistance with resetting the link.
Update customized panels by selecting Custom Office Utilities menu > Update

Customized Panels to Current Level. Review the placement of all user-defined
fields.

. If you have customized Advanced Lookup Engine (ALE) lookups, after converting to

the new version of the software and prior to accessing other modules, select Library
Master Utilities menu > Lookup Conversion to convert your lookups.

. Verify that all module links are functional by selecting Library Master Utilities menu >

Link Maintenance Utility. Links that appear in red are broken and will need to be
fixed using the Relink button in Link Maintenance Utility. For more information on
relinking files, see Copy/Move/Relink Files in your Help system.

If you are also upgrading your Payroll Module, review the list of enhancements and
upgrade instructions in the Sage 100 Payroll Installation and Upgrade Guide,
available on the Sage 100 Documents page.

Test your customized Crystal reports and forms.

* If you need to troubleshoot issues with customized reports and forms, run the
Crystal Form Comparison Report utility to compare your customized reports
and forms to the standard ones in version 2023.

To run the utility, select File menu > Run, and then type SYWFCU. The utility
tells you which tables, if any, have been added to a report or form. It does not
provide information about formatting changes, such as those affecting fonts,
logos, and so forth

* If you were previously using non-graphical forms, you will need to set them up
using SAP Crystal Reports.

* If you are using Sage 100 Standard or Sage 100 Advanced, use the Crystal
Reports Conversion Wizard to convert your Crystal reports and forms. For more
information, see SAP Crystal Reports FAQs in the Help system. If you do not
run the wizard now, it will automatically run the first time that someone runs a
form or report.

 If you are using Sage 100 Premium, refer to the Converting Reports for Sage
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11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

100 Premium section in the Sage 100 Installation and System Administrator's
Guide for more information.

If Sage 100 2023 is installed on the same computer as an earlier version of Sage
100, complete this step to avoid errors when printing forms and reports in the earlier
version:

Copy the pvxwin32.exe.config file from the .. \MAS90\Home folder in your 2020
installation to the same folder in your 2023 installation. You must complete this step
on both the server and the workstation.

If your system has custom reports, review the Custom Reports menus to make sure
they are available. If they are not, add them using Report Manager.

If you use Sage Intelligence Reporting, create a new repository for use with the
latest version of Sage 100 and import any custom reports into it. For detailed
instructions, see the "Upgrading Sage Intelligence Reporting" (page 206) checklist.

Review the Paperless Office module configuration for e-mailing statements, reports,
journals, registers, and other forms. For more information, see Set Up Paperless
Office in the Help.

Review your Business Insights Dashboard pages. For more information, see Set Up
Business Insights Dashboard in the Help.

To use the eBusiness Manager module:

a. Restore the copied templates back to the IW folder after re-installing the
Web Engine.

b. Copy the poweredby.gif image from the MAS90\Images folder to the IIS
Inetpup\wwwroot\images folder and restart the [IS Web service.

If you converted Work Order data to Production Management data, purchase orders
that were linked to work orders must be manually relinked to work tickets. You can
do this by selecting the purchase order in Purchase Order Entry and entering the
applicable work ticket number in the Work Ticket No. field on the Lines tab.

If you use Custom Financials Reporting, you must unhide the menu and tasks.
Select File menu > Run and type *unhidegl in the Run Program window.

Print all customized form definitions and compare them to the ones previously
printed. Default forms may be erased in the upgrade process.

If you purchased the Return Merchandise Authorization module, after setting up the
data files for the first time, select Return Merchandise Authorization Setup menu >
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21.

22.

23.

24.

25.

26.

Create Customer Invoice Search Records to create customer invoice search
records in RMA.

To run Microsoft Script links, you must have the Microsoft Windows Script Host
processor on your system. For information on installing the Microsoft Windows
Script Host processor, refer to the Microsoft Download Center website.

If you use Automatic Update or Task Scheduler, review your scheduled automatic
updates and reschedule those updates by selecting Library Master Main menu >
Automatic Update or Task Scheduler, as applicable.

If you were using the classic Desktop, which is no longer available, and had task
folders in your My Tasks area, you can add tasks to the Favorites list instead. For
more information, see Add Items to the Favorites Content Group in the Help.

Test all printers, including Device Configurator printers, that you normally use for
printing forms and reports. Each workstation must have a default printer defined.

To use the auto-complete feature with enhanced search, run the Build Search Index
utility to index your existing customer, vendor, and item records. To run the utility,
select Library Master > Utilities > Build Search Index.

Install Paya Connect Desktop on each workstation for each Windows user who
needs to access credit card and ACH payment information in Sage 100.

To install Paya Connect Desktop for Sage 100 Standard:

a. Use File Explorer to browse to the MAS90\Wksetup folder.

If you are installing Paya Connect Desktop on a workstation that connects to
a Sage 100 Standard installation on a server, browser to the
MAS90\Wksetup folder on the server.

b. Double-click Autorun.exe to open the Workstation Setup program; it takes a
few seconds to launch.

c. Click Install Paya Connect Desktop.

d. Proceed through the steps in the Paya Connect Desktop installation wizard
to install the program.

To install Paya Connect Desktop for Sage 100 Advanced and Premium:

a. Use File Explorer to browse to the server where Sage 100 is installed, and
locate the MAS90\Wksetup folder.
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b. Double-click Autorun.exe to open the Workstation Setup program; it takes a
few seconds to launch.

c. Click Install Paya Connect Desktop.

d. Proceed through the steps in the Paya Connect Desktop installation wizard
to install the program.

27. Ifyouinstalled the 32-bit version of Sage 100 and need to convert to the 64-bit
version, see "Converting to 64-bit Version of Sage 100" (page 210).
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When upgrading to version 2023, you must perform a parallel installation, and use the
Pre-Migration and Parallel Migration utilities from the Library Master Utilities menu to
upgrade your data. For more information, consult with your Sage business partner.

If you have custom modules or modifications to any of your modules, consult your Sage
business partner or development partner prior to beginning the upgrade process.

If your system is integrated with Sage CRM, you must follow the instructions for
upgrading Sage CRM in the Sage 100 Installation and System Administrator's Guide.
You can find the guide on the Sage 100 Documents page.

Pre-Upgrade Checklist

You must prepare your version 2019 data for upgrading. This should be done for each
company you plan to upgrade.

Complete these steps in your version 2019 installation.

1. Process all pending credit card transactions.

2. Print and update all journals and registers.

Important! Failure to complete this step may result in loss of data.

3. If you use the Payroll module:

» Update the Payroll Check Register.
* Complete and purge all direct deposit transactions.

You must install the Payroll module in addition to installing Sage 100. Payroll is
not part of the Sage 100 installation program. To avoid the need to run a
separate data conversion for Payroll, install the module before proceeding to
the Upgrade Checklist.

For more information, see the Sage 100 Payroll Installation and Upgrade Guide
available on the Sage 100 Documents page.

Sage 100 Customer Upgrade Guide 171


https://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm
https://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm

Upgrading from Version 2019 to Version 2023

4. If you're upgrading the Work Order module to Production Management, run Work
Order Purge to move closed work orders into the history files. Work Order Purge is
located on the Work Order Main menu.

5. Create a backup of your version 2019 MAS90 folder, which includes data for all of
your companies. Perform this step following your usual backup process. For specific
support on how to back up your data, refer to manuals for your backup software or
contact the vendor from whom you purchased that product.

6. Rebuild all data files.

« If you are upgrading from Sage 100 Standard or Advanced, use the Rebuild Key
Files and Rebuild Sort File utilities.

* If you are upgrading from Sage 100 Premium, use the Rebuild Sort File utility.
You must answer Yes to all recalculation questions.

7. Print all customized form definitions.

8. If you are using eBusiness Manager, back up any templates, .htm files, and the IW
folder before uninstalling the previous version of the Web Engine.

9. Run the Pre-Migration Utility on the Library Master Utilities menu. The utility
examines your data and displays a list of tasks that you should run before migrating
your data. For more information, see the Pre-Migration Utility help.

10. If you are upgrading Sage 100 Premium, configure your firewall to allow access to
port number 1433 on the server with your version 2019 installation. Port 1433 is the
default SQL Server port.

Upgrade Checklist

After completing the "Pre-Upgrade Checklist" (page 171), you are ready to migrate your

data to your version 2023 system.
Complete these steps in your version 2023 installation.

» For Sage 100 Standard or Advanced, use the checklist below.

» For Sage 100 Premium, see "Upgrade Checklist for Sage 100 Premium" (page 173).

Note: If you’re going to convert data for the Payroll module, you’ll need access to
Tax Profile Maintenance. If you use Payroll departments, you must have access to
all departments in each company.
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Upgrade Checklist for Sage 100 Standard and Advanced

1. Create a backup of your version 2023 MAS90 folder. Creating a backup now will
save time if you need to revert to the folder’s original state.

2. Loginto Sage 100 2023 as the Administrator. From the Administrative Tools
window:

a. Start Role Maintenance and create a role that you'll use to run the Parallel
Migration Wizard.

b. Onthe Tasks tab, expand Library Master > Miscellaneous Tasks, and then
select the Parallel Migration check box.

c. Start User Maintenance, create a logon, and select the role that you
created.

d. Close the Administrative Tools window.

3. Loginto Sage 100 2023, and select Library Master > Utilities > Parallel Migration.
Follow the steps in the wizard to migrate your data.

4. After the migration is complete, log into Sage 100 2023 as the Administrator. Use
the tasks available from the Administrative Tools window to review user security
and set up and assign the appropriate roles to your users.

5. Review security tasks for new features in version 2023. Review ODBC security if it
is used.

6. If you are using Unified Logon and you upgraded your system files, you must add
the following statement on one workstation SOTA.ini: Logon=Yes.

7. If you customized your Desktop, review the customizations.

Important! After migrating data for companies that are connected to Bank Feeds,
you cannot use Bank Feeds in any pre-existing company that was not migrated
and converted. You will not be able to connect or disconnect banks or process
transactions.

Upgrade Checklist for Sage 100 Premium

Use this checklist to migrate your Sage 100 Premium data.
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Important!

» You must have administrator rights for the server with your prior version of Sage
100 and the server with your version 2023 installation.

» Clustered drives do not allow hidden shares. If you are using clustered drives,
follow the instructions in the Manual Workaround section of article number
76993 in the Sage Knowledgebase.

1. Foryour Sage 100 2023 installation, create a backup of the following:
a. The Sage 100 MAS90 folder
b. The MAS_System SQL Server database

Creating backups now will save time if you need to revert to the installation’s original
state.

2. Verify that the required rights and permissions are set up on the server(s) where
SQL Server is installed. If the instance of SQL Server for Sage 100 2023 is installed
on a different server than the instance used for your prior version, you must
complete these steps on both servers.

a. Open the Control Panel, select Administrative Tools, and then select
Services.

b. Inthe Services window, locate the SQL Server instance used for Sage 100
Premium, right-click it, and select Properties.

c. Inthe Properties window, click the Log On tab and select an option.

* Ifthe SQL Server instance that you're using for version 2023 is installed
on the same server as the instance used for your prior version of Sage
100 Premium, select Local System Account.

 Ifthe SQL Server instance that you’re using for version 2023 is installed
on a different server than the one used for your prior version of Sage
100 Premium, select This Account.

In the account field, enter: \ServerName\Administrator

Replace "ServerName" with the name of the server. Sage strongly
recommends using the actual Administrator or Domain Administrator
account.

Enter the password for the account.
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d. Apply your changes and then stop and restart the services.

€. If you're working with more than one server, make sure that all servers can
access each other through hidden shares.

For example: \\ServerName\C$, \\ServerName\D$

3. Start the Parallel Migration Wizard using one of the methods below, and follow the
steps in the wizard.

* If you are using Windows Server 2008, start the Parallel Migration Wizard from
the Sage program group on the Start menu.

* If you are using Windows Server 2012 or later, start the Parallel Migration
Wizard from the Start window.

The Migration Wizard creates .bak files in the ..\DATA folders for the two SQL

Server locations. The hidden shares are used to access the source databases to

create the .bak files. For example:

\\ServerName\c$\Program Files\Microsoft SQL
Server\MSSQL12.MSSQLSERVER\MSSQL\Data

After the .bak files are created, the wizard copies them to the hidden share of the
destination ..\DATA SQL Server folders.

To complete the process, the wizard then restores the databases into the new SQL
Server location and removes the .bak files from both the source and destination
locations.

If permissions were not set correctly on both servers, you may receive the following
error: "Error Number : 0x80040e14 Description: Access Denied 5 or Access Denied
2 Setup will now terminate”

If this error occurs, see article number 76993 in the Sage Knowledgebase.

4. After the migration is complete, log into Sage 100 2023 as the Administrator. Use
the tasks available from the Administrative Tools window to review user security
and set up and assign the appropriate roles to your users.

5. Review security tasks for new features in version 2023. Review ODBC security if it
is used.

6. If you are using Unified Logon and you upgraded your system files, you must add
the following statement on one workstation SOTA.ini: Logon=Yes.

~

. If you customized your Desktop, review the customizations.
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You're now ready to convert your data to version 2023.

Important! After migrating data for companies that are connected to Bank Feeds,
you cannot use Bank Feeds in any pre-existing company that was not migrated
and converted. You will not be able to connect or disconnect banks or process
transactions.

Data Conversion Checklist

Follow these steps to convert your data.

1. If your company data contains credit card information, install the latest version of
Paya Connect Desktop and verify that the workstation you are using has a working
internet connection. This is necessary so that credit card records can be transferred
to a Paya Exchange Vault account during conversion. Credit card records must be
transferred to a Paya Exchange Vault account before company data can be
converted.

To install Paya Connect Desktop:
a. Startthe Sage 100 installation program.
b. Click Productivity Applications.
c. Click Install Paya Connect Desktop to start the installation wizard.
d. Proceed through the wizard to install the program.

2. Select Library Master Main menu > Company Maintenance. Select a company, and
then click Convert to convert your data. You must convert data for each of your
companies. In addition, you can select one or more of the following options:

e Convert Data for All Companies: Select this check box to convert data for all of
your companies instead of doing it one-by-one. This check box may be
unavailable if you’re converting Payroll data, depending on which version of
Payroll you're upgrading from.

» Convert SAP Crystal Reports: Select this check box to convert all of your
custom reports and forms. The time required to convert your reports and forms
depends on how many of them you have that need to be converted. The
process runs in the background, and you can continue working in Sage 100

while it’s running.
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You can convert custom forms and reports later by running the Sage 100
Crystal Report Conversion Wizard.

e Update Custom Office Panels to Current Level: Select this check box to run the
Custom Office panel update for any customized panels for the companies being
converted. This update runs without any prompts.

You can update custom panels later by running the Update Customized Panels
to Current Level utility on the Custom Office Utilities menu.

3. If you were not processing transactions through Paya but plan to start doing so,
contact Paya to convert the Paya Exchange Vault-Only account created during
conversion to a processing account.

4. If your system is integrated with Sage CRM, go into CRM Server Options, and
update the following information as needed.

 Integration server port ID

» Sage CRM SQL server name

» Sage CRM SQL database name

The server name and database name should reference the mirror installation that
you created for integration with Sage 100 2023. For more information on this

process, refer to the Installing Sage CRM section in the Sage 100 Installation and
System Administrator’s Guide.

After updating the information, load the Sage CRM data.

5. If you synchronize payroll data between your General Ledger module and Sage
Payroll Services, verify that your Sage 100 company or companies are still linked to
the service.

a. Select General Ledger > Payroll Services > Payroll Services
Synchronization Wizard.

b. Sign in to Sage Payroll Services.

c. Proceed through the wizard.

d. Review the status messages shown in the Synchronizing Data with Sage
Payroll Services window.

If you see a "Synchronization Complete" message, no further action is
required.
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10.

If you see a "Synchronization failed" message, contact iSolved Support for
assistance with resetting the link.
Update customized panels by selecting Custom Office Utilities menu > Update

Customized Panels to Current Level. Review the placement of all user-defined
fields.

. If you have customized Advanced Lookup Engine (ALE) lookups, after converting to

the new version of the software and prior to accessing other modules, select Library
Master Utilities menu > Lookup Conversion to convert your lookups.

. Verify that all module links are functional by selecting Library Master Utilities menu >

Link Maintenance Utility. Links that appear in red are broken and will need to be
fixed using the Relink button in Link Maintenance Utility. For more information on
relinking files, see Copy/Move/Relink Files in your Help system.

If you are also upgrading your Payroll Module, review the list of enhancements and
upgrade instructions in the Sage 100 Payroll Installation and Upgrade Guide,
available on the Sage 100 Documents page.

Test your customized Crystal reports and forms.

* If you need to troubleshoot issues with customized reports and forms, run the
Crystal Form Comparison Report utility to compare your customized reports
and forms to the standard ones in version 2023.

To run the utility, select File menu > Run, and then type SYWFCU. The utility
tells you which tables, if any, have been added to a report or form. It does not
provide information about formatting changes, such as those affecting fonts,
logos, and so forth

* If you were previously using non-graphical forms, you will need to set them up
using SAP Crystal Reports.

* If you are using Sage 100 Standard or Sage 100 Advanced, use the Crystal
Reports Conversion Wizard to convert your Crystal reports and forms. For more
information, see SAP Crystal Reports FAQs in the Help system. If you do not
run the wizard now, it will automatically run the first time that someone runs a
form or report.

 If you are using Sage 100 Premium, refer to the Converting Reports for Sage
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11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

100 Premium section in the Sage 100 Installation and System Administrator's
Guide for more information.

If Sage 100 2023 is installed on the same computer as an earlier version of Sage
100, complete this step to avoid errors when printing forms and reports in the earlier
version:

Copy the pvxwin32.exe.config file from the ..\MAS90\Home folder in your 2019
installation to the same folder in the 2023 installation. You must complete this step
on both the server and the workstation.

If your system has custom reports, review the Custom Reports menus to make sure
they are available. If they are not, add them using Report Manager.

If you use Sage Intelligence Reporting, create a new repository for use with the
latest version of Sage 100 and import any custom reports into it. For detailed
instructions, see the "Upgrading Sage Intelligence Reporting" (page 206) checklist.

Review the Paperless Office module configuration for e-mailing statements, reports,
journals, registers, and other forms. For more information, see Set Up Paperless
Office in the Help.

Review your Business Insights Dashboard pages. For more information, see Set Up
Business Insights Dashboard in the Help.

To use the eBusiness Manager module:

a. Restore the copied templates back to the IW folder after re-installing the
Web Engine.

b. Copy the poweredby.gif image from the MAS90\Images folder to the IIS
Inetpup\wwwroot\images folder and restart the [IS Web service.

If you converted Work Order data to Production Management data, purchase orders
that were linked to work orders must be manually relinked to work tickets. You can
do this by selecting the purchase order in Purchase Order Entry and entering the
applicable work ticket number in the Work Ticket No. field on the Lines tab.

If you use Custom Financials Reporting, you must unhide the menu and tasks.
Select File menu > Run and type *unhidegl in the Run Program window.

Print all customized form definitions and compare them to the ones previously
printed. Default forms may be erased in the upgrade process.

If you purchased the Return Merchandise Authorization module, after setting up the
data files for the first time, select Return Merchandise Authorization Setup menu >
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21.

22.

23.

24.

25.

26.

Create Customer Invoice Search Records to create customer invoice search
records in RMA.

To run Microsoft Script links, you must have the Microsoft Windows Script Host
processor on your system. For information on installing the Microsoft Windows
Script Host processor, refer to the Microsoft Download Center website.

If you use Automatic Update or Task Scheduler, review your scheduled automatic
updates and reschedule those updates by selecting Library Master Main menu >
Automatic Update or Task Scheduler, as applicable.

If you were using the classic Desktop, which is no longer available, and had task
folders in your My Tasks area, you can add tasks to the Favorites list instead. For
more information, see Add Items to the Favorites Content Group in the Help.

Test all printers, including Device Configurator printers, that you normally use for
printing forms and reports. Each workstation must have a default printer defined.

To use the auto-complete feature with enhanced search, run the Build Search Index
utility to index your existing customer, vendor, and item records. To run the utility,
select Library Master > Utilities > Build Search Index.

Install Paya Connect Desktop on each workstation for each Windows user who
needs to access credit card and ACH payment information in Sage 100.

To install Paya Connect Desktop for Sage 100 Standard:

a. Use File Explorer to browse to the MAS90\Wksetup folder.

If you are installing Paya Connect Desktop on a workstation that connects to
a Sage 100 Standard installation on a server, browser to the
MAS90\Wksetup folder on the server.

b. Double-click Autorun.exe to open the Workstation Setup program; it takes a
few seconds to launch.

c. Click Install Paya Connect Desktop.

d. Proceed through the steps in the Paya Connect Desktop installation wizard
to install the program.

To install Paya Connect Desktop for Sage 100 Advanced and Premium:

a. Use File Explorer to browse to the server where Sage 100 is installed, and
locate the MAS90\Wksetup folder.
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b. Double-click Autorun.exe to open the Workstation Setup program; it takes a
few seconds to launch.

c. Click Install Paya Connect Desktop.

d. Proceed through the steps in the Paya Connect Desktop installation wizard
to install the program.

27. Ifyouinstalled the 32-bit version of Sage 100 and need to convert to the 64-bit
version, see "Converting to 64-bit Version of Sage 100" (page 210).
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Upgrading from Version 2018 to Version 2023

When upgrading to version 2023, you must perform a parallel installation, and use the
Pre-Migration and Parallel Migration utilities from the Library Master Utilities menu to
upgrade your data. For more information, consult with your Sage business partner.

If you have custom modules or modifications to any of your modules, consult your Sage
business partner or development partner prior to beginning the upgrade process.

If your system is integrated with Sage CRM, you must follow the instructions for
upgrading Sage CRM in the Sage 100 Installation and System Administrator's Guide.
You can find the guide on the Sage 100 Documents page.

Pre-Upgrade Checklist

You must prepare your version 2018 data for upgrading. This should be done for each
company you plan to upgrade.

Complete these steps in your version 2018 installation.

1. Process all pending credit card transactions.

2. Print and update all journals and registers.

Important! Failure to complete this step may result in loss of data.

3. If you use the Payroll module:

» Update the Payroll Check Register.
* Complete and purge all direct deposit transactions.

You must install the Payroll module in addition to installing Sage 100. Payroll is
not part of the Sage 100 installation program. To avoid the need to run a
separate data conversion for Payroll, install the module before proceeding to
the Upgrade Checklist.

For more information, see the Sage 100 Payroll Installation and Upgrade Guide
available on the Sage 100 Documents page.
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4. If you're upgrading the Work Order module to Production Management, run Work
Order Purge to move closed work orders into the history files. Work Order Purge is
located on the Work Order Main menu.

5. Create a backup of your version 2018 MAS90 folder, which includes data for all of
your companies. Perform this step following your usual backup process. For specific
support on how to back up your data, refer to manuals for your backup software or
contact the vendor from whom you purchased that product.

6. Rebuild all data files.

« If you are upgrading from Sage 100 Standard or Advanced, use the Rebuild Key
Files and Rebuild Sort File utilities.

* If you are upgrading from Sage 100 Premium, use the Rebuild Sort File utility.
You must answer Yes to all recalculation questions.

7. Print all customized form definitions.

8. If you are using eBusiness Manager, back up any templates, .htm files, and the IW
folder before uninstalling the previous version of the Web Engine.

9. Run the Pre-Migration Utility on the Library Master Utilities menu. The utility
examines your data and displays a list of tasks that you should run before migrating
your data. For more information, see the Pre-Migration Utility help.

10. If you are upgrading Sage 100 Premium, configure your firewall to allow access to
port number 1433 on the server with your version 2018 installation. Port 1433 is the
default SQL Server port.

Upgrade Checklist

After completing the pre-upgrade and upgrade checklists, you are ready to migrate your
data to your version 2023 system.

* For Sage 100 Standard or Advanced, use the checklist below.

* For Sage 100 Premium, see "Upgrade Checklist for Sage 100 Premium " (page 184).

Note: If you’re going to convert data for the Payroll module, you’ll need access to
Tax Profile Maintenance. If you use Payroll departments, you must have access to
all departments in each company.
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Upgrade Checklist for Sage 100 Standard and Advanced

1. Create a backup of your version 2023 MAS90 folder. Creating a backup now will
save time if you need to revert to the folder’s original state.

2. Loginto Sage 100 2023 as the Administrator. From the Administrative Tools
window:

a. Start Role Maintenance and create a role that you'll use to run the Parallel
Migration Wizard.

b. Onthe Tasks tab, expand Library Master > Miscellaneous Tasks, and then
select the Parallel Migration check box.

c. Start User Maintenance, create a logon, and select the role that you
created.

d. Close the Administrative Tools window.

3. Loginto Sage 100 2023, and select Library Master > Utilities > Parallel Migration.
Follow the steps in the wizard to migrate your data.

4. After the migration is complete, log into Sage 100 2023 as the Administrator. Use
the tasks available from the Administrative Tools window to review user security
and set up and assign the appropriate roles to your users.

5. Review security tasks for new features in version 2023. Review ODBC security if it
is used.

6. If you are using Unified Logon and you upgraded your system files, you must add
the following statement on one workstation SOTA.ini: Logon=Yes.

7. If you customized your Desktop, review the customizations.

Important! After migrating data for companies that are connected to Bank Feeds,
you cannot use Bank Feeds in any pre-existing company that was not migrated
and converted. You will not be able to connect or disconnect banks or process
transactions.

Upgrade Checklist for Sage 100 Premium

Use this checklist to migrate your Sage 100 Premium data.
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Important!

» You must have administrator rights for the server with your prior version of Sage
100 and the server with your version 2023 installation.

» Clustered drives do not allow hidden shares. If you are using clustered drives,
follow the instructions in the Manual Workaround section of article number
76993 in the Sage Knowledgebase.

1. Foryour Sage 100 2023 installation, create a backup of the following:
a. The Sage 100 MAS90 folder
b. The MAS_System SQL Server database

Creating backups now will save time if you need to revert to the installation’s original
state.

2. Verify that the required rights and permissions are set up on the server(s) where
SQL Server is installed. If the instance of SQL Server for Sage 100 2023 is installed
on a different server than the instance used for your prior version, you must
complete these steps on both servers.

a. Open the Control Panel, select Administrative Tools, and then select
Services.

b. Inthe Services window, locate the SQL Server instance used for Sage 100
Premium, right-click it, and select Properties.

c. Inthe Properties window, click the Log On tab and select an option.

* Ifthe SQL Server instance that you're using for version 2023 is installed
on the same server as the instance used for your prior version of Sage
100 Premium, select Local System Account.

 Ifthe SQL Server instance that you’re using for version 2023 is installed
on a different server than the one used for your prior version of Sage
100 Premium, select This Account.

In the account field, enter: \ServerName\Administrator

Replace "ServerName" with the name of the server. Sage strongly
recommends using the actual Administrator or Domain Administrator
account.

Enter the password for the account.
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d. Apply your changes and then stop and restart the services.

€. If you're working with more than one server, make sure that all servers can
access each other through hidden shares.

For example: \\ServerName\C$, \\ServerName\D$

3. Start the Parallel Migration Wizard using one of the methods below, and follow the
steps in the wizard.

* If you are using Windows Server 2008, start the Parallel Migration Wizard from
the Sage program group on the Start menu.

* If you are using Windows Server 2012 or later, start the Parallel Migration
Wizard from the Start window.

The Migration Wizard creates .bak files in the ..\DATA folders for the two SQL

Server locations. The hidden shares are used to access the source databases to

create the .bak files. For example:

\\ServerName\c$\Program Files\Microsoft SQL
Server\MSSQL12.MSSQLSERVER\MSSQL\Data

After the .bak files are created, the wizard copies them to the hidden share of the
destination ..\DATA SQL Server folders.

To complete the process, the wizard then restores the databases into the new SQL
Server location and removes the .bak files from both the source and destination
locations.

If permissions were not set correctly on both servers, you may receive the following
error: "Error Number : 0x80040e14 Description: Access Denied 5 or Access Denied
2 Setup will now terminate”

If this error occurs, see article number 76993 in the Sage Knowledgebase.

4. After the migration is complete, log into Sage 100 2023 as the Administrator. Use
the tasks available from the Administrative Tools window to review user security
and set up and assign the appropriate roles to your users.

5. Review security tasks for new features in version 2023. Review ODBC security if it
is used.

6. If you are using Unified Logon and you upgraded your system files, you must add
the following statement on one workstation SOTA.ini: Logon=Yes.

~

. If you customized your Desktop, review the customizations.
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You're now ready to convert your data to version 2023.

Important! After migrating data for companies that are connected to Bank Feeds,
you cannot use Bank Feeds in any pre-existing company that was not migrated
and converted. You will not be able to connect or disconnect banks or process
transactions.

Data Conversion Checklist

Follow these steps to convert your data.

1. If your company data contains credit card information, install the latest version of
Paya Connect Desktop and verify that the workstation you are using has a working
internet connection. This is necessary so that credit card records can be transferred
to a Paya Exchange Vault account during conversion. Credit card records must be
transferred to a Paya Exchange Vault account before company data can be
converted.

To install Paya Connect Desktop:
a. Startthe Sage 100 installation program.
b. Click Productivity Applications.
c. Click Install Paya Connect Desktop to start the installation wizard.
d. Proceed through the wizard to install the program.

2. Select Library Master Main menu > Company Maintenance. Select a company, and
then click Convert to convert your data. You must convert data for each of your
companies. In addition, you can select one or more of the following options:

e Convert Data for All Companies: Select this check box to convert data for all of
your companies instead of doing it one-by-one. This check box may be
unavailable if you’re converting Payroll data, depending on which version of
Payroll you're upgrading from.

» Convert SAP Crystal Reports: Select this check box to convert all of your
custom reports and forms. The time required to convert your reports and forms
depends on how many of them you have that need to be converted. The
process runs in the background, and you can continue working in Sage 100

while it’s running.
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You can convert custom forms and reports later by running the Sage 100
Crystal Report Conversion Wizard.

e Update Custom Office Panels to Current Level: Select this check box to run the
Custom Office panel update for any customized panels for the companies being
converted. This update runs without any prompts.

You can update custom panels later by running the Update Customized Panels
to Current Level utility on the Custom Office Utilities menu.

3. If you were not processing transactions through Paya but plan to start doing so,
contact Paya to convert the Paya Exchange Vault-Only account created during
conversion to a processing account.

4. If your system is integrated with Sage CRM, go into CRM Server Options, and
update the following information as needed.

 Integration server port ID

» Sage CRM SQL server name

» Sage CRM SQL database name

The server name and database name should reference the mirror installation that
you created for integration with Sage 100 2023. For more information on this

process, refer to the Installing Sage CRM section in the Sage 100 Installation and
System Administrator’s Guide.

After updating the information, load the Sage CRM data.

5. If you synchronize payroll data between your General Ledger module and Sage
Payroll Services, verify that your Sage 100 company or companies are still linked to
the service.

a. Select General Ledger > Payroll Services > Payroll Services
Synchronization Wizard.

b. Sign in to Sage Payroll Services.

c. Proceed through the wizard.

d. Review the status messages shown in the Synchronizing Data with Sage
Payroll Services window.

If you see a "Synchronization Complete" message, no further action is
required.
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10.

If you see a "Synchronization failed" message, contact iSolved Support for
assistance with resetting the link.
Update customized panels by selecting Custom Office Utilities menu > Update

Customized Panels to Current Level. Review the placement of all user-defined
fields.

. If you have customized Advanced Lookup Engine (ALE) lookups, after converting to

the new version of the software and prior to accessing other modules, select Library
Master Utilities menu > Lookup Conversion to convert your lookups.

. Verify that all module links are functional by selecting Library Master Utilities menu >

Link Maintenance Utility. Links that appear in red are broken and will need to be
fixed using the Relink button in Link Maintenance Utility. For more information on
relinking files, see Copy/Move/Relink Files in your Help system.

If you are also upgrading your Payroll Module, review the list of enhancements and
upgrade instructions in the Sage 100 Payroll Installation and Upgrade Guide,
available on the Sage 100 Documents page.

Test your customized Crystal reports and forms.

* If you need to troubleshoot issues with customized reports and forms, run the
Crystal Form Comparison Report utility to compare your customized reports
and forms to the standard ones in version 2023.

To run the utility, select File menu > Run, and then type SYWFCU. The utility
tells you which tables, if any, have been added to a report or form. It does not
provide information about formatting changes, such as those affecting fonts,
logos, and so forth

* If you were previously using non-graphical forms, you will need to set them up
using SAP Crystal Reports.

* If you are using Sage 100 Standard or Sage 100 Advanced, use the Crystal
Reports Conversion Wizard to convert your Crystal reports and forms. For more
information, see SAP Crystal Reports FAQs in the Help system. If you do not
run the wizard now, it will automatically run the first time that someone runs a
form or report.

 If you are using Sage 100 Premium, refer to the Converting Reports for Sage
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11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

100 Premium section in the Sage 100 Installation and System Administrator's
Guide for more information.

If Sage 100 2023 is installed on the same computer as an earlier version of Sage
100, complete this step to avoid errors when printing forms and reports in the earlier
version:

Copy the pvxwin32.exe.config file from the .. \MAS90\Home folder in your 2018
installation to the same folder in the 2023 installation. You must complete this step
on both the server and the workstation.

If your system has custom reports, review the Custom Reports menus to make sure
they are available. If they are not, add them using Report Manager.

If you use Sage Intelligence Reporting, create a new repository for use with the
latest version of Sage 100 and import any custom reports into it. For detailed
instructions, see the "Upgrading Sage Intelligence Reporting" (page 206) checklist.

Review the Paperless Office module configuration for e-mailing statements, reports,
journals, registers, and other forms. For more information, see Set Up Paperless
Office in the Help.

Review your Business Insights Dashboard pages. For more information, see Set Up
Business Insights Dashboard in the Help.

To use the eBusiness Manager module:

a. Restore the copied templates back to the IW folder after re-installing the
Web Engine.

b. Copy the poweredby.gif image from the MAS90\Images folder to the IIS
Inetpup\wwwroot\images folder and restart the [IS Web service.

If you converted Work Order data to Production Management data, purchase orders
that were linked to work orders must be manually relinked to work tickets. You can
do this by selecting the purchase order in Purchase Order Entry and entering the
applicable work ticket number in the Work Ticket No. field on the Lines tab.

If you use Custom Financials Reporting, you must unhide the menu and tasks.
Select File menu > Run and type *unhidegl in the Run Program window.

Print all customized form definitions and compare them to the ones previously
printed. Default forms may be erased in the upgrade process.

If you purchased the Return Merchandise Authorization module, after setting up the
data files for the first time, select Return Merchandise Authorization Setup menu >
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21.

22.

23.

24.

25.

26.

Create Customer Invoice Search Records to create customer invoice search
records in RMA.

To run Microsoft Script links, you must have the Microsoft Windows Script Host
processor on your system. For information on installing the Microsoft Windows
Script Host processor, refer to the Microsoft Download Center website.

If you use Automatic Update or Task Scheduler, review your scheduled automatic
updates and reschedule those updates by selecting Library Master Main menu >
Automatic Update or Task Scheduler, as applicable.

If you were using the classic Desktop, which is no longer available, and had task
folders in your My Tasks area, you can add tasks to the Favorites list instead. For
more information, see Add Items to the Favorites Content Group in the Help.

Test all printers, including Device Configurator printers, that you normally use for
printing forms and reports. Each workstation must have a default printer defined.

To use the auto-complete feature with enhanced search, run the Build Search Index
utility to index your existing customer, vendor, and item records. To run the utility,
select Library Master > Utilities > Build Search Index.

Install Paya Connect Desktop on each workstation for each Windows user who
needs to access credit card and ACH payment information in Sage 100.

To install Paya Connect Desktop for Sage 100 Standard:

a. Use File Explorer to browse to the MAS90\Wksetup folder.

If you are installing Paya Connect Desktop on a workstation that connects to
a Sage 100 Standard installation on a server, browser to the
MAS90\Wksetup folder on the server.

b. Double-click Autorun.exe to open the Workstation Setup program; it takes a
few seconds to launch.

c. Click Install Paya Connect Desktop.

d. Proceed through the steps in the Paya Connect Desktop installation wizard
to install the program.

To install Paya Connect Desktop for Sage 100 Advanced and Premium:

a. Use File Explorer to browse to the server where Sage 100 is installed, and
locate the MAS90\Wksetup folder.
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b. Double-click Autorun.exe to open the Workstation Setup program; it takes a
few seconds to launch.

c. Click Install Paya Connect Desktop.

d. Proceed through the steps in the Paya Connect Desktop installation wizard
to install the program.

27. Ifyouinstalled the 32-bit version of Sage 100 and need to convert to the 64-bit
version, see "Converting to 64-bit Version of Sage 100" (page 210).
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Upgrading from Version 2017 to Version 2023

When upgrading to version 2023, you must perform a parallel installation, and use the
Pre-Migration and Parallel Migration utilities from the Library Master Utilities menu to
upgrade your data. For more information, consult with your Sage business partner.

If you have custom modules or modifications to any of your modules, consult your Sage
business partner or development partner prior to beginning the upgrade process.

If your system is integrated with Sage CRM, you must follow the instructions for
upgrading Sage CRM in the Sage 100 Installation and System Administrator's Guide.
You can find the guide on the Sage 100 Documents page.

Pre-Upgrade Checklist

You must prepare your version 2017 data for upgrading. This should be done for each
company you plan to upgrade.

Complete these steps in your version 2017 installation.

1. Process all pending credit card transactions.

2. Print and update all journals and registers.

Important! Failure to complete this step may result in loss of data.

3. If you use the Payroll module:
» Update the Payroll Check Register.
e Complete and purge all direct deposit transactions.

 If you have set up departments, you must have a user account set up with
access to all departments in all companies. Department access must be
assigned to individual user logon ID, not by groups. Groups are no longer used
to manage department access.

You must install the Payroll module in addition to installing Sage 100. Payroll is not
part of the Sage 100 installation program. To avoid the need to run a separate data
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conversion for Payroll, install the module before proceeding to the Upgrade
Checklist.

For more information, see the Sage 100 Payroll Installation and Upgrade Guide
available on the Sage 100 Documents Page.

4. If you're upgrading the Work Order module to Production Management, run Work
Order Purge to move closed work orders into the history files. Work Order Purge is
located on the Work Order Main menu.

3. Create a backup of your version 2017 MAS9O0 folder, which includes data for all of
your companies. Perform this step following your usual backup process. For specific
support on how to back up your data, refer to manuals for your backup software or
contact the vendor from whom you purchased that product.

6. Rebuild all data files.

« If you are upgrading from Sage 100 Standard or Advanced, use the Rebuild Key
Files and Rebuild Sort File utilities.

* If you are upgrading from Sage 100 Premium, use the Rebuild Sort File utility.
You must answer Yes to all recalculation questions.

7. Print all customized form definitions.

8. If you are using eBusiness Manager, back up any templates, .htm files, and the IW
folder before uninstalling the previous version of the Web Engine.

9. Run the Pre-Migration Utility on the Library Master Utilities menu. The utility
examines your data and displays a list of tasks that you should run before migrating
your data. For more information, see the Pre-Migration Utility help.

10. If you are upgrading Sage 100 Premium, configure your firewall to allow access to
port number 1433 on the server with your version 2017 installation. Port 1433 is the
default SQL Server port.

Upgrade Checklist

After completing the pre-upgrade checklist, you are ready to migrate your data to your
version 2023 system.

* For Sage 100 Standard or Advanced, use the checklist below.

* For Sage 100 Premium, see "Upgrade Checklist for Sage 100 Premium " (page 195).
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Note: If you’re going to convert data for the Payroll module, you’ll need access to
Tax Profile Maintenance. If you use Payroll departments, you must have access
to all departments in each company.

Upgrade Checklist for Sage 100 Standard and Advanced

1. Create a backup of your version 2023 MAS90 folder. Creating a backup now will
save time if you need to revert to the folder’s original state.

2. Loginto Sage 100 2023 as the Administrator. From the Administrative Tools
window:

a. Start Role Maintenance and create a role that you'll use to run the Parallel
Migration Wizard.

b. On the Tasks tab, expand Library Master > Miscellaneous Tasks, and then
select the Parallel Migration check box.

c. Start User Maintenance, create a logon, and select the role that you
created.

d. Close the Administrative Tools window.

3. Loginto Sage 100 2023, and select Library Master > Utilities > Parallel Migration.
Follow the steps in the wizard to migrate your data.

4. After the migration is complete, log into Sage 100 2023 as the Administrator. Use
the tasks available from the Administrative Tools window to review user security
and set up and assign the appropriate roles to your users.

5. Review security tasks for new features in version 2023. Review ODBC security if it
is used.

6. If you are using Unified Logon and you upgraded your system files, you must add
the following statement on one workstation SOTA.ini: Logon=Yes.

~

If you customized your Desktop, review the customizations.

Important! After migrating data for companies that are connected to Bank Feeds,
you cannot use Bank Feeds in any pre-existing company that was not migrated
and converted. You will not be able to connect or disconnect banks or process
transactions.

Upgrade Checklist for Sage 100 Premium

Use this checklist to migrate your Sage 100 Premium data.
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Important!

» You must have administrator rights for the server with your prior version of Sage
100 and the server with your version 2023 installation.

» Clustered drives do not allow hidden shares. If you are using clustered drives,
follow the instructions in the Manual Workaround section of article number
76993 in the Sage Knowledgebase.

1. Foryour Sage 100 2023 installation, create a backup of the following:
a. The Sage 100 MAS90 folder
b. The MAS_System SQL Server database

Creating backups now will save time if you need to revert to the installation’s original
state.

2. Verify that the required rights and permissions are set up on the server(s) where
SQL Server is installed. If the instance of SQL Server for Sage 100 2023 is installed
on a different server than the instance used for your prior version, you must
complete these steps on both servers.

a. Open the Control Panel, select Administrative Tools, and then select
Services.

b. Inthe Services window, locate the SQL Server instance used for Sage 100
Premium, right-click it, and select Properties.

c. Inthe Properties window, click the Log On tab and select an option.

* Ifthe SQL Server instance that you're using for version 2023 is installed
on the same server as the instance used for your prior version of Sage
100 Premium, select Local System Account.

 Ifthe SQL Server instance that you’re using for version 2023 is installed
on a different server than the one used for your prior version of Sage
100 Premium, select This Account.

In the account field, enter: \ServerName\Administrator

Replace "ServerName" with the name of the server. Sage strongly
recommends using the actual Administrator or Domain Administrator
account.

Enter the password for the account.
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d. Apply your changes and then stop and restart the services.

€. If you're working with more than one server, make sure that all servers can
access each other through hidden shares.

For example: \\ServerName\C$, \\ServerName\D$

3. Start the Parallel Migration Wizard using one of the methods below, and follow the
steps in the wizard.

* If you are using Windows Server 2008, start the Parallel Migration Wizard from
the Sage program group on the Start menu.

* If you are using Windows Server 2012 or later, start the Parallel Migration
Wizard from the Start window.

The Migration Wizard creates .bak files in the ..\DATA folders for the two SQL

Server locations. The hidden shares are used to access the source databases to

create the .bak files. For example:

\\ServerName\c$\Program Files\Microsoft SQL
Server\MSSQL12.MSSQLSERVER\MSSQL\Data

After the .bak files are created, the wizard copies them to the hidden share of the
destination ..\DATA SQL Server folders.

To complete the process, the wizard then restores the databases into the new SQL
Server location and removes the .bak files from both the source and destination
locations.

If permissions were not set correctly on both servers, you may receive the following
error: "Error Number : 0x80040e14 Description: Access Denied 5 or Access Denied
2 Setup will now terminate”

If this error occurs, see article number 76993 in the Sage Knowledgebase.

4. After the migration is complete, log into Sage 100 2023 as the Administrator. Use
the tasks available from the Administrative Tools window to review user security
and set up and assign the appropriate roles to your users.

5. Review security tasks for new features in version 2023. Review ODBC security if it
is used.

6. If you are using Unified Logon and you upgraded your system files, you must add
the following statement on one workstation SOTA.ini: Logon=Yes.

~

. If you customized your Desktop, review the customizations.

Sage 100 Customer Upgrade Guide 197


https://support.na.sage.com/selfservice/viewdocument.do?noCount=true&externalId=76993

Upgrading from Version 2017 to Version 2023

You're now ready to convert your data to version 2023.

Important! After migrating data for companies that are connected to Bank Feeds,
you cannot use Bank Feeds in any pre-existing company that was not migrated
and converted. You will not be able to connect or disconnect banks or process
transactions.

Data Conversion Checklist

After completing the pre-upgrade and upgrade checklist, you are ready to convert your
data to version 2023.

Note: If you use the Payroll module, you must log in with a user account that has
access to all payroll departments; otherwise, you will not be able to complete data
conversion.

1. If your company data contains credit card information, install the latest version of
Paya Connect Desktop and verify that the workstation you are using has a working
internet connection. This is necessary so that credit card records can be transferred
to a Paya Exchange Vault account during conversion. Credit card records must be
transferred to a Paya Exchange Vault account before company data can be
converted.

To install Paya Connect Desktop:
a. Startthe Sage 100 installation program.
b. Click Productivity Applications.
c. Click Install Paya Connect Desktop to start the installation wizard.
d. Proceed through the wizard to install the program.

2. Select Library Master Main menu > Company Maintenance. Select a company, and
then click Convert to convert your data. You must convert data for each of your
companies. In addition, you can select one or more of the following options:

e Convert Data for All Companies: Select this check box to convert data for all of
your companies instead of doing it one-by-one. This check box may be
unavailable if you’re converting Payroll data, depending on which version of
Payroll you're upgrading from.
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e Convert SAP Crystal Reports: Select this check box to convert all of your
custom reports and forms. The time required to convert your reports and forms
depends on how many of them you have that need to be converted. The
process runs in the background, and you can continue working in Sage 100
while it’s running.

You can convert custom forms and reports later by running the Sage 100
Crystal Report Conversion Wizard.

» Update Custom Office Panels to Current Level: Select this check box to run the
Custom Office panel update for any customized panels for the companies being
converted. This update runs without any prompts.

You can update custom panels later by running the Update Customized Panels
to Current Level utility on the Custom Office Utilities menu.

3. If you are converting Payroll Data, the Payroll Data Conversion Wizard
automatically opens. Companies that include Payroll data must be converted one
by one. You'll be guided through the following tasks:

e Mapping department numbers. If you use payroll departments and any of the
departments numbers contain special characters, you must enter new
department numbers containing only alphanumeric characters to replace them.

» Selecting tax groups from the payroll tax database to replace your existing tax
codes. If you are using local tax codes, each state and local tax code
combination will be replaced by one tax group. Depending on which tax codes
you’re using, the wizard offers suggestions for you to review and update as
needed.

* Adding tax groups to tax profiles. Tax profiles are collections of tax groups that
you assign to employees to determine how their taxes are calculated. You can
access Tax Profile Maintenance from the wizard to create tax profiles.

» Selecting filing statuses from the payroll tax database to replace your existing
ones. The filing statuses in the database may differ from the ones that you are
using. The wizard offers suggestions when possible for you to review and
update as needed.
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4.

If you were not processing transactions through Paya but plan to start doing so,
contact Paya to convert the Paya Exchange Vault-Only account created during
conversion to a processing account.

If your system is integrated with Sage CRM, go into CRM Server Options, and
update the following information as needed.

* Integration server port ID

e Sage CRM SQL server name

» Sage CRM SQL database name

The server name and database name should reference the mirror installation that
you created for integration with Sage 100 2023. For more information on this

process, refer to the Installing Sage CRM section in the Sage 100 Installation and
System Administrator’s Guide.

After updating the information, load the Sage CRM data.

If you synchronize payroll data between your General Ledger module and Sage
Payroll Services, verify that your Sage 100 company or companies are still linked to
the service.

a. Select General Ledger > Payroll Services > Payroll Services
Synchronization Wizard.

b. Signinto Sage Payroll Services.

c. Proceed through the wizard.

d. Review the status messages shown in the Synchronizing Data with Sage
Payroll Services window.

If you see a "Synchronization Complete" message, no further action is
required.

If you see a "Synchronization failed" message, contact iSolved Support for
assistance with resetting the link.

Update customized panels by selecting Custom Office Utilities menu > Update
Customized Panels to Current Level. Review the placement of all user-defined
fields.

For the Job Cost and Payroll modules, you must manually recreate all of your
customized panels. User defined fields will be automatically converted.
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8.

10.

If you have customized Advanced Lookup Engine (ALE) lookups, after converting to
the new version of the software and prior to accessing other modules, select Library

Master Utilities menu > Lookup Conversion to convert your lookups.

For the Job Cost and Payroll Modules, you must manually recreate all custom

lookups.

Verify that all module links are functional by selecting Library Master Utilities menu
> Link Maintenance Utility. Links that appear in red are broken and will need to be
fixed using the Relink button in Link Maintenance Utility. For more information on
relinking files, see Copy/Move/Relink Files in your Help system.

If you are also upgrading your Payroll Module, review the list of enhancements and
upgrade instructions in the Sage 100 Payroll Installation and Upgrade Guide,
available on the Sage 100 Documents page.

After reviewing the guide, complete the following tasks:

a. Select Payroll > Setup > Earnings Code Maintenance. For each earnings

code, select a tax rule.

b. Select Payroll > Setup > Deduction Code Maintenance. For each pension or

cafeteria plan deduction code, select a tax rule.

C. Select Payroll > Setup > Company Tax Group Setup. For each tax group

that you are using:

Enter the tax ID number for state and local tax groups. For the Federal
tax group, the tax ID number entered in Company Maintenance
appears and can only be viewed.

Enter the general ledger account numbers to credit with the tax
amounts withheld from employees’ pay.

On the Main tab, enter any tax rates that are specific to your company
and the associated effective dates.

On the Taxes tab, in the Tax field, select the tax(es) for the selected tax
group. The taxes available are based on the selected tax group. Note:
There may be more than one tax that needs to be set up.
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d. Select Payroll > Setup > Tax Profile Maintenance. Review the tax profiles
that were created when converting payroll data, and make changes if
needed.

€. Select Payroll > Main > Employee Maintenance. On the Taxes tab, enter at
least one tax profile for each employee. Depending on the tax groups, you
may need to enter a filing status, a Workers’ Compensation code, or other
information.

f. Also in Employee Maintenance, on the Additional tab, verify that the correct
selection appears in the Ethnicity/Race field.

g. If you are using the security feature in Department Maintenance, you must
recreate the lists of users who can access each department. Select Payroll
> Setup > Department Maintenance, and click the Security tab.

h. To ensure that your system can communicate with the tax calculation
engine, add the following URL to your browser's trusted sites list:
Spa.na.sage.com

Complete this step on all workstations that will be used to process payroll,
and also on the server where Sage 100 is installed if the Process Tax
Calculation on the Server check box is selected in System Configuration.

11. Test your customized Crystal reports and forms.

* If you need to troubleshoot issues with customized reports and forms, run the
Crystal Form Comparison Report utility to compare your customized reports
and forms to the standard ones in version 2023.

To run the utility, select File menu > Run, and then type SYWFCU. The utility
tells you which tables, if any, have been added to a report or form. It does not
provide information about formatting changes, such as those affecting fonts,
logos, and so forth

* If you were previously using non-graphical forms, you will need to set them up
using SAP Crystal Reports.

* If you are using Sage 100 Standard or Sage 100 Advanced, use the Crystal
Reports Conversion Wizard to convert your Crystal reports and forms. For more
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12.

13.

14.

15.

16.

17.

18.

19.

information, see SAP Crystal Reports FAQs in the Help system. If you do not
run the wizard now, it will automatically run the first time that someone runs a
form or report.

* If you are using Sage 100 Premium, refer to the Converting Reports for Sage
100 Premium section in the Sage 100 Installation and System Administrator's
Guide for more information.

For the Job Cost and Payroll modules, the Crystal Reports Conversion Wizard
might partially convert your customized forms and reports. Test all of your
customized forms and reports, and use Crystal Reports Designer to manually
update or recreate them as needed.

If Sage 100 2023 is installed on the same computer as an earlier version of Sage
100, complete this step to avoid errors when printing forms and reports in the earlier
version:

Copy the pvxwin32.exe.config file from the .\MAS90\Home folder in your 2017
installation to the same folder in your 2023 installation. You must complete this step
on both the server and the workstation.

If your system has custom reports, review the Custom Reports menus to make sure
they are available. If they are not, add them using Report Manager.

If you use Sage Intelligence Reporting, create a new repository for use with the
latest version of Sage 100 and import any custom reports into it. For detailed
instructions, see the "Upgrading Sage Intelligence Reporting" (page 206) checklist.

For the Job Cost and Payroll modules, recreate all Visual Integrator import and
export jobs.

If you converted Work Order data to Production Management data, purchase orders
that were linked to work orders must be manually relinked to work tickets. You can
do this by selecting the purchase order in Purchase Order Entry and entering the
applicable work ticket number in the Work Ticket No. field on the Lines tab.

Review the Paperless Office module configuration for e-mailing statements, reports,
journals, registers, and other forms. For more information, see Set Up Paperless
Office in the Help.

Review your Business Insights Dashboard pages. For more information, see Set Up
Business Insights Dashboard in the Help.
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20.

21.

22.

23.

24.

25.

26.

27.

28.

29.

To use the eBusiness Manager module:

a. Restore the copied templates back to the IW folder after re-installing the
Web Engine.

b. Copy the poweredby.gif image from the MAS90\Images folder to the IIS
Inetpup\wwwroot\images folder and restart the IIS Web service.

If you use Custom Financials Reporting, you must unhide the menu and tasks.
Select File menu > Run and type *unhidegl in the Run Program window.

Print all customized form definitions and compare them to the ones previously
printed. Default forms may be erased in the upgrade process.

If you purchased the Return Merchandise Authorization module, after setting up the
data files for the first time, select Return Merchandise Authorization Setup menu >
Create Customer Invoice Search Records to create customer invoice search
records in RMA.

To run Microsoft Script links, you must have the Microsoft Windows Script Host
processor on your system. For information on installing the Microsoft Windows
Script Host processor, refer to the Microsoft Download Center website.

If you use Automatic Update or Task Scheduler, review your scheduled automatic
updates and reschedule those updates by selecting Library Master Main menu >
Automatic Update or Task Scheduler, as applicable.

If you were using the classic Desktop, which is no longer available, and had task
folders in your My Tasks area, you can add tasks to the Favorites list instead. For
more information, see Add Iltems to the Favorites Content Group in the Help.

Test all printers, including Device Configurator printers, that you normally use for
printing forms and reports. Each workstation must have a default printer defined.

To use the auto-complete feature with enhanced search, run the Build Search Index
utility to index your existing customer, vendor, and item records. To run the utility,
select Library Master > Utilities > Build Search Index.

Install Paya Connect Desktop on each workstation for each Windows user who
needs to access credit card and ACH payment information in Sage 100.

To install Paya Connect Desktop for Sage 100 Standard:
a. Use File Explorer to browse to the MAS90\Wksetup folder.
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If you are installing Paya Connect Desktop on a workstation that connects to
a Sage 100 Standard installation on a server, browser to the
MAS90\Wksetup folder on the server.

b. Double-click Autorun.exe to open the Workstation Setup program; it takes a
few seconds to launch.

c. Click Install Paya Connect Desktop.
d. Proceed through the steps in the Paya Connect Desktop installation wizard
to install the program.

To install Paya Connect Desktop for Sage 100 Advanced and Premium:

a. Use File Explorer to browse to the server where Sage 100 is installed, and
locate the MAS90\Wksetup folder.

b. Double-click Autorun.exe to open the Workstation Setup program; it takes a
few seconds to launch.

c. Click Install Paya Connect Desktop.

d. Proceed through the steps in the Paya Connect Desktop installation wizard
to install the program.

30. If you installed the 32-bit version of Sage 100 and need to convert to the 64-bit
version, see "Converting to 64-bit Version of Sage 100" (page 210).
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Upgrading Sage Intelligence Reporting

If you use Sage Intelligence Reporting, follow the steps in this chapter to create a new
repository for Sage 100 2023. If you have custom reports, follow the instructions to export
custom reports from your prior version of the program and import them into the new
repository.

For detailed instructions on each step, see:

e "Export Custom Reports" (page 206)

e "Create a New Repository" (page 207)

e "Set Up Sage Intelligence Reporting in Sage 100 2023" (page 207)

e "Import Custom Reports" (page 208)

Report Compatibility

Reports can be imported only from an earlier version of the program or another instance
of the same version. For example, you can import a report created in version 2013 into
version 2023. You cannot import a report created in version 2023 into version 2013.

Reports created in Sage 100 Standard and Sage 100 Advanced are not compatible with
Sage 100 Premium. Likewise, reports created in Sage 100 Premium are not compatible
with Sage 100 Standard and Sage 100 Advanced.

Export Custom Reports

In your prior version of Sage 100, export all of the custom reports that you want to use in
version 2023.
To export custom reports

1. In your prior version of Sage 100, select Sage Intelligence Reporting Main menu >
Report Manager.

2. Right-click a report and then click Export Report. (Alternately, select a report and
then, on the Tools menu, click Export Report.)

Sage 100 Customer Upgrade Guide 206



Create a New Repository

3. Select the location where you want to save the file and then click Save. A file with an
AL _ extension is created.

4. Repeat these steps for all custom reports that you want to use in version 2023.

Create a New Repository

Create a shared folder to use as the Sage Intelligence Reporting repository for Sage 100
2023. We recommend using a separate repository for each installation of Sage
Intelligence Reporting.

Note: These steps may vary depending on what version of Windows you are
using. Check with your network administrator if you need assistance.

To create a repository

1. Use Windows File Explorer to create a folder in the desired location.
Right-click the folder, point to "Share with," and click "Advanced sharing."

On the Sharing tab, select the "Share this folder" check box.

Enter a share name.

Click Permissions.

For all applicable users, select the Full Control or Read and Write check boxes.

Click OK.

©® N o g bk~ w b

If you use reporting trees or distribution settings, copy the following folders from the
old repository to the new one:

* Report Trees

¢ Distribution

Set Up Sage Intelligence Reporting in Sage
100 2023

After creating the shared folder, enter its location in Sage 100 2023. If you haven't already
registered your 2023 version of Sage Intelligence Reporting, you will be asked to do so.
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To set up Sage Intelligence Reporting

1.

In Sage 100 2023, select Sage Intelligence Reporting Main menu > Report
Manager.

Click File and then click Change.
Click Yes in the message window.

In the Network Repository Path field, type the UNC path to the shared folder that
you created. For example: \\ServerName\ReportRpository

Click OK.

If you receive a message asking you to register Sage Intelligence Reporting, click
OK to open the License Manager window.

In the Account Number field, enter your Sage customer number.
In the Serial Number field, enter you unlocking key. This field is case-sensitive.

Click Apply and then click Perform Registration.

Import Custom Reports

After creating the new repository and registering Sage Intelligence Reporting, import any

custom report files.

To import custom reports

1.

If you want to create folders to organize your reports, on the Home tab, click Add
Folder.

Right-click either the Home folder or any custom folder created in the prior step, and
then click Import Report. (Alternately, you can click the Tools tab, and then click
Import Report.)

Select one of the custom reports that you exported from your prior version.

In the Import Report window, in the Target Connection field, select a connection.
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» For consolidated reports, select Sage MAS Consolidation.

Note: You must own the Sage 100 Intelligence Connector module to generate
consolidated reports.

e For any other type of report, select Sage MAS (Auto Connect).
In the Report Destination field, select the folder for the report.
Click Import.

On the Home tab in the Actions group, click Refresh.

Repeat these steps for any other custom reports that you exported from your prior
version of Sage Intelligence Reporting.
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Converting to 64-bit Version of Sage
100

If you installed the 32-bit version of Sage 100 on a computer running the 64-bit version of
Windows, you can convert it to the 64-bit version. You should do this only if you are no
longer using any earlier 32-bit versions of Sage 100 installed on the same computer, and
if all of your Sage 100 workstations are running the 64-bit version of Windows.

All versions of Sage 100 released before version 2021 are 32-bit.

Warnings!

« If you have an earlier 32-bit version of Sage 100 installed on the computer, it will
no longer work after you convert version 2023 to 64-bit.

« If you have any Sage 100 workstations running the 32-bit version of Windows,
they will no longer be able to run Sage 100 after it has been converted to 64-bit.

Do not convert to 64-bit until after you’ve completed your testing and have created a
backup of the data from your earlier version.

To convert from 32-bit to 64-bit

1. On the computer where Sage 100 2023 is installed, open the folder where the Sage
100 installation program is located.

2. Click or double-click the 32_64_Bit_Switch_Ultility.exe file.
3. Click Next and then enter the password for the Sage 100 Administrator account.

4. Click Convert.

Sage 100 is converted to the 64-bit version.

The Workstation Synchronization program automatically upgrades the workstations
the next time Sage 100 is started on the workstation.

If running the Application Server as a service, then the following steps are required to

re-create the Windows Service after converting from either 32-bit to 64-bit or from 64-

bit to 32-bit:

1. Use the Uninstall Sage 100 Application Server Service shortcut to delete the
existing service (a reboot may be necessary to complete this step).

2. Re-create the service using the Sage 100 Application Server Service Setup
shortcut.
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Time Track Task Locations

Refer to the following table to see which Time Track tasks replaced TimeCard tasks in

version 2018.2 and where they are located.

TimeCard Task

Setup Menu

Cost Code/Earnings Code Setup

Exception Code Maintenance

TimeCard & TimeClock Options

TimeCard Employee Maintenance

TimeCard Job Maintenance

TimeCard Utilities

TimeClock Shift Maintenance
Main Menu

TimeCard Entry and Edit
TimeCard Entry and Edit --New

Entries Only
TimeCard Inquiry

TimeCard History Inquiry

TimeClock Punch In/Punch Out

Time Track Task

Select Job Cost > Setup > Cost Code
Maintenance. Click Earnings to open the Valid
Earnings Code window.

Not available.
Payroll > Setup > Time Track Options

Select Payroll > Main > Employee Maintenance.
Click More and select Time Track to open the
Employee Time Track Settings window.

Select Job Cost > Main > Job Cost Maintenance.
Select or clear the Exclude from Certified Payroll
Report check box.

Not available.

Select Payroll > Time Track > Shift Maintenance.

Select Payroll > Time Track > Time Track Entry.

Select Payroll > Time Track > Time Track Entry.

Select Payroll > Time Track > Time Track Inquiry.

Not available. To view history, select Payroll >
Time Track > Time Track Report, and select the
History check box before printing the report.

Select Payroll > Time Track > Punch In/Out.
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TimeCard Task Time Track Task

Period End Menu

Select Payroll > Period End > Period End

Purge History Files .
Processing.

Not available. Data is automatically transferred to
Purge/Transfer to History history when time entries are updated in the Job
Cost and Payroll modules.

Job Cost Menu
Calculate Job Cost Selections Not available.*
Daily Transaction Register Not available.*

Select Job Cost > Time Track > Time Track

J/C Distribution Register/Update .
Register / Update.

Select Job Cost > Time Track > Time Track

J/C Selection Audit Report )
Register / Update.

Select Job Cost > Time Track > Time Track
Selection.

Job Costs Selection

Reports Menu

. . Select Payroll > Time Track > Approaching
Approaching Overtime Report )
Overtime Report.

Select Payroll > Time Track > Attendance
Worksheet.

Attendance Worksheet

Average Hourly Pay Report Not available.

. Select Payroll > Main > Certified Payroll
Certified Payroll Report

Worksheet.
Departmental Exception Report Not available.
Employee Exception Report Not available.
Exception Calendar Report Not available.
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TimeCard Task Time Track Task
Gross Earnings Report Not available.

Select Job Cost > Time Track > Job Daily

Job Daily Production Report .
Production Report.

TimeCard Report Select Payroll > Time Track > Time Track Report.

*Labor costs are automatically calculated when they are selected and updated to the Job
Cost module. There is not a separate Daily Transaction Register for Time Track. Costs
are updated when you update the Job Cost Daily Transaction Register. For more
information, see Post Time Track Entry Costs for Jobs in the help.
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